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1 About SAP Lumira

SAP Lumira Desktop is an application you can use to visualize and create stories about data. From
manipulating, editing, formatting, and refining data to creating visualizations that represent data graphically,
to finally sharing the visualizations—building stories in SAP Lumira starts and ends with data.

Data enters the application as a dataset (a set of columns, hierarchies, and filters) that you use to build a
document. You create a dataset by acquiring data, enhance it with measures, hierarchies, calculations, and
customized columns, and then choose charts to visualize the data. You can use the visualization to create
stories that provide a graphical narrative to describe data. For example, you can group charts on a story page
to create a presentation-style dashboard and then add images and text annotations.

You can publish datasets and stories to other applications and platforms, including the following places:

e SAP HANA
e SAP BusinessObjects Business Intelligence platform
e SAP Lumira, server for teams (previously called SAP Lumira Team Server and SAP Lumira, Edge edition)

SAP Lumira is installed locally and can use remote or local data from one or multiple data sources. The charts
you build are saved automatically and can be printed or shared via email.
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2 Getting started with SAP Lumira

Use SAP Lumira to create charts or stories that you can keep private or share with others.

You can switch between the following activities as needed to fine-tune your chart or story:

e Acquire data as a dataset.
® Prepare and enrich data for visualizations.
e \isualize data as charts and stories.

Acquire data as a dataset

Acquiring data involves the following process:

e (Create a document to be the container for your data and visualizations.
e (Connect to the data source that contains the data to be visualized.
e Acquire the data to create a dataset.

You can extend a dataset by merging or appending it with other compatible datasets. One document can
contain multiple datasets.

Acquired datasets appear in the Prepare room.

Prepare and enrich data for visualizations

To make it easier to visualize data and to make the data more relevant to your charting and story telling needs,
you can clean up and enrich your data. Enriching data means adding semantic value to your dataset by
creating measures, hierarchies, and customizing columns.

Visualize data as charts and stories

In the Visualize room, choose from a variety of charts for the best chart to visualize your data. The enriched
elements in the dataset allow you to plot meaningful relationships and to explore data trends in a purely
graphical environment.

In the Compose room, create stories with charts, pictograms, input controls that filter data, text, shapes, and
images to describe your data.
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Related Information

Acquiring data [page 22]
Prepare room—viewing, cleaning,manipulating, and sharing data [page 54]
Creating hierarchies [page 64]

2.1 Navigating SAP Lumira's Home page

The Home page allows you to work on existing documents or to create visualizations using sample data.

When you start SAP Lumira you can start working immediately from the Home page, performing tasks such as
creating or opening a dataset, using the samples that are shipped with the product, and so on.

To start working on an existing document or use the demo samples, click any one of the icons in the side bar to
gain quick access to the following application components and resources:

Table 1:

Side bar When clicked...

Home Gives you access to learning resources, for example video tutorials and the SAP Lumira
website. If you are connected to the internet at startup, the Home page also has a live infor-
mation feed about SAP Lumira customer solutions and news to help you develop your expe-
rience with your data, visualizations, and stories.

My Documents Opens alist of all locally stored documents. Double-click a document name to open the da-

ltems taset and associated visualizations.

Visualizations Opens alist of all locally stored visualizations. Double-click a visualization name to open the
chart and its associated dataset.

Datasets Opens alist of all of the locally stored datasets. A dataset is the set of columns, hierarchies,
and filters used to build a document. Datasets are stored in the SAP Lumira application
Documents folder in in your profile path. Double-click a dataset name to open.

Stories Opens alist of all of the locally stored stories. Double-click a story to open its dataset and
associated visualizations.

Server for teams Allows you to upload documents to SAP Lumira Team Server for secure sharing with team
members.

SAP Bl Platform Opens an SAP Lumira document from the SAP BusinessObjects Business Intelligence plat-
form.

Hadoop HDFS Allows you to download data from Apache Hadoop.

Connections Allows you to view locally defined connections and change data source for local connec-
tions.

Try with Samples Opens a list of sample documents and locally installed MS Excel data sources that you can
use as learning materials.
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Related Information

Acquiring data [page 22]
Prepare room—viewing, cleaning,manipulating, and sharing data [page 54]

2.2 Opening a dataset

A dataset is a set of columns, hierarchies, and filters used to create a document. It does not contain any
visualizations.

Context

Datasets are stored in the Documents folder whose location is defined in your profile path for SAP Lumira.

Procedure

1. Onthe Home page, select |+ My Items # Datasets 3.
A list of available datasets appears.

2. Double-click a dataset, and enter your credentials if it is necessary to connect to a data source.
The document that contains the dataset is opened.

1 Note

If you modify your dataset, the changes will be saved in your document even if you do not edit the
document. If you have more than one document that uses the same data source and dataset, the
dataset will appear twice in the list of datasets.

You can view the dataset in the Prepare room and visualizations saved in the document in the Visualize
room.
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2.3 Creating a document

You can connect to a data source and store the acquired dataset in a new . 1ums document.

Context

Each SAP Lumira document contains:

® One or more datasets

e Connection parameters for data sources if any of the sources are relational database management
systems (RDBMS)

® (Charts built from datasets

e Stories that describe data using charts, text, navigation points, and images

Procedure

1. Onthe Home page, select |l File » New J.

= Tip

You can also select Create New Document or select | My Items » Documents » + New Document 3
from the left-hand menu.

2. Inthe Add new dataset dialog, select a data source type from the Select a Source column or a recently
used data source from the All Recently Used column and select Next.

3. Select a source file or enter the data source connection details and select Create.

The dataset is imported into the document.

1 Note

If you select Connect to SAP HANA as a data source, only the metadata is imported into your document.

Results

A new document is created and opened in the SAP Lumira room you select as default. When you save the
document, you will be prompted to provide a document name, location, and description.
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Next Steps

You can now create a visualization from your dataset. You can use the Prepare room to prepare your dataset.

Related Information

Acquiring data [page 22]
Prepare room—viewing, cleaning,manipulating, and sharing data [page 54]

2.4 Saving a document to a local directory

When you save a document locally, your dataset, visualizations, and stories are added to the document.

Procedure

1. Select | File » Save As 3, and select Local in Save Options.

2. Enter a name, location, and description for the document or select a name from the list, and select Save.

1 Note

If you modify your dataset, the changes will be saved in your document even if you do not edit the
document. If you have more than one document that uses the same data source and dataset, the
dataset will appear twice in the list of datasets.

Results

The document is saved locally.

Restriction

Documents saved in older versions of SAP Lumira or SAP Lumira, server for teams can be opened in newer
versions of the application, but documents created in newer versions may not open correctly in older
versions. You may publish a new document to a server with older software, but the server must be updated
for the document to open properly.
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Related Information

Saving a document to the SAP Business Intelligence platform [page 15]

2.5 Saving a document to SAP Lumira, server for teams

SAP Lumira, server for teams is a lightweight document storage solution for environments that do not have
SAP HANA or the SAP BusinessObjects Business Intelligence platform. When you save a document to SAP
Lumira, server for teams, your dataset, visualizations, and stories can be shared with a small number of
collaborators.

Prerequisites

e Ensure that SAP Lumira, server for teams is installed and running on your network.

e Configure the URL to SAP Lumira, server for teams in SAP Lumira by selecting |+ File ¥ Preferences ¥
Network 3.
e [Enter the email address for each user or group that you want to share the document with.

= Tip

For best results, use the same version of SAP Lumira and SAP Lumira, server for teams. If the two
versions are different, some features may not be available.

Restriction

When you share a saved document, you must use the SAP Lumira, server for teams web interface to
revoke a user's permissions. If you save the same document more than once, each time specifying
permissions for a different user, both users will receive permissions.

Procedure

1. Select | File » Save As J, and select Server for teams in Save Options.
2. If prompted for credentials, select Enterprise, WinAD, or SAP from the Authentication Type list.

3. Type your username and password. If you selected SAP authentication, type the SAP system and client
number.

SAP Lumira, desktop edition User Guide
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= Tip
Unless the default settings of SAP Lumira, server for teams had been changed, your username is your
email address. If you want SAP Lumira to remember your password, select the Save password check

box.

4. Select Connect.
If you log into SAP Lumira, server for teams for the first time and the versions of SAP Lumira and SAP

Lumira, server for teams are different, a message is displayed, warning that some features may not be
available.

5. Choose save options for the document, and select Save.

1 Note

If you leave the Share with option blank, you will be the only person who can view or edit the document.

Results

The document is saved to SAP Lumira, server for teams, and a copy is saved locally.

1 Note

After the document is saved, the launchpad can refresh its datasets if refreshing is enabled on the server.

Restriction

Documents saved in older versions of SAP Lumira or SAP Lumira, server for teams can be opened in newer
versions of the application, but documents created in newer versions may not open correctly in older
versions. You may publish a new document to a server with older software, but the server must be updated

for the document to open properly.

Related Information

Upgrading from SAP Lumira Trial Edition [page 200]
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2.6 Saving a document to the SAP Business Intelligence
platform

When you save a document to the SAP BusinessObjects Business Intelligence platform, you can take
advantage of authorization, auditing, data loss prevention, and sharing functions for your dataset,
visualizations, and stories.

Prerequisites

e [Ensure that Bl platform 4.1 SP3 or later is installed and running on your network.

e Configure the URL to the Bl platform in SAP Lumira by selecting | File ¥ Preferences  Network 3.
® Toview items on the Bl platform, ensure that SAP Lumira, server for Bl Platform with the same version as
SAP Lumira is installed.

1 Note

If a message indicating that the versions are different is displayed, contact your Bl platform
administrator.

Procedure

1. Select|r File » Save As Jand select SAP Bl Platform in Save Options.

2. If prompted, enter your credentials.

1 Note

In this release, you can publish a document or log onto SAP Lumira, server for Bl Platform from Lumira
desktop using the operating system SSO. However, ensure that you have configured the SSO on SAP
Lumira server for Bl Platform environment and Both Lumira Desktop and SAP Lumira server for B
Platform reside on the same machine.

3. Choose the authentication type and select Connect.
1 Note
If you select SAP as the authentication type, enter the SAP System and the SAP Client.

4. Choose save options for the document, and select Save.
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Results

The document is saved to the Bl platform repository.

1 Note

When you save a dataset, a visualization, or a story, the document and all of its contents are saved.

Related Information

Setting application preferences [page 196]
Upgrading from SAP Lumira Trial Edition [page 200]

2.7 Opening a document, visualization, dataset, or story

You can open local items such as documents, visualizations, datasets, and stories, or items saved to SAP
Lumira, server for teams, or SAP BusinessObjects Business Intelligence platform.

Prerequisites

To be able to open a non-local item, you must configure the URL to SAP Lumira, server for teams, or the

Business Intelligence platform in SAP Lumira by selecting |# File » Preferences » Network 1.

1 Note

You must have appropriate rights to view and edit documents that you or other people own.

Procedure

1. Onthe left-hand menu of the Home page:

o Toopenalocal item, select Documents, Visualizations, Datasets, or Stories.

o Toopenadocument from SAP Lumira, server for teams, select Server for teams, enter your
credentials, and select Connect.

= Tip

Unless the default settings of SAP Lumira, server for teams had been changed, your username is
your email address.

SAP Lumira, desktop edition User Guide
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o Toopenadocument from the Bl platform, select SAP Bl Platform, enter your credentials, select the
Authentication Type, and select Connect. When you are connected, select the appropriate folder from
the Bl platform repository.

1 Note
The SAP BusinessObjects Bl add-on for SAP Lumira must be installed and the Bl platform must be

version 4.1 SP3 or later.

A list of available items appears.
2. Toopen anitem, double-click it.

3. Ifthe document requires a data source, enter your credentials and select OK.

Results

The document opens in the Visualize room. You can view datasets in the Prepare room, visualizations in the
Visualize room, and stories in the Compose room.

Restriction

Documents saved in older versions of SAP Lumira or SAP Lumira, server for teams can be opened in newer
versions of the application, but documents created in newer versions may not open correctly in older
versions. You may publish a new document to a server with older software, but the server must be updated
for the document to open properly.

2.8 Example: Visualizing orders by type and time of day

| have an online retail store and want to answer the question “How do the number and type of orders vary by
time of day? How does the time of year (June versus December) affect this pattern?”

This example shows what you need to do in the Prepare, Visualize, and Compose rooms to answer this
question.
1 Note

This example uses data in datetime format. Datetime format is currently supported only for data acquired
from SAP HANA.

Getting data ready in the Prepare room

Select Prepare at the top of the application to switch to the Prepare room.

Let's start by looking at some data. To keep things simple, assume the data contains only these columns:
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e Order Date (datetime)
e QOrder ID (number)
e Product Type (string)

MEASURES 1

S OrderlD Sum Crder Date Order 1D
123
DIMEMNSIONS 3
121312013 43466
M COrder Date
' 211912015 43541
123 COrder D
9712014 43304
ABC  Product Type
1212212014 43274

Product Type
ABC

Accessones
Equipment
Men's clothing

Women's clothing

1. The first stepis to create an Hour column. Let's create this column using a calculated dimension based on

18

the Order date column:

1. Selectthe # icon next to the Order date dimension, then select Create Calculated Dimension.
2. Select Hour () from the Functions list (you can search for it rather than scrolling), and add it to the

Formula pane. On Windows, this requires a double-click.

3. Move the {Order Date} parameter inside the Hour () function - keep the { } brackets.

4. Name the new dimension and select OK.

New Calculated Dimension

Dimension Name | Hour
Formula
Hour({QrderDate})
Dimensions Functions
Q, Fir Q, hour

Hour(=time=)

Hour () function.

Next, create a column for the month. Repeat the previous step using the Month () function instead of the

Change the aggregation of Order ID from Sum to Count (Distinct).We don't want to plot the total number

of orders - instead, we want to see how many orders were placed in each hour of the day.

1. Select the # icon next to the Order ID measure.
2. Select|F Change Aggregation ¥ Count (Distinct) .

PUBLIC
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MEASURES 1

#5 Order D Sum m Change Aggregation

Count (Distinct)

The Order ID measure now calculates the total number of unique orders.

The data preparation is finished, and we can move to the Visualize room to create the charts.

Creating charts in the Visualize room

Select Visualize at the top of the application to switch to the Visualize room.

We will create the following charts:

Sales by hour and type for June.
Sales by hour and type for December.

Select + next to the Visualization Gallery (near the bottom of the application) to add a new chart.

] ~
Select Stacked Column Chart from the Visualization Tools panel.

Drag the following measures and dimensions from the Measures and Dimensions panel (on the left) to the
shelves in the Visualization Tools panel.

Table 2:
Item ’ Shelf
Order ID Y axis

(Select Order ID from the Measures panel)

Hour X axis

(The calculated measure that you created using the
Hour () function).

Product Type Color

Add a filter:

1. Select Y. in the filter bar (near the top of the application).

2. Select the Month dimension that you created using the Month () function.
3. Select 6 (for June).
Change the title to Orders by type and time of day — June.

Select the # icon next to the default title, select Rename, and enter a new title.

If you want, you can change the name of the measure and dimension used in the visualization. This will
change the axis labels. (I changed Hour to Hour of day and Order ID to Order Count.
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Select the # icon next to the measure or dimension, select Rename, and enter a new name.

Y, I;u‘lonth (1) [
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/
X /
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/
i
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|
. ) - - ) - -
IIIIIIIIIIIIIIII | i PdellctTvpe 0
o
4 5 8 7 8 ] 10 1 12 12 14 15 1% 17 18 1% 20 21 22

Hour of Day

Order Count

7. Repeat the previous steps to make another chart for December. When creating the filter, select 12
(December) for the month.

You can duplicate the existing chart to get started. In the visualization gallery, select # on the previous
chart, then select Duplicate.

We have created two charts:

e Orders by type and time of day — June
e Orders by type and time of day — December

We can now move to the Compose room and create the story.

Using charts to create a story in the Compose room

Select Compose at the top of the screen to switch to the Compose room. We will create a story that compares
orders by type and time of day, for the months of June and December.

1. Inanew story, select one of the visualizations from the Content Panel and drag it to an area on the story
page.
2. Select the second visualization and drag it to the same story page.

3. Arrange the visualizations on the page, and edit the visualization properties to format the story the way
you want.
| did the following:

Selected expand |Z| in each visualization to expand it to the maximum width of the page.

2. Turned off Optimized Chart Alignment in Visualization Properties to give the visualizations a little more
room.

3. Adjusted the vertical axis so both charts used the same scale.
Select Vertical Axis in Visualization Properties, then adjust the Axis Value Scale.
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= Tip

If you can't see the Visualization Properties panel, select a visualization on the story page. You may
have to double-click it several times.

With my data, the final story looked like this:

Orders by type and time of day - June
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3 Acquiring data

You acquire data by copying it from a data source to a local dataset.

When acquiring data, the application displays a preview of it, parses the data, and analyzes the columns to
determine the data type. Objects representing columns are proposed as either dimensions or measures. You
can manually hide some types of columns, based on the column name and data properties.

1 Note

The maximum number of cells that can be acquired is determined by the capacity of your computer. You
will be warned when an acquisition includes 30 million cells for 64-bit operating systems or 15 million cells
for 32-bit operating systems.

Depending on the data source, data can be adapted before acquisition to include or remove columns,
dimensions, measures, variables, and input parameters. Some data sources have additional options, such as
formatting data, naming and trimming columns, and specifying column-name prefixes.

Table 3: Supported data sources

Data source Description

Microsoft Excel Loads an Excel worksheet as a dataset

Text file Loads atext file (.csvor . txt)as adataset

Clipboard Creates a dataset from data that was copied to the clipboard
SAP HANA Downloads data from SAP HANA (offline)

Connects to SAP HANA (online)

SAP BusinessObjects universe | Downloads data from SAP BusinessObjects universe files (. unv and . unx)

Query with SQL Runs freehand SQL on a database, to download a dataset
Hadoop Downloads data from Apache Hadoop.
SAP BW ® Accesses data through views in SAP HANA

® Downloads data from SAP BusinessObjects universe files (. unx)

e Downloads data from SAP BW (available when the “Download data from SAP Busi-
ness Warehouse" extension is installed)

1 Note

For some online data sources; for example the Connect to SAP HANA data source, data is not acquired as a
dataset and saved in a document. Instead, the data is accessed from the server, and only metadata is saved
in the document.
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After a dataset is acquired, you can add or remove columns, dimensions, measures, and variables in it.

Related Information

Acquiring data from a text file [page 26]

Acquiring data from SAP HANA views [page 29]

Acquiring data from an Excel workbook [page 24]

Acquiring data using Query with SQL [page 38]

Connecting to a universe data source [page 36]

Editing an acquired dataset [page 49]

Objects hidden from the object list [page 51]

Download data from SAP Business Warehouse extension [page 183]
SAP Universe Query Panel extension [page 179]

3.1 Viewing a data source connection and its associated
documents

You can view all connections defined for the application, and the documents associated with each connection,

and change the target data source for locally defined connections.

Procedure

1. Close any open documents.

2. From the left-side menu, select Connections.
The CONNECTIONS pane appears on the right and lists all available data source connections. Select a
connection to display a list of documents associated with it. The DOCUMENT FOR pane appears to the
right of the CONNECTIONS pane and lists the documents associated with each connection.

3. Select alocal connection in the list to display its target data source.
You can select another data source if required.
4. (Optional) To change the data source connection for a document, perform the following actions:
a. Select the connection to change.
b. Select the document to change the data source for in the DOCUMENT FOR pane.
c. Select a new data source for the document in the CONNECTIONS pane, and select Apply.

1 Note

In this release, while acquiring the dataset you can edit BW connection locally in SAP Lumira Desktop.

However, you can view these connections when you start SAP BW.
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3.2 Acquiring data from an Excel workbook

Procedure

1. Onthe Home page, select Create New Document.

In the Add new dataset dialog, select Microsoft Excel, and select Next.
3. Choose one or more Excel files, and select Open.

Data from the Excel files is previewed in the Add new dataset dialog.
4. (Optional) Modify the Excel options for acquiring data.

5. Select Create.

Results

The Visualize room opens so you can start building charts and analyzing the data. If you want to modify the
dataset first, switch to the Prepare room.

3.2.1 Add new dataset dialog options for Excel

You can acquire data from one or multiple Microsoft Excel workbooks. You choose which rows and columns to
acquire. You can also acquire data from cross tables.

Table 4: Add new dataset dialog options for Excel

Option Description

Dataset Name Enter a name for the new dataset.

File(s) Select the Excel workbooks that will be the data source for the
new dataset.

Sheet When an Excel workbook contains multiple worksheets, select
the worksheet to acquire for the dataset.

Append all sheets Select this check box to add all worksheets in the workbook to
the dataset. Common columns are appended, and different col-
umns are added as new columns.

Set first row as column names Select this check box to set the first row values in the worksheet
as column names in the dataset.

Table Header Type Select Standard Table (No Transformations) or Cross Table.
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Option Description

Select All Select this check box to add all columns in the worksheet to the
dataset.

Show record count Select this check box to show the number of columns and the

number of rows in the dataset.

|} Advanced Options > Show hidden columns ]

Select this check box to display hidden worksheet columns as
column headers in the dataset.

|} Advanced Options > Show hidden rows ]

Select this check box to display hidden worksheet rows in the da-
taset.

| Advanced Options  Detect merged cells 3

Select this check box to highlight merged worksheet cells in the
dataset.

|+ Advanced Options » Range Selection 3

When a worksheet contains one or more named ranges, select
the range to apply to columns acquired for the dataset. A dataset
is restricted to the columns defined in this range.

|} Advanced Options > Column }

For cross tables, specify the number of columns to use for the left
header.

|} Advanced Options > Row ]

Specify the number of rows to use for the top header.

3.2.2 Acquiring data from multiple Excel workbooks

When acquiring data from multiple Excel workbooks, the data format and data type must be the same in all of

the workbooks.

Procedure

On the Home page, select Create New Document.

2. Inthe Add new dataset dialog, select Microsoft Excel, and select Next.

3. Choose one or more Excel files, and select Open.

Data from the Excel files is previewed in the Add new dataset dialog.

4. (Optional) In the Dataset Name box, enter a name for the dataset.

5. Beside File(s), select Add Files, and browse to and select the Excel spreadsheet to acquire data from.

You can use wild cards to search for a spreadsheet name. By default, the first file in the path is considered
the reference file to which data will be appended from other spreadsheets acquired.

For example, enter C: \data\monthly updates\*.x1ls (x) tofindall .x1s (x) filesin the path.

6. Inthe Sheet list, select a worksheet.
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This worksheet is the reference sheet that data from other worksheets will be appended to. The count of
records is updated to reflect the number of records from all acquired data. A “Source file” column is added
to the dataset, listing each data source name. If you selected the Append all sheets check box, all
worksheets in the Excel spreadsheet are added to the dataset.

Data from the worksheet appears in the preview pane of the Add new dataset dialog.
7. (Optional) To display hidden worksheet rows or columns in the dataset, select Advanced Options.

8. (Optional) To display hidden worksheet columns in acquired data, select the Show hidden columns check
box, and enter the column range to display in the Range Selection list.

9. (Optional) To display hidden worksheet rows in acquired data, select the Show hidden rows check box, and
enter the row range to display in the Range Selection list.

10. Select Create.

Results

The data is acquired and appears in the Prepare room.

3.3 Acquiring data from a text file

You can acquire data from one or more text files, if the data is stored with delimiters or in fixed-width columns.
An example of a text file using delimiters is a comma-separated value (. csv) file.

Context

A .csv file stores numbers and text in plain-text format. Each record consists of fields usually separated by a
comma or a tab, and records are separated by line breaks. Here is an example of a . csv file, with data
separated by commas:

"Product", "Country", "Year", "Quantity", "Margin"
"SkiS", "Italy", |l2013","1,297","1, 929"
"Computers", "China","2014","609","10, 659"

Acquiring data from this . csv file results in five columns in the dataset: "Product," "Country," "Year,"
"Quantity," and "Margin." Column 2, in this example, would contain the values "Country", "ltaly", and "China".

Here is an example of a text file with the data stored in fixed-width columns:

Product Country Year Quantity Margin
Skis Italy 2013 1,297 1,929
Computers China 2014 609 10,659

You can acquire data from multiple-file data sources. The files must have the same format and data type.
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Table 5: Add new dataset dialog options for text files

Option Description

Dataset Name The name of the dataset

File(s) The file or files that contain the data for the new dataset. You can import data from one
or multiple files. To specify multiple files, separate the file paths in the File(s) field with
semicolons, or select Add Files and choose one or more files to add to the selection.

Separator Choose whether data in your files is separated by delimiters or is entered in fixed-width

columns. Delimiters are symbols, such as commas, tabs, or spaces, that separate fields
in the data source and that will specify columns in the dataset in SAP Lumira.

Set first row as column names

Select this check box to use the first row of data as column names in the dataset.

Clear this check box to use the default column names ("Columnl", "Column2", and so
on).

|} Advanced Options > Number
format ]

The format for numeric columns in the dataset

| Advanced Options » Date
format }

The format for date columns in the dataset

|+ Advanced Options ¥ Break
Column 4

When acquiring data stored as fixed-width columns, analyze the data file and suggest
column widths (in characters) for separating data into columns in the dataset.

If the suggested widths aren't suitable, you can change the widths by entering values
separated by commas. For example, if your data is in three columns and the column
widths are five, 10, and 15 characters, you would enter 5,10, 15 in the Break Column
box, and select Apply to see a preview of the resulting dataset.

|+ Advanced Options » Trim
leading spaces }

Select this check box to remove leading and trailing values from numbers and text in the
dataset so that column headers do not appear as empty fields. For example, if a "Prod-
uct" entry has a leading space (" Product"), the space is removed and "Product" ap-
pears as the column header.

Procedure

On the Home page, select Create New Document.

2. Inthe Add new dataset dialog, select Text, and select Next.

3. Choose one or more text files, and select Open.
Data from the files is previewed in the Add new dataset dialog.

4. (Optional) Adjust the dataset options in the dialog as needed.

5. Select Create.
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Results

The Visualize room opens, and you can start building charts and analyzing data. If you want to modify the
dataset first, switch to the Prepare room.

3.4 Acquiring data copied to the clipboard

Text-based data can be copied to the clipboard from a text-based file (for example, from Microsoft Excel) or

from a web page.

Context

Table 6: New Dataset dialog options for data copied from the clipboard

Option Description
Dataset Name The name of the dataset
Separator Choose whether data on the clipboard is separated by delimiters or is entered in fixed-

width columns. Delimiters are symbols, such as commas, tabs, or spaces, that separate
fields in the data source and that will specify columns in the dataset in the application.

Set first row as column names

Select this check box to use the first row of data as column names in the dataset.

Clear this check box to use the default column names ("Columnl", "Column2", and so
on).

|+ Advanced Options » Number
format }

The format for numeric columns in the dataset

|} Advanced Options > Date
format 4

The format for date columns in the dataset

|’ Advanced Options > Break
Column ]

When acquiring data stored as fixed-width columns, analyze the data file and suggest
column widths (in characters) for separating data into columns in the dataset.

If the suggested widths aren’t suitable, you can change the widths by entering values
separated by commas. For example, if your data is in three columns and the column
widths are five, 10, and 15 characters, you would enter 5,10, 15 in the Break Column

box, and select Apply to see a preview of the resulting dataset.
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Description

|b Advanced Options > Trim Select this check box to remove leading and trailing values from numbers and text in the

) dataset so that column headers do not appear as empty fields. For example, if a "Prod-

leading spaces ] . ) .\ . ) B .
uct" entry has a leading space (" Product"), the space is removed and "Product" ap-

pears as the column header.

1 Note

The Microsoft Internet Explorer (IE) web browser has a known issue when copying text to the clipboard. If
you encounter this issue, use a different supported browser instead.

Procedure

1. Copy text to the clipboard.
2. Onthe Home page, select Create New Document.

3. Inthe Add new dataset dialog, select Copy from Clipboard, and select Next.
The text you copied is pasted in the dialog.

4. (Optional) Select Trim Spaces to remove leading and trailing spaces from numbers and text in the dataset.
5. (Optional) Select Trim Row to remove blank lines from the dataset.

6. Select Proceed.
Data from the files is previewed in the Add new dataset dialog.

7. (Optional) Adjust the dataset options in the dialog as needed.

8. Select Create.

Results

The Visualize room opens, and you can start building charts and analyzing data. If you want to modify the
dataset first, switch to the Prepare room.

3.5 Acquiring data from SAP HANA views

You can acquire data from SAP HANA analytic or calculation views.

Data in an SAP HANA database is accessible in a "view"—a predefined virtual grouping of table columns that
enables data access for a particular business requirement. Views are specific to the type of tables that are
included, and to the type of calculations that are applied to columns. For example, an attribute view is built on
dimension tables, an analytic view is built on a fact table and attribute views, and a calculation view executes a
function on columns when the view is accessed.
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You can connect to SAP HANA views in two ways:

e By downloading data from SAP HANA
Data is copied locally and can be manipulated and edited before being visualized in charts.

e By viewing datain SAP HANA
Datais read-only (that is, you cannot edit it), but you can visualize it in charts.

After connecting to a view, data is presented as columns, facets, measures, dimensions, and hierarchies in the
application.

Related Information

Downloading data from SAP HANA [page 33]

Connecting to SAP HANA [page 30]

Accessing SAP BW data in SAP HANA views [page 34]

Specifying values for SAP HANA variables and string input parameters [page 35]

3.5.1 Connecting to SAP HANA

While connected to SAP HANA, you can view data and create visualizations from an SAP HANA cube.

Prerequisites

You need to know your SAP HANA server name, port number, user name, password and - in the case of MDC
connection - you need to know your tenant details . For more information, contact your SAP HANA
administrator.

Procedure

1. Onthe Home page, choose New Document.

The Add new dataset dialog box appears.
2. Choose Connect to SAP HANA.
3. Choose Next.

The SAP HANA Data Acquisition Connector dialog appears.

4. From the Connect To list, select either a direct connection to the SAP HANA System, or log on to the SAP
BusinessObjects Bl Platform to access the managed OLAP connections to SAP HANA.

o For aconnection to the SAP HANA System, proceed as follows:
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1. Inthe Connect to field, choose HANA from the dropdown list.
2. Select the server to log on to from the Server list.
3. Enter the port number to log on with in the Instance/Port box.

1 Note

In this release, you can connect to SAP HANA using Multitenant Database Container (MDC)
connection, where you host multiple SAP HANA databases on a single SAP HANA system. In
this setup, all tenant databases share the same system resources such as memory and CPU
cores. However, each tenant database consists of resources such as database users, catalog,
repository, services, and, persistence of both data files and log files. To connect to SAP HANA
system using MDC connection, perform the following:

o Enter the details in the Server list, with the SAP HANA server name and tenant port number

in the format: <HANA server name: Tenant port number> to log on to the server.
o Enter the instance number in the Instance field.

4. To connect to the SAP HANA server, perform one of the following:

Table 7:
Section Description
If you connect by entering credentials Enter your user name and password, and choose
Connect.
If you connect via single sign-on (SSO) Select the Authenticate by Operating System (SSO)
check box, and choose Connect.

5. Choose Next.
The Add new dataset: SAP HANA view dialog appears, displaying available SAP HANA views.

6. Expand the SAP HANA view that contains the data to view, and choose the cube that contains the
data.

7. Choose which data to access:

o To access particular dimensions and measures in the data, choose Next, select the
dimensions and measures, and choose OK.

o To access all the measures and dimensions in a cube, choose Create.

o  SAP BusinessObjects BIP-managed connections allow you to directly acquire data from the SAP
HANA database without having to remember your credentials. For a connection to the SAP
BusinessObijects Bl Platform, proceed as follows:

Enter the Bl Platform connection details.

If you want to save your password, select Save Password.

Choose Connect.

A w oo

Select an OLAP connection, and select Next.
The following OLAP connections are supported:

o Single sign-on (SSO): System establishes connection via single sign-on.
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1 Note

SSO in HANA Managed connection works only if you have configured Kerberos SSO in the
system where you have installed Lumira Desktop and the HANA system that you are trying
to connect to.

©  Prompt: System prompts you to enter your credentials.
o Save password credentials: System saves the password for the SAP HANA database

5. Youcan apply a search, based on key words, for the specific OLAP connection.
An Add new dataset: SAP HANA views dialog appears, displaying available SAP HANA views.

6. Expand the SAP HANA view that contains the data to view, and choose the cube that contains the
data.

7. Choose Next.

8. Select the dimensions and measures you want to download to your Lumira Desktop dataset.

9. Select Create.

The Visualize room opens. You can start building charts and analyzing the data here. If you want to modify
the dataset first, switch to the Prepare room.

Related Information

Specifying values for SAP HANA variables and string input parameters [page 35]
Restrictions for Connecting to SAP HANA [page 32]

3.5.11 Restrictions for Connecting to SAP HANA

When connected to an SAP HANA online data source, the following restrictions apply:

32

The Change Aggregation action that is typically available for each measure in the Measures and
Dimensions panel is not available.

These actions that are typically available for each dimension in the Measures and Dimensions panel are
not available:

o Convert to Number

o Convertto Text

o Convert to Date/Time

o Create a measure

o Create a date/time hierarchy

o Create a custom hierarchy

o Create a geographic hierarchy by Latitude / Longitude
o Duplicate

o Merge this column

o Create Calculated Dimension

Although you cannot create date/time hierarchies, any level-based hierarchies that are modeled
specifically as time hierarchies in your HANA views will be treated as time hierarchies by Lumira. For
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details, see the section titled “Considerations for working with SAP HANA" in the SAP Lumira Installation
Guide.

e Although you cannot create custom hierarchies, any regular level-based hierarchies that are modeled in
HANA will be treated by Lumira similarly to custom hierachies.

e Although you can create a geographic hierarchy “By Names”, the resultant geographic hierarchy will have
only one level.

e The “Create New Dataset” action is not available from each visualization's thumbnail in the visualization
gallery.

e Additional datasets can be added only from the same instance of the first SAP HANA dataset, using the
same SAP HANA connection. It is not possible to acquire data from other data sources.

e The following SAP HANA functions are not supported in calculated measures or dynamic text:
o AddMonthToDate
o AddYearToDate
o LastDayOfMonth
o DayOfYear
o Week
o LastWord
o ExceptLastWord

3.5.2 Downloading data from SAP HANA

You can manipulate data and create visualizations from an SAP HANA cube.

Prerequisites

You must know your SAP HANA server name, port number, user name, and password. For more information,
contact your SAP HANA administrator.

Procedure

On the Home page, select Create New Document.

In the Add new dataset dialog, select Download from SAP HANA One, and select Next.
Select the server to log on to in the Server list.

Enter the port number to log on to in the Instance/Port box.

Connect to the SAP HANA server:

o~ o

Description

If you connect by entering credentials | Enter your user name and password, and select Connect.
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Description

If you connect via single sign on (SSO) | Select the Authenticate by Operating System (SSO) check box, and select
Connect.

6. Select Next.
An Add new dataset: SAP HANA views dialog appears, displaying available SAP HANA views.

7. Expand the SAP HANA view that contains the data to view, and choose the cube that contains the data.
8. Choose which data to acquire:

o To acquire particular dimensions and measures in the data, select Next, choose the dimensions and
measures, and select OK.

o Toacquire all data, select Create.

Results

The Visualize room opens, and you can start building charts and analyzing the data. If you want to modify the
dataset first, switch to the Prepare room.

Related Information

Acquiring data from SAP HANA views [page 29]
Specifying values for SAP HANA variables and string input parameters [page 35]

3.5.3 Accessing SAP BW data in SAP HANA views

You can access SAP Business Warehouse (BW) data that is available in SAP HANA analytic or calculation
views.

In an SAP BW-on-SAP HANA system, you can use the SAP HANA modeler to import SAP BW models (for
example, SAP HANA-optimized cubes, Data Store Objects (DSO), and BW Query Snapshots) as analytic views
and calculation views. Once the models are activated, the application can consume them by connecting to an
SAP HANA cube.

For information about implementing an SAP BW-on-SAP HANA system and about making data available to
SAP HANA, see the FAQ: BW on HANA document at http://www.experiencesaphana.com/community/
solutions/net-weaver-bw/bwonhanafaqf .

Related Information

Downloading data from SAP HANA [page 33]
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3.5.4 Specifying values for SAP HANA variables and string
input parameters

You are prompted to enter a value for an SAP HANA variable or a string input parameter when acquiring an
analytic view in Download from SAP HANA One mode and when creating a document on an analytic view in
Connect to SAP HANA One mode.

Context

Each SAP HANA variable defines a filter on a dimension of a view. You enter a value for each dimension before
datais acquired, and the value appears as a facet row after acquisition.

You enter a value for each SAP HANA input parameter when acquiring data, and SAP Lumira passes the value
to a calculation, such as a formula for a calculated measure. When entering a value for a string input
parameter, you must enter an SQL statement, using single quotes to indicate the beginning and end of the
statement string. For example, enter BUKRS='CALP"' to search for CALP.

Procedure

1. Connect to an SAP HANA instance in Download from SAP HANA One or Connect to SAP HANA One mode.
2. Choose which data to acquire:
o Toacquire particular data, select an analytic view, select Preview and select data, select Select,
choose the dimension values and measures, and select Edit Variables.
When no variables or input parameters are defined in a view, the Edit Variables button is not available.
o To acquire all data available in an analytic view, choose the view, and select Create.
A HANA Variables box appears, listing the variables and input parameters defined for the analytic view.
Variables are prefixed by "VAR" and input parameters are prefixed by "IP."

3. Choose avariable or an input parameter.
The dimension or input parameter value appears in the right pane.

4. Choose one or more values, and select Add.

To choose multiple individual values, press and hold and select each value. To choose a range of
values, press and hold and select the first and last value in the range.

The selected values appear in the bottom pane.
5. Select OK.

6. If you are acquiring data through Preview and select data, select Create to start the data acquisition.
Data appears in the Prepare room, and each variable appears as a facet with the selected prompt values.
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Results

The Variables button appears at the top of the facets pane. Select the button to view the values you chose for
SAP HANA variables.

3.6 Acquiring data from universes

You can acquire data from SAP BusinessObjects universe files.

Universe (.unx) files for SAP NetWeaver BW access are created with the Information Design Tool that is
installed with SAP BusinessObjects Business Intelligence platform. For information about the Information
Design Tool, see the Information Design Tool User Guide.

For information about data federation, see the Data Federation Administration Tool Guide.

For a complete list of supported universes and database access options, see the Product Availability Matrix on
the SAP Service Marketplace at SAP Product Availability Matrix#e.

3.6.1 Connecting to a universe data source

Procedure

1. Onthe Home page, select Create New Document.
2. Inthe Add new dataset dialog, select Universe, and select Next.
3. Inthe Universe credentials pane:
a. Enter the name or IP address of the server that hosts your Central Management Server (CMS).

If you are connecting to a CMS that belongs to a different network domain, make sure the hosts file
located at c: \Windows\System32\drivers\etc has the corresponding host name entry (for
example, x.x.x.x<NameOfMachineHostingCMS>).

b. Enter the CMS user name, password, and authentication type.

c. Touse Windows AD authentication to connect to the CMS, append the following entries in the
SAPLumira.ini file, located at <LumiraInstallDir>\SAPLumira\Desktop:

-Djava.security.auth.login.config=<Path to bscLogin>\bscLogin.conf
-Djava.security.krb5.conf=<Path to kbr5>\krb5.ini

-Djava.security.auth.login.config=C:\Windows\bscLogin.conf
-Djava.security.krb5.conf=C:\Windows\krb5.ini

d. Select Connect.
A list of universes available in the CMS appears.
4. Choose a universe, and select Select.

5. Choose the required objects in the universe tree, and select Acquire.
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Before acquiring data, you can preview the data and apply filters by selecting the Preview and Select Data

option. If a query contains contexts or prompts, you must respond to them before data can be acquired.

When creating a query, you can set the following query properties:
o Max Rows Retrieved: The maximum number of rows to be retrieved by the query.

o Max Retrieval Time: The maximum amount of time a query can run (in seconds).

o Retrieve Duplicate Rows: Select to retrieve duplicate rows.

Results

The Visualize room opens, and you can start building charts and analyzing the data. If you want to modify a

dataset first, switch to the Prepare room.

3.6.2 Troubleshooting messages about universe data

connections

You may encounter these messages and possible causes while working with the universe data source.

Table 8: Troubleshooting messages about universe data connections

Message

Could not connect to Central Management

Server (CMS)

Cause

e The CMS is unresponsive.
® Your user name or password is incorrect.
® The authentication type is incorrect.

e Anetwork issue has occurred.

Could not load the selected universe

e The universe is corrupted.

e The CMS is unresponsive.

® The universe connection is not configured properly.

Could not validate the query

e Thereis anissue with the database connection.

e The data types do not match the object.

e Aresult returned from the server has reached the limit
set forthe Maximum Character Stream Size

(MB) configuration parameter in the SAP Web

Intelligence Report Server.

e One or more universe objects are not configured prop-

erly.

Query returns no row sets

A query for the object returned no data.
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3.7 Acquiring data using Query with SQL

You can create a data provider by manually entering the SQL for a target data source. You can specify the
source tables, columns, and functions used to acquire data.

For a complete list of database middleware that Query with SQL can access, see the SAP Product Availability
Matrix .

Table 9: Supported database middleware drivers

Supported database mid- | How to obtain the driver

dleware
Amazon Redshift The Simba Redshift driver is included with SAP Lumira.
Apache Spark Manually install the driver in SAP Lumira as described in the section “Installing data access

drivers”. Select the Generic JDBC datasource - JDBC Drivers database.

The driver binaries are located at <InstallDir>\Program Files\SAP Lumira
\Desktop\utilities\SparkJIDBC\. There are multiple . jar files in that location.
Select all of them during driver installation.

Apache Amazon EMR and Apache Hive Simba drivers are included with SAP Lumira.
Cloudera The Cloudera Impala Simba driver is included with SAP Lumira.
IBM DB2 Go to the IBM DB2 connectivity download page at https://www.ibm.com/account/

profile/us?page=reghelpdesk # . Choose the appropriate driver for your database, save the
compressed installation file to your computer, extract the compressed file (db2jcc. jar)
to alocal directory, and run the installer from your computer. For versions earlier than 9.5,
you must extract do2cc.jaranddb2jcc license cu.jar instead.

Before you can download a driver, you must register using a free IBM-recognized user email
address as the account name. If you do not know which version of the driver to use, both
drivers for DB2 version 10.1 [DB2 version 10.1 FPO (GA) and version 10] are suitable for all
versions later than DB2 version 9.5. For more information, contact your database adminis-

trator.
IBM Netezza See your Netezza administrator.
Microsoft SQL Server Go to the SQL Server 2005, 2008, and 2012 Microsoft Drivers download center page at

http://www.microsoft.com/en-us/download/driver.aspx?q=driver # . Choose the appro-
priate driver for your database, save the installation file to your computer, and run the instal-
ler from your computer.

If you don't know which version of the driver to use, Microsoft JDBC Driver 4.0 for SQL
Server is suitable for all supported SQL server versions. If you are installing JDBC Driver 4.0
for SQL Server, the driveris sgljdbc 4.0.2206.100 enu.exe fora Windows operat-
ing system. The sgqljdbc4. jar driver file is extracted to \sgqljdbc_4.0\enu\, inthe
specified extraction folder.
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Supported database mid-

dleware

Oracle

How to obtain the driver

Go to the Oracle JDBC Driver Downloads page at http://www.oracle.com/technetwork/
database/features/jdbc/index-091264.htm| #*

Before you can download a driver, you must create a free user account. If you don't know
which version of the driver to use, ojdbc14. jar is suitable for any supported version of
Oracle 10 and 11.

Salesforce

The Salesforce driver is installed by default; you do not need to install it. However, you do
need to get a logon token before being able to acquire Salesforce data.

Log on to the Salesforce website and go to |} My Settings > Personal > Reset My Security

Token ] A logon token will be sent to you by email.

Append the token to the end of your password when logging on to SAP Lumira.

Sybase

The Sybase driver (jconn4 . jar) is installed by default; you do not need to install it. It is
located at \\<InstallDir>\Program Files\SAP Lumira\Desktop\plugins
\com.businessobjects.connectionserver.standalone 3.1.3.v201206
03-0404\ConnectionServer\jdbc\drivers\IQ15.

Teradata

Go to the Teradata connectivity download page at http://downloads.teradata.com/down-
load/connectivity/jdbc-driver # . Choose the appropriate driver for your database, save the
compressed installation file to your computer, extract the compressed file to a local direc-
tory, and run the installer from your computer.

Before you can download a driver, you must create a free user account. If you don't know
which version of the driver to use, the Teradata JDBC Driver 14 is suitable for all supported
Teradata versions. For Windows, use TeraJDBC __indep indep.
14.00.00.14.zip.Once extracted, the driver files are tdgssconfig. jar and
terajdbcé4.jar.

IBM Puredata

See your Netezza administrator.

Informix Dynamic

See your IBM administrator.

GreenPlum 4

See your GreenPlum administrator.

Table 10: JDBC drivers for typical database middleware

Database middleware

’ JDBC driver available

Oracle ojdbclé.jar

Microsoft SQL Server sgljdbc4d.jar

Teradata terajdbcd.jarand tdgssconfig.jar
Sybase jconn4.jar
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Database middleware ’ JDBC driver available

IBM DB2 db2jcc.jarordb2cc.jar and

db2jcc_license cu.jar forversions earlier than 9.5

IBM Netezza nzjdbc.jar

Related Information

Installing data access drivers [page 40]
Connecting to a Query with SQL data source [page 42]
Query with SQL connection parameters [page 44]

3.7.1 Installing data access drivers

The Sybase |Q 15 data access driver is automatically installed with the application. For other databases, you
may need to install the JDBC data access driver for your database middleware, before using Query with SQL.

Prerequisites

e You must be familiar with your database and with the SQL language.

® The correct data access driver must be installed for your database middleware. A data access driver is the
software provided by a database vendor that allows a client application to connect to middleware and to
access data in a database. You copy the data access driver for your middleware from your database
vendor support web site to a local folder, and then you can select the driver in the application and connect
to the database.

1 Note

Installing data access drivers from a vendor site can be problematic due to the variety of driver versions
and file formats. If you are unfamiliar with your database version or the vendor web site, contact your
database administrator.

Context

Follow these general steps to obtain a data access driver:

1. Download the data access driver (a . jar file) from the database vendor site, and copy the file to a local
folder.
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2. Register the driver path by selecting the driver in the application.

3. Select a Query with SQL data source on the SOL Drivers tab in the application preferences.
You can select an installed SQL driver or install the required driver.

Procedure

1. Select | File » Preferences » SQL Drivers J.
The Driver Installation page lists database middleware names and the status of drivers:

o When the status check mark is green, the driver is correctly installed and you can start using Query
with SQL.

o When the status check mark is red, the driver is not installed for that middleware and you must install
it.

o When the status check mark is yellow, a compatible driver is available for the middleware, but the
application must be restarted before it is available. Once the software has restarted, you can use
Query with SQL.

2. Choose a data source, and perform one of the following actions:

Option Description

If the data source middleware has a green | Select Next, enter the middleware connection information, and select
check mark Create.

The data access drive is installed. You do not need to perform the re-
maining steps in this task.

If the data source middleware has a yel- Restart the application, and repeat step 1.
low check mark

If the data source middleware has a red Go to step 3.
check mark

3. Ifthe middleware driver is not configured, select the Install button, choose the database driver, and select
Install Drivers at the top of the database list.

4. Inthe selection box for locally available middleware:

Option Description

If the correct . jar fileis listed Go to step 6.

If the correct . jar file is not listed | Download the driver from the vendor support site, install the driver, select
Cancel to close the driver selection box, and then download and install the cor-
rect . jarfile.

You must access the web page that lists JDBC data access drivers for the middleware vendor. Depending
on the database, different types of driver files are available; usually a compressed file containing the
drivers or an executable file to install the drivers automatically. For the application, download only the
compressed file.

5. Onyour vendor's support web site, download the compressed JDBC driver file (for example, a . tar, .gz,
or . zip file) for your database middleware version.

6. Onyour computer, select the folder that contains the extracted JDBC driver files for your database
middleware.
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A complete list of supported JDBC drivers is included in the Product Availability Matrix, available on the
SAP Service Marketplace site at https://support.sap.com/pam#.

7. Restart the application.
The list of available database middleware drivers is updated.

Results

When you use Query with SQL to create a new document in the application, the target database middleware is
listed with a green check mark, indicating that the driver is available to access the database.

1 Note

You can refresh the Lumira documents successfully if you have the higher version of SQL Drivers for drivers
such as Teradata 14, Teradata 15, PostgreSQL 9, Oracle 11, Oracle 12, and DB2 10 for LUW installed in SAP
Lumira. For example, if you have Teradata 14 in the set of SQL Drivers, you can refresh the Lumira
documents..

3.7.2 Connecting to a Query with SQL data source

You can connect directly to a database to specify the data to acquire and to set parameters to optimize the
database connection.

Prerequisites

e You must be familiar with your database and with the SQL language.

e The correct data access driver must be installed for your database middleware. A data access driver is the
software provided by a database vendor that allows a client application to connect to middleware and to
access data in a database. You copy the data access driver for your middleware from your database
vendor support web site to a local folder, and then you can select the driver in the application and connect
to the database.

1 Note

Installing data access drivers from a vendor site can be problematic due to the variety of driver versions
and file formats. If you are unfamiliar with your database version or the vendor web site, contact your
database administrator.

You need to install a JDBC data access driver for your database middleware before using Query with SQL. The
data access driveris a . jar file that you download from a database vendor site and copy to the driver folder in
the application installation path. Refer to the Related Information about finding and installing the correct data
access driver for your database middleware.
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Procedure

On the Home page, select Create New Document.

In the Add new dataset dialog, select Query with SQL, and select Next.

Choose the database middleware for the target database and select Next.

Enter your logon credentials and, if necessary, select Advanced to adjust advanced driver parameters.
Select Connect.

Choose a table, or type an SQL query to fetch the required table.

Select Preview, and choose the columns you want to acquire.

® N OO AW e

Select Create.
You can now start building charts and analyzing data in the Visualize room. If you want to modify the

dataset first, use the Prepare room.

Related Information

Query with SQL connection parameters [page 44]
SQL editor options for Query with SQL [page 43]
Installing data access drivers [page 40]

3.7.2.1 SOQL editor options for Query with SQL

Use an SQL editor to write SQL and create a Query with SQL data source, based on a connected database. The
SQL editor is accessed from the Query with SQL connection option when you create a new document.

Only the SELECT statement is authorized in the SQL editor to acquire data from database tables. Use these
SQL editor options to select tables for the data source:

Table 11: SQL editor options

Option Description

Catalog The accounts available to the connected database. Expand each node to see the tables available.
Double-click a table to add the table to the SQL query.

Query The SELECT query to fetch tables. (Only SELECT is supported.) You can add table names by
double-clicking the table in the account node in the left pane.

SQL History Keep a log of the SELECT statements used in the query pane. Choose a statement to include it in
the query.

Preview data Select this option to preview the tables that are acquired by SELECT.

Select All/None Choose all or no columns, or choose individual columns for acquisition.
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Related Information

Connecting to a Query with SQL data source [page 42]

3.7.3 Query with SQL connection parameters

You can create your own data provider by manually entering the SQL for a target data source to acquire table
data. When using Query with SQL, you must enter connection information for the target database, and you can
specify connection parameters to optimize the fetching of data.

Table 12: Logon parameters

Parameter Description
User name The user name that you use to connect with the target database
Password The password that you use to connect with the target database

Server (<host>:<port>) | The name and port of the server hosting the database

Database The database name

Table 13: Advanced parameters

Parameter Description

Connection pool mode If using a connection pool, use to keep the connection pool mode connection active.

Pool timeout If the connection pool mode is set to Keep the connection active for, the length of time in
minutes to keep the connection open.

Array fetch size The maximum number of rows authorized with each fetch from the database. For ex-
ample, if you enter 20, and your query returns 100 rows, the connection retrieves the
data in five fetches of 20 rows each. To deactivate array fetch, enter an array fetch size
of 1. Data is retrieved row by row.

Deactivating the array fetch size can increase the efficiency of retrieving your data, but
it slows server performance. The greater the value in the array fetch size, the faster
your rows are retrieved. However, ensure that you the client system has adequate
memory.

Array bind size Size of the bind array before it is transmitted to the database. Generally, the larger the
bind array, the more rows (n) can be loaded in one operation, and performance will be
optimized.

Login timeout The number of minutes before a connection attempt times out and a message appears.
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Parameter

Description

JDBC driver properties | Valuesfor JDBC driver properties. You can define the value of more than one property,
separated by commas. For example, the
oracle.jdbc.defaultNChar=true,defaul tNChar=true value for JDBC
driver properties sets the oracle.jdbc.defaultNChar and defaultNChar

driver properties.

3.8 Acquiring data from Hadoop

You can acquire data from Apache Hadoop data sources.

Organizations that generate very large amounts of data (“Big data") may store their data in an Apache Hadoop
Distributed File System (HDFS). But working with entire sets of Hadoop data in analysis tools can lead to poor
performance. Therefore, to maintain good performance when analyzing Hadoop data, Lumira Desktop lets you
acquire a sample of the Hadoop data, create your visualizations and stories based on that sample, and then
generate the full dataset.

You can also work directly with the full dataset without first acquiring a sample. In either case, Lumira Desktop
acquires a maximum of 1 million rows, but you can change that limit by adding or changing this property in the
SAPLumira.ini file, located at <L.umiraInstallDir>\SAP Lumira\Desktop:

-Dhilo.hivemaxsamplingsize=<VALUE>

You can acquire Hadoop data directly from HDFS files, or you can acquire data using Apache Hive or Cloudera
Impala queries. Also, you can merge a Hadoop dataset with another dataset, but only if the other dataset is
also in Hadoop. If the other dataset isn't already in Hadoop, you can add it to Hadoop first.

1 Note
In this release, when using Hadoop data, some Lumira Desktop features are disabled:

e (Calculated dimensions
e Display formatting
e Semantic enrichment (for geographic and time dimensions)
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3.8.1 Connecting directly to Hadoop HDFS files

You can acquire data directly from Apache Hadoop HDFS files.

Procedure

On the Home page, select Create New Document.
In the Add new dataset dialog, select Connect to Hadoop, and select Next.
Specify the URL and port number of the WebHDFS Server.

Provide Username and Password.

N N

1 Note

In previous releases, Password field option for connecting to Hive or Hadoop data sources was not
supported. This was because the Lumira desktop only supported the Big Data Exploration workflows
without authentication. However, with this release, you need to provide you user credentials while
connecting Hive or HDFS data sources and scheduling workflows on a Kerberos enabled cluster. This
eliminates the use of external tools like MIT Kerberos. Therefore, the system does not save the acquired
tickets and once application is closed credentials are not available.

5. Choose Connect.
6. Select the directory where you want to acquire data from.
7. Specify how many lines of data you want to sample.

The number of lines of data that you specify are sampled from the first file in the directory. Data from the
file is previewed in the Add new dataset dialog.

1 Note

All files within the directory must have the same file structure.

8. (Optional) Adjust the dataset options in the dialog as needed.
9. Select Create.

Results

The data is acquired and appears in the Prepare room. A SAMPLE button at the top of the window reminds you
that you're working with only a sample of the full dataset. You can select the button to see details of the
sampled data.

Related Information

Generating the full Hadoop dataset [page 48]
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3.8.2 Connecting to Hadoop using Hive or Impala

You can acquire data from Apache Hadoop by using Hive or Impala queries.

Procedure

On the Home page, select Create New Document.
In the Add new dataset dialog, select SOL on Hadoop, and select Next.

Specify a database driver, the URL and port number of the Impala or Hive server.

N N

Provide Username and Password.

1 Note

In previous releases, Password field option for connecting to Hive or Hadoop data sources was not
supported. This was because the Lumira desktop only supported the Big Data Exploration workflows
without authentication. However, with this release, you need to provide you user credentials while
connecting Hive or HDFS data sources and scheduling workflows on a Kerberos enabled cluster. This
eliminates the use of external tools like MIT Kerberos. Therefore, the system does not save the acquired
tickets and once application is closed credentials are not available.

Choose Connect.
In the left pane, select the schema or table that you want to acquire data from.

In the right pane, select the columns you want to acquire.

© N o«

At the top of the dialog, choose whether you want to acquire just a sample of the dataset, and if so, specify
a sampling rate percentage.

Sampling is done by randomly choosing rows in the dataset.
9. Select Create.

Data from the file is previewed in the Add new dataset dialog.

Results

The Visualize room opens, and you can start building charts and analyzing data. If you want to modify the
dataset first, switch to the Prepare room. A SAMPLE button at the top of the window reminds you that you're
working with only a sample of the full dataset. You can select the button to see details of the sampled data.

Related Information

Generating the full Hadoop dataset [page 48]
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3.8.3 Generating the full Hadoop dataset

After you've acquired a sample of your Hadoop data and created your visualizations and stories, you can
reapply your data transforms to generate the full Hadoop dataset, using the Oozie scheduler. For example, if
you've split or removed columns in the sample dataset, those transforms are applied when generating the full
Hadoop dataset.

Prerequisites

e The Apache Oozie Workflow Scheduler must be installed as part of your Hadoop deployment.

e Specify parameters for the Hadoop WebHDFS Server in |» File  Preferences » Network 4. The directory
that you specify is where Lumira Desktop looks for the results of the scheduled files.

Procedure

1. Select the SAMPLE button.
2. Select Generate Full Dataset.
3. Inthe Schedule Hadoop Job dialog, choose your settings:
o Specify the Output Options:
o Full Dataset Output Directory
o Full Dataset Table Name
o Compress Files
o Generate SAP Lumira file with full dataset:
If you select this option, a . 1ums file is generated and saved in your Hadoop platform. You can
save Hadoop datasets just like any other datasets, but be aware that the resulting . 1ums file can
reach hundreds of megabytes in size. The . 1ums file can be copied to a local disk for faster
access.
If you don't select this option, Lumira Desktop generates just a Hive table.
o Askyour IT administrator for the Oozie settings.

o Specify the same settings for the Hadoop WebHDFS Server as are specified in |+ File  Preferences
Network 3.
4. Select Schedule.

The full Hadoop dataset is generated. This can take several minutes, depending on the size of the Hadoop
dataset. Also, the SAMPLE button is no longer displayed.
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3.9 Editing an acquired dataset

After a dataset has been acquired, you can edit it.

Context

You can edit this information in acquired datasets:

e Add new columns that were removed from the data source when it was originally acquired
e Remove columns that were included in the original data source

e Change values selected for SAP HANA variables and input parameters

e Edit the SQL query for a Query with SQL data source

Procedure

1. Open a dataset that is already acquired in the application.

2. Select | Data ¥ Edit data source 3.

3. Perform one or more of the following actions:

o Select a column name check box to add a new column.
o Clear a column name check box to remove a column.

o Tochange SAP HANA variables and input parameters, select Edit Variables, enter or delete values for
variables or input parameters, and select OK.

o Edit the SQL query for a Query with SOL data source
4. Select OK.

The document is refreshed. If the data source has undergone a model change, such as columns being
added or removed, the Data Mapping dialog opens so that you can resolve the model changes.

3.10 Refreshing data in a document

The data that is saved with a document can become stale or invalid. Refresh the document to get fresh data
from the data source.

Context

For example, if you have an Excel data source comprising two columns <Name> and <Age>, and you acquire
the Excel data into SAP Lumira, but later the numbers in the Excel data are updated, you may want to refresh
the document to reacquire the updated Excel data.
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Dataisn't automatically refreshed if the data source has undergone a model change, such as columns being
added or removed. For example, if in the above Excel file the <Name> columnis splitinto <First Name>and
<Last Name> columns, the <Name> column in the data source no longer exists and the refresh fails.

If the data can't be refreshed automatically, the Data Mapping dialog helps you to refresh your data manually,
by mapping columns in your dataset to columns in the data source.

Procedure

Ty
1. If your document is open in the Prepare room, select the * licon. Or, if you're working in the Visualize

T

k_-

room, select the down-arrow next to the icon and select either Refresh or Refresh data with prompts.

If your data source contains variables, choosing the Refresh data with prompts option lets you reselect
variable values before the data is refreshed. These data sources support refreshing with prompts:

o Connect to SAP HANA

o Download from SAP HANA

© Download from SAP Business Warehouse
o SAP Universe Query Panel

If the data source model has not changed, the data is refreshed.
If the data source model has changed, the Data Mapping dialog appears. The dialog lists the datasets in
your document that can't be automatically refreshed. Complete the rest of these steps:
2. For query-based data sources, for example MySQL, select Edit Query.
In the Edit data source dialog, redefine your query, and select OK when finished.
3. Select a dataset in the Data Mapping dialog.
The Changed Columns for that dataset are shown.
4. Using the drop-down lists, choose columns from the data source to map the Changed Columns to.

You can map columns only to other unused columns of the same type. You can also remove any columns
that you no longer need in your dataset, but be aware that any dependencies based on the removed
columns will be removed as well.

Using the above Excel example, you could choose the changed column <Name>, and map it to the <Last
Name> Or <First Name> column from the drop-down list.

Related Information

Showing the latest data in a story page [page 156]

Editing an acquired dataset [page 49]

Specifying values for SAP HANA variables and string input parameters [page 35]
Prompting and SAP HANA variables and input parameters [page 138]
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3.11 Datetime and Time data types

Older versions of Lumira Desktop did not support Datetime (a data type containing both date and time
information; for exampe, timestamps) or Time data types. When data was acquired from data sources that
included time and datetime data, Lumira Desktop converted time data to string data, and datetime data to
date data (truncating the time information). When these datasets were saved as Lumira Desktop documents,
they were saved with the string and date data types.

When documents containing these older datasets are opened, saved, or refreshed in newer versions of Lumira
Desktop, they remain unchanged. The time and datetime information is not converted back to time and
datetime data.

Because Lumira Desktop now supports Time and Datetime data types, if you acquire a new dataset froma
data source that contains time or datetime data, even if it's the same data source whose time and datetime
data was converted to string and date data in an older version of Lumira Desktop, the time and datetime
information is acquired as Time and Datetime data.

3.12 Renaming a dataset

You can rename a dataset in the Prepare and Visualize room.

Procedure

Open a dataset.

In the Prepare or Visualize room, select the dataset name.
Change the name of the dataset.

Press[enter], or select an area outside the dataset name field.

A w oo

3.13 Objects hidden from the object list

Use the enrichment suggestions file to prevent specific columns from being proposed as measures in the
application when data is acquired.

To prevent specific columns from being proposed as measures when data is acquired, the application uses the
enrichment suggestions.<VersionNumber>.txt file toidentify columns that should not be proposed as
measures.

The first time you create a document, the file is saved in your @user.home/ . sapvi directory (for example C:

\Users\<YourUserName>\.sapvi).

By default, column names in the enrichment suggestions file are in English. However, you can define names in
other languages, specify column names to hide from the objects list, and prevent objects from being
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considered time or geographical objects. The enrichment will be processed if you selected automatic
detection of enrichments in the application preferences.

When you upgrade the application, a new version of the enrichment suggestions file is saved, without
overwriting the original file. You can use the original file as a reference to modify the new suggestions file. The
application will use the file name that corresponds with the installed version of the application.

3.14 Editing the enrichment suggestions file

Edit the enrichment suggestions file to identify which objects should not be proposed as measures or as time
or geographic attributes on the Measures and Dimensions panel.

Context

You can define as many rules as you require inthe enrichment suggestions.<VersionNumber>.txt file.
For each rule, you must declare four properties. The syntax is Java regex and metadata is not case-sensitive.

Table 14: Properties required for each rule in the enrichment suggestions file

Required property Description

objectName Pattern matching on the object name (column header). Any character can be

used. When . *DAY . * is used, any object containing the string DAY is included
in the rule (MONDAY, TUESDAY, and so on).

dataType List of data types. Recognized data types are:
® integer
® Dbiginteger
® double
® string
® date
® Dboolean
Any column name, with any data type, will be considered for exclusion from the

proposal pane. If no dataType property is declared, all data types are consid-
ered.

enrichment Prevents objects from appearing. The values are MEASURE or TIME (time hier-
archy objects) or GEO (geographic hierarchy objects).

rule Defaults to hide. Do not change this value.

The following example shows the default enrichment file:

{

"version":"1.0",
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"policies": {

by

"suggestionRules": [
{
"objectName":" (?i) .*year.*|.*month.*|.*quarter.*
| . *week|.*day|.*semester.*|.*hour|.*minute|.*second",
"dataTypes":["integer", "biginteger", "double"],

"enrichment":"MEASURE",
"rule":"hide"

"objectName":" (?i) .*zip.*",
"dataTypes":["integer", "biginteger", "double"],
"enrichment":"MEASURE",

"rule":"hide"

"objectName":"(?i).*_id\\d*",
"dataTypes":["integer", "biginteger", "double"],
"enrichment":"MEASURE",

"rule":"hide"

"objectName":" (?1i) . *key.*",
"dataTypes":["integer", "biginteger", "double"],
"enrichment":"MEASURE",

"rule":"hide"

"objectName":" (?i) .*zip.*",
"dataTypes":["integer", "biginteger", "double"],
"enrichment":"TIME",

"rule":"hide"

"objectName":" (?1) .* id\\d*",
"dataTypes":["integer", "biginteger", "double"],
"enrichment":"TIME",

"rule":"hide"

"objectName":" (?1i) .*key.*",
"dataTypes":["integer", "biginteger", "double"],
"enrichment":"TIME",

"rule":"hide"

Procedure

1. Opentheenrichment suggestions.<VersionNumber>.txt filein atext editor.
2. For each object, define the data type(s), enrichment, and other properties as needed.
You must keep "rule" setto "hide".

3. Save the file with the same name.

SAP Lumira, desktop edition User Guide
Acquiring data PUBLIC 53



4 Prepare room—viewing,
cleaning,manipulating, and sharing data

When data is first acquired by the application, it is raw data that is often formatted inconsistently and is not
easily interpreted by business users. Before creating charts to visualize your data, it is often necessary to
prepare the data so that it is presentable and understandable. Use the tools in the Prepare room to view and
prepare data.

These are the main areas where you interact with the Prepare room:
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Table 15:
Number Area Description
1 Measures and Dimensions panel Lists the measures and dimensions that were detected in the data.
Use tools on the Measures and Dimensions panel to define and to edit
measures and to create hierarchies.
2 dataset selector The document may contain multiple datasets. Use the dataset selec-
tor to add a new dataset and to choose between different datasets.
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Number Area Description

3 filter bar Displays filter tokens that represent filters applied to the dataset.

To add afilter to a column or a dimension, select the column or dimen-

sion and select the # icon that appears.

4 Data Pane tools Use these tools to change the data display, add calculations, merge
data, refresh data, and undo user actions.

5 column details Select a column in the Data Pane to display information about its val-

ues:
(Manipulation Tools panel)

e View each unique value in the column, along with the number of
times it occurs.
e Search for avalue in the column.

e Sort the display by value or by number of occurrences.

6 Dataset status Shows the number of rows and columns in the dataset that are visible

in the Data Pane.

For example, consider the message Showing: 75000/75000 Rows -
48/50 columns. This indicates that all 75000 rows in the dataset are
visible, while 48 columns are visible and 2 columns are hidden.

7 refresh status Indicates the last time the dataset was refreshed.

Sl |
Select| ™= | to refresh the data.

8 Data Pane Displays the data in the currently selected dataset.

e Select Grid ®EE to display data in columns and rows. All rows are

displayed.
e Select Facets D to display only the unique values in each col-
umn. The number of times each value occurs is also displayed.

9 Data Actions Select a column in the Data Pane to display the data actions. The data

(Manipulation Tools panel) actions available depend on the type of data in the selected column.

Related Information

Measures and Dimensions panel [page 56]
Data pane [page 56]

Manipulation Tools panel [page 58]

Data actions for columns [page 58]

SAP Lumira, desktop edition User Guide
Prepare room—viewing, cleani ipulating, and sharing data PUBLIC 55




4.1 Measures and Dimensions panel

The Measures and Dimensions panel is located to the left of the Chart Canvas. It lists the measures,
dimensions, hierarchies, and inferred dimensions in a dataset.

Table 16: Objects on the Measures and Dimensions panel

Object Description

Measures A map to aggregated data in a column or calculation. You use measures to get a calculated re-
sult when columns are combined. For example, a measure called Sales Revenue would repre-
sent the column Sales Revenue that contains the summed revenue for sales. Measures are au-
tomatically detected and listed.

Dimensions A data object that represents categorical data in a dataset.

Hierarchies A reference to more than one related column in a dataset; the columns have hierarchical rela-
tionships. For example, an object Time could include Year, Quarter, and Month columns ar-
ranged in a hierarchical structure under the top object Time.

Attributes Maps to a column in a dataset.

Inferred dimensions One or more columns created from geography or time data that is available to the application
(to support a hierarchy).

Related Information

Creating a geographic hierarchy with location names [page 68]
Creating measures [page 72]
Creating hierarchies [page 64]

4.2 Datapane

The Data pane is the central pane that shows your data in the Prepare room.
Use the Data pane to view, organize, edit, and prepare datasets for visualizations.

Table 17: Options on the Data pane

Description

Data source selection Lists the data sources connected in the current session. You can use the list to toggle be-
tween datasets and to add datasets.
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Option Description

Data filters Lists the filters that are applied to column data. You can edit or remove the filters in the
list.

Grid [T
Select ®EE to display data in columns and rows. All rows are displayed.

Facets

-

umns are not shown.) Using facets can be helpful when a dataset includes many repeated

Select to display only unique values in data, in columns. (Repeated values in col-

values.

Show/Hide columns

n
Select ILI to show or hide columns in a dataset.

Calculation

W
Select to add calculated dimensions or measures.

Combine

@ v

datasets into the current dataset, but the data must be compatible. You can append an-

Select to merge or append data to a dataset. You can merge data from multiple

other dataset to the current one. Data in common columns is appended to the current da-
taset, and data in unique columns is added in new columns.

Refresh the document data

Ty
Select| ™= | to refresh the dataset(s) used in the document.

Undo

Select 5 to reverse the last action. You can undo most actions, but actions that
change the underlying data, such as adding or updating the data, clear the undo history.

Redo

Select ] to repeat the last action.

Related Information

Editing and cleaning data [page 60]

Filtering data [page 61]

Adding a dataset [page 77]

Merging datasets (JOIN) [page 78]
Switching to another dataset [page 78]

Creating a calculated measure or dimension [page 74]
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4.3 Manipulation Tools panel

The Manipulation Tools panel is located on the right side of the Prepare room and contains tools for editing and
formatting values.

Depending on the data type of the selected column, you can use the panel to perform the following tasks:

e Duplicate, rename, and remove columns
e (Create calculated dimensions

e Find, replace, and change string values
e Fillin prefixes and suffixes

e Convert, trim, and group values

e [Edit text strings

4.3.1 Data actions for columns

Data actions for columns containing characters, dates, and/or numbers are listed on the Manipulation Tools
panel. The actions that are available depend on the type of data in the column.

To show the data actions available for a column, select the # icon next to the column name or right-click the
name.

Table 18: Options on the DATA ACTIONS panel

Description Available from menu | Available for

in column header

Duplicate Inserts a new column that is a copy of this col- Yes Yes Yes Yes
umn.

Rename Changes the name of this column to a specified | Yes Yes Yes Yes
name.

Split Divides this column after a specified split point No Yes No No

and moves all string values after that point to a
new column. The split can be a punctuation mark
(for example, a comma) or a text string.

Remove Removes this column. Yes Yes Yes Yes

Convert Case | Converts text in this column to lowercase or up- | No Yes No No
percase.

Replace Finds a specified string in this column and repla- | No Yes No No

ces it with another specified string.
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Description Available from menu | Available for

in column header
Charac- Dates

ters

Fill Prefixes or suffixes a specified string with a No Yes No No
specified character, to a specified length.

Convert to Converts all values in this column to text. Yes No No Yes
Text

Convert to Converts all values in this column to integers. No Yes No No
Integer

Convert to Converts all values in this column to numbers. Yes Yes No No
Number

Convert to Converts all values in this column to dates, times, | Yes Yes No No

Date/Time or datetimes, in the selected format.

Trim Removes characters in this column before or af- | No Yes No No
ter a specified punctuation mark or character.

Group by Creates a group for the values selected in this No Yes Yes Yes
Selection column.
Group by Creates a group for a specified range of valuesin | No Yes Yes Yes
Range this column.
Create Creates a new column and applies a specified No No Yes Yes
Calculated function to values in the new column.
Di .
fmension For example, a "Floor" function can be applied to

a "Margin" column to create a new column of

margin values, rounded down to the nearest

whole number.
Cell inner In the Grid or Facets view: No Yes No No
selection

® Removes text in a specified word or range of
characters in this column

® Replaces text in a specified word or range of
characters in this column

e (Creates a new column with data copied from
this column and cleaned (for example, with
"resort" removed from the data)

® Moves specified text to the beginning of
each row value in this column
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Description Available from menu | Available for

in column header
Charac- Dates | Num-

ters bers

Concatenate | Joins two or more columns, with an optional No No No No
specified separator and name for the merged
column.

Concatenate options become available when you
select two or more columns.

4.4 Editing and cleaning data

You use the Manipulation Tools panel to edit and format values in a column. The panel is available in the Grid
and Facets views.

Context

Some data actions on the Manipulation Tools panel are also accessible by selecting the # iconin a column
name or by right-clicking the column name.

Procedure

1. Perform one of the following actions:

To edit all values in a single column Select the column header.

To edit all values in multiple columns Press and select each column header.

To edit an individual value Select acell.

To edit multiple values in a column Press and select each cell.

To edit a range of characters or a word within a cell (Character values only) Double-click in the Grid view or

(cell inner selection) slow double-click in the Facets view, and select a range of
characters or a word.

2. Openthe Manipulation Tools panel to the right of the Data pane.
Unique column values appear in a Values box at the top of the panel. You can select one or more values to
edit in this box, or enter a search string in the Find box. Selections in the editor panel override the value
selections made directly in a column. The data actions available for a column depend on the data type of
the column and on whether a column, cell, or range of characters within a cell is selected.
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3. Select an editing option on the Manipulation Tools panel, modify the values as needed, and select Apply.

4.41 Filtering data

A filter is a restriction imposed on a dataset to limit the values displayed. You create filters by choosing values
or ranges of values from a dimension to include or exclude.

You can filter data in an entire dataset or in a single visualization. Filters applied to a dataset affect any chart
that uses the data. However, filters applied to a visualization affect only the current chart (not the entire
dataset).

In the Prepare room, you can add or edit dataset filters. All of the filters that are defined on the dataset appear
in the filter bar at the top of the Data pane.

In the Visualize room, you can work with filters applied to the dataset as well as filters on the current
visualization.
Example

If a dataset includes data on revenue for products sold over years between 1995 and 2012 and you only
want to analyze revenue data for the years 2010 to 2012, you can create a dataset filter on the dimension
Year to limit the values shown to this period.

When composing or viewing stories, you can also filter data in invidiual visualizations, in an entire page, or in
the whole story. These filters don't affect data in the Visualize or Prepare room, though, and you won't be able
to edit dataset filters while viewing or composing stories.

Related Information

Filtering data in the Visualize room [page 117]
Filtering data in stories [page 163]

4411 Using the filter dialog in the Prepare room

You use the filter dialog in the Prepare room to define a filter on the dataset and all of the visualizations based
onit.

Context

The filter dialog does not support SAP Lumira formula language or regular expressions (regex). You may need
to add a calculated measure or dimension to create a more complex filter.
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Procedure

1. To open the filter dialog in the Prepare room, select the Options # icon in a column header or for a
dimension, and select Filter.

You can also select the token for an existing dataset filter to edit it in the filter dialog.

2. Onthe filter dialog, choose an operator from the list.

3. Specify the filter values:

Operator Description

Between

Type a beginning value and an end value.

Equal to, Not Equal to,
Greater than, Greater than
orequal to, Less than, or
Less than or equal to

Type a value.

Contains Type a string that is contained in all of the values that you want to include. For
example, filtering a dimension of clothing product categories for shirt would return
values such as T-shirts, long-sleeve shirts, shirt dresses, and so on.

Like or Not Like Type a pattern that matches all of the values that you want to filter or exclude. You can

use the following wildcard characters in the pattern:
© The _ character matches any single character. For example, filtering a dimension
of US state abbreviations for A_ would return the values AL, AK, AR, and AZ.
o The % character matches any number of characters. For example, filtering a
dimension of US state names for A%a would return Alabama, Alaska, and Arizona.

In List or Not In List

62 PUBLIC

Select values from the list in the filter dialog.

©  Youcanhold while clicking values to select a range of values.

o With alphanumeric dimensions or numeric integer dimensions, you can select the
box of filter values to show the values as comma separated text. You can then
type values, or paste a CSV list. If your values include commas, surround each
value with quotation marks. For example, "New York, NY", "Los
Angeles, CA", "Chicago, IL"

If you enter a value that does not exist in the dataset or visualization, it is saved
with the filter. This way, you can filter values that are added to the data after the
filter is created.

o You can also select the Options ﬁ icon to change the filter dialog settings,
including displaying the number of times that each record occurs in the dataset,
and sorting the data by value or by number of occurrences.

o When filtering an integer or alphanumeric dimension, you can select the Find 0\

icon to search for a member by name. By selecting |} Options > Enable wildcard
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Operator Description

search } you can search alphanumeric dimensions using the _ and % wildcards

described in the previous row.

4. Select Apply.

Results

The data is filtered and a token representing the filter is added above the Data pane.

Next Steps

You can edit the filter by selecting the token in the Prepare room or Visualize room, or remove it by selecting

the Delete 'ﬂ' icon.

Related Information

Creating a calculated measure or dimension [page 74]

4.4.2 Formatting numbers and dates

You can choose a display format for number, date, time, and datetime columns.

Context

For example, numbers can be displayed as percentages or in scientific notation, and negative numbers can be
displayed in parentheses. You can also add a custom symbol or character string as a prefix or suffix to the
displayed values.

Procedure

1. Open the display format dialog from the Measures and Dimensions panel or from the Data pane in the
Prepare room:
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o Onthe Measures and Dimensions panel, select the Options # icon beside a measure or dimension,
and select Display Formatting.

o Inthe Data pane in the Prepare room, select the Options # icon in the header of a number or date
column, and select Display Formatting.

2. Select formatting options and select OK.

o If you're adding a character string prefix or suffix, the maximum number of characters is 256.
o For Datetime dimensions, both date and time formatting options are available.

o Fractional seconds are available only for Datetime dimensions, and can be used only when the 24-
hour time format is selected.

4.4.3 Converting data to another type

You can convert data from one type to another. For example, you can convert text to dates or numbers to text.

Procedure

1. Perform one of the following actions:

o Onthe Measures and Dimensions panel, select the Options # icon next to a dimension.

o Inthe Data pane, select the # icon in a column heading.
2. Inthe data conversion dialog, select options as needed, and select OK.
If you're converting to Date, Time, or Datetime values:
o If the dimension you're converting contains only time values, leave the Date format list set to None.
o Ifthe dimension you're converting contains only date values, leave the Time format list set to None.

4.5 Creating hierarchies

If the dataset contains dimensions that logically form a hierarchy, such as Year-Quarter-Month or Country-
State-City, you can define the hierarchy in the application.

Hierarchies allow you to view data at different levels of granularity. In charts that contain hierarchies, you can
drill up and down through the different levels of data to gain a deeper understanding of the relationship
between the dimensions and measures. The following types of hierarchies are available:
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Table 19:

Hierarchy Example

date/time <Year>-<Month>-<Day>

geographic <Country>-<Region>-<City>
= Tip
You must create a geographic hierarchy from your location data before plotting it on a
geographic map. For example, to plot sales by city on a map, you must create a geo-
graphic hierarchy for the <city> dimension.

custom <Product Type> - <Product>

Related Information

Creating a time or date/time hierarchy [page 65]
Creating a custom hierarchy [page 67]
Creating a geographic hierarchy [page 68]

4.5.1 Creating a time or date/time hierarchy

Use dimensions containing date or datetime information to create a time hierarchy.

Prerequisites

Your dataset must contain a dimension with a valid date or datetime format, for example:

e 1997-07-16
e 2/19/20151:04:26 PM

Datetime data from SAP HANA is supported. Datetime data from other data sources, such as Excel, are not
currently supported.

= Tip

The EJ icon indicates dimensions with a valid date or datetime format that can be used to create a date/
time hierarchy.
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Context

With time hierarchies, you can view and analyze your data at different time levels:

e Drill up or down through data aggregated by year, month, quarter, day, and (for datetime data) hour,
minute, and second.

e Filter data based on date or time.

e Answer time-based questions, such as "What time of day are most orders placed?".

Procedure

Select the ﬁ icon next to a dimension or column that contains valid date or date/time data, and select
Create a date/time hierarchy.

Results

A time hierarchy is created and displayed in the Dimensions panel. Columns are created for each level in the
hierarchy, for example:

® Year

®  Quarter
e Month
e Day

e Hour

e Minute
e Second

Note that Hour, Minute, and Second are created only for datetime data.

Related Information

Creating a custom hierarchy [page 67]

Hierarchical data [page 127]

Creating a geographic hierarchy with location names [page 68]
Creating a geographic hierarchy using latitude and longitude [page 70]
Example: Visualizing orders by type and time of day [page 17]
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4.5.2 Creating a custom hierarchy

You can create a hierarchy using any combination of the available dimensions.

Context

Use a custom hierarchy to drill through and filter data using your own defined levels, such as Product Area -
Product Line - Product.

Procedure

1. Selectthe # icon next to the dimension or column to use as the base for the hierarchy.

2. Select Create a custom hierarchy.
The Create Hierarchy dialog appears. The dimensions available on the Measures and Dimensions panel are
listed in the left pane. You can enter a search string to find a dimension (for example, the first letters of a
dimension name).

3. Add dimensions to the hierarchy in the right pane.

= Tip

You can double-click a dimension to move it between the panes.

4. (Optional) Use the arrows beside the hierarchy list to move a selected dimension up or down in the
hierarchy.

5. Enter a name for the hierarchy, and select Create.
The new custom hierarchy appears on the Measures and Dimensions panel. New columns are created for
each level of the new hierarchy.

Related Information

Hierarchical data [page 127]

Creating a geographic hierarchy with location names [page 68]
Creating a geographic hierarchy using latitude and longitude [page 70]
Creating a time or date/time hierarchy [page 65]
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4.5.3 Creating a geographic hierarchy

You must create a geographic hierarchy to plot location data on a geographic chart.

The application contains a database of location information that includes countries, regions, sub-regions, and
cities, plus their latitude and longitude. The application uses this data to create geographic charts.

To create a geographic chart, you must first map your geographic data to the information contained in this
database by creating a geographic hierarchy.

= Tip

The location names in the application's database are available in many different languages, so you can use
location names in different languages to create a geographic hierarchy.

45.3.1 Creating a geographic hierarchy with location
names

Data in a geographic hierarchy can be mapped on a geographic chart. Geographic hierarchies based on
location names are easily understood by users.

Context

During data acquisition, the application looks for dimensions containing location names and marks them with

a @ icon. These dimensions are good candidates for creating a geographic hierarchy.

Procedure

1. Select the Options # icon next to a dimension or column, and select |» Create a geographic hierarchy ¥
By Names 3.

This option is available for string dimensions and columns.

2. Inthe Geographical Data dialog, choose which dimensions to map to the hierarchy:

= Tip

If a geographic level, for example Sub-Region, does not apply to your location, select None. Locations
can still be mapped on a geographic chart with some information missing.
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Table 20:
Show o Select All Dimensions to view all possible dimensions for each level in the geographic
hierarchy.
o Select Geo dimensions to view only the suggested dimensions.
Country Select the dimension to map to the Country level.
Region Select the dimension to map to the Region level, for example State or Province.
Sub-Region Select the dimension to map to the Sub-Region level.
City Select the dimension to map to the City level.

3. Select Confirm.

The Geographical Data dialog displays the mapping between the locations in your dataset and the
locations in the application's database:
o Locations mapped exactly are marked with green.
o Locations with more than one possible match (for example, if more than one city named London was
found) are marked with yellow.
o Locations not found in the geographic database are marked with red.

4. Select All in the Show list to display the mappings for all locations:

o Foritems marked with yellow, select the correct location from the list.

o Foritems marked with red, either edit the source data or ignore the error.
If a location was not found in the database, it will not be included in the geographic hierarchy.

o (Optional) For items marked with green, you can choose to remove them from the mapping.
5. Select Done.

Results

The geographic hierarchy is created and marked with a icon in the Dimensions panel.

Next Steps

To edit the mapping of a geographic hierarchy, select the Options # icon next to the hierarchy and select
Edit reconciliation.
Related Information

Creating a geographic hierarchy using latitude and longitude [page 70]
Creating a time or date/time hierarchy [page 65]
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Creating a custom hierarchy [page 67]
Creating a geographic hierarchy [page 68]

4.5.3.2 Creating a geographic hierarchy using latitude and
longitude

Data in a geographic hierarchy can be mapped on a geographic chart. Latitude and longitude allows mapping
of all possible locations, in addition to the cities, regions, and countries available in the geographic information
database.

Prerequisites

Latitude and longitude data must be numeric. If data is not numeric, you must convert column values using a
formula (for example, ToNumber () ).

Context

The application automatically calculates levels above and below a selected geographic dimension. You can
accept the calculated levels in your hierarchy or replace them with levels that you define based on your
latitude and longitude data.

Table 21: Properties for a calculated level in a hierarchy

Level property Description
Category Definition of the level, either automatically calculated based on the latitude/longitude data
or user-defined (you select the column to base a level on)
Column For a user-defined level, select the column to use for the level.
Latitude For a user-defined level, select the latitude data.
Longitude For a user-defined level, select the longitude data.
Level type Name of the level in the hierarchy
1 Note

The application does not support creating geographic hierarchies with latitude and longitude data from SAP
HANA data sources.
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Procedure

1. Ensure latitude and longitude dimensions are numeric.

Use the following steps to create a numeric dimension:

a. Select Options # next to the latitude or longitude dimension and select Create Calculated
Dimension.

The New Calculated Dimension dialog opens. The name of the dimension appears in the Formula
windows, for example {Latitude}.
b. Inthe Functions pane, select and double-click the formula ToNumber.

The formula ToNumber is added to the Formulas dialog.
c. Add the dimension name to the formula, for example ToNumber({Latitude}).
d. Enter aname for the calculated dimension in Dimension Name and select OK.
e. Repeat these steps for the longitude dimension.

2. If you want to create a geographical hierarchy based on the longitude and latitude for a dimension or
column, then perform the following:

a. Choose the Options # next to the latitude or longitude dimension
b. Navigate to |+ Create a geographic hierarchy ¥ By Latitude/Longitude 3
The Geographical Data dialog box appears.

c. Select the required latitude and longitude on which you want to define the hierarchy.
d. To select the geographical level, perform one of the following:

Option Action

For geographical hierarchy with one level Select any option except Other

For geographical hierarchy with two or more level 1. Select Other
2. Choose Next
The Generate parent levels dialog box appears.

3. Select the parent level hierarchy based on your re-
quirement

3. Choose Finish.

Results

The geographic hierarchy is created and marked with a icon in the Dimensions panel.

Related Information

Hierarchical data [page 127]
Creating a geographic hierarchy with location names [page 68]
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Creating a calculated measure or dimension [page 74]
Creating a custom hierarchy [page 67]
Creating a geographic hierarchy [page 68]

4.6 Creating measures

Measures enrich datasets. You can manually create them at any time directly from a column or dimension or
by using the formula language to create a calculated measure, or you can allow the application to detect them
automatically on numeric column data types when a dataset is acquired.

1 Note

When using a Connect to SAP HANA data source, it is not possible to create a measure with a numeric or
string dimension. Measures in Connect to SAP HANA data sources are detected directly from the SAP
HANA Analytic view. Measures must be created in the SAP HANA view, before being acquired automatically
in the application.

1 Note

When using a Connect to SAP HANA data source, it is not possible to change the aggregation type of a
measure.

Related Information
Creating a measure from a column or dimension [page 72]

Creating a calculated measure or dimension [page 74]

4.6.1 Creating a measure from a column or dimension

You can create a measure from almost any column or dimension.

Context

These exceptions apply:

e When the column data type is Numeric, any aggregate function can be used for the measure.
e When the column data type is Date or String, neither Sum nor Average can be used.
e Aggregation is performed when the measure is used in the Facets view. It is not available in the Grid view.
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Table 22: Aggregate functions

Function Description
Sum Returns the sum of a measure
Min Returns the smallest value in a set of values
Max Returns the largest value in a set of values
Count (Distinct) Returns the number of distinct values in a set of values
Count (All) Returns the number of values in a set of values
Average Returns the average value of a measure
None Allows a numeric dimension to be used as a measure, without aggregation. This type of
measure enables each value to be visualized in a graph, which is useful for certain types of
graphs.
For example, for a scatter plot that displays margin and quantity-sold values, this option
displays all points on the scatter plot and shows the spread of individual values that would
not be apparent using an aggregation function.
1 Note
The aggregation type None is not supported when using a Connect to SAP HANA data
source.
Procedure

1. Selectthe # icon on a column heading or next to the dimension to use as the basis for the measure, and
select Create a measure.
A measure is created in the Measures section of the Measures and Dimensions panel.

2. Selectthe # icon next to the new measure, select Change Aggregation, and select an aggregate
function.

Next Steps

Switch to the Facets view to see the measure applied to data in a dataset. Select the measure to see changes
to data values caused by aggregation.
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4.6.2 Creating a calculated measure or dimension

You can create calculated measures and dimensions using the SAP Lumira formula language.

Context

The following features are supported in the formula editor:

Combining any two columns in a dataset
Applying functions from a predefined set of numeric, date, and text functions

Using "if," "then," "else" clauses
Using automatic completion to improve editing speed
Using a calendar picker for date parameters

Copying text and syntax to a function definition

Procedure

Select the Options icon next to a measure or dimension and then select Create Calculated Measure or
Create Calculated Dimension.

2. Enter a name for the measure or dimension.

3. Double-click one or more measures or dimensions and functions to add them to the Formula syntax box.

4. Enter parameters for the function and associated information based on the function task.

You must enter the names of columns used in the formula. Automatic completion will suggest a column
name after you start entering the first letter.

If you are inputting calendar information, select the Select a Date button at the bottom of the functions list,
and use the date picker to select dates.

Select OK to apply the formula.
A measure or dimension is created.

Related Information

Lumira functions reference [page 205]

74

SAP Lumira, desktop edition User Guide
PUBLIC Prepare room—viewing, cleaning,manipulating, and sharing data



4.7 Sharing Datasets

Context

You can export a dataset to either a CSV format or Microsoft Excel format from SAP Lumira to your local
system. The following restrictions apply while exporting or publishing a dataset:

e Both visible and hidden objects will be exported
e Filters and sorting cannot be used
e Columns that are referenced more than once in a dataset are exported multiple times

Procedure

1. Start SAP Lumira.

2. Choose Prepare room.
3. Choose | File » Export As File 4.

The Export As File dialog box appears.
4. (Optional) Select an export option:

o To apply dataset filters to the exported data, select Export with filters.

o To export hidden dimensions in the dataset, select Export hidden dimensions.

o To export hidden dimensions resulting from enrichment of the dataset, select Export hidden
dimensions derived from the dataset enrichment
Two examples of these columns are the Latitude and Longitude columns generated for geography
hierarchies that are created by geographical names.

5. Choose Export.

6. Choose a convenient location to save the file and choose the file format to save the dataset.

4.8 Publishing a dataset to SAP HANA

When you publish a dataset to SAP HANA, only the dataset is published (not associated visualizations).

Prerequisites

Before you publish the time hierarchies to SAP HANA, the following prerequisites apply:

e The maximum calendar range must be 50 years.

e The SAP HANA calendar system table must be available, and the calendar must be Gregorian. SAP Lumira
uses time information from the SAP HANA server to match data to the SAP HANA Gregorian calendar.
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Procedure

1. Start SAP Lumira.

2. Choose Prepare Room.

3. Select the dataset that you want to publish.
4. Choose ||r File » Publish » SAP HANA

o1

The Publish to SAP HANA dialog box appears.

Enter your connection details.

6. Choose Connect.

The dialog box appears with the list of Available Views.

Select the required view.
Choose Publish.

Results

The dataset is published as a new analytic view.
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5 Working with multiple datasets

You can add a dataset to the available datasets, move between datasets, merge or append two datasets, and
use data from more than one dataset inside a visualization.

When combining datasets, two datasets are merged using a JOIN operator, and two matched datasets are
merged using a UNION operator. Appended datasets are compatible and have an equivalent number of
columns in the merged table.

Using multiple datasets within a visualization is called dataset linking.

Related Information

Adding a dataset [page 77]

Switching to another dataset [page 78]
Merging datasets (JOIN) [page 78]
Appending datasets (UNION) [page 79]
Removing a dataset [page 81]

Dataset linking [page 81]

5.1 Adding a dataset

You can open multiple datasets in the same document, and you can add a dataset to a document.

Procedure

1. Inthe datasets list at the top of the Data pane, select Add Dataset.

2. Inthe Add new dataset dialog, select a data source in the Select a Source or All Recently Used pane, and
select Next.

3. Enter connection information for the dataset, and select Create.

Results

Data from the dataset is acquired in the document.

SAP Lumira, desktop edition User Guide
Working with multiple datasets PUBLIC 77



5.2 Switching to another dataset

You can have multiple datasets open in a document at the same time and switch from one dataset to another,
which you would likely do when preparing a merge between two datasets or when using multiple datasets ina
visualization (dataset linking).

Procedure

In the datasets list at the top of the Data pane, select the dataset to switch to.

Results

The dataset you selected is now the active dataset.

5.3 Merging datasets (JOIN)

Use the JOIN operator to merge two datasets.

Prerequisites

® The merging dataset must have a key column.
e Only columns with the same data type can be merged.
® The merge process combines all columns.

Context

Columns in the second dataset are matched to a key column in the original dataset. The application proposes
potential column matches and the probability of each match.

Procedure

W
1. Select the Combine icon, and select Merge.
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2. Inthe Merge Data dialog, select the key column to use as the identifying column for matching.

3. Perform one of the following actions:

Option Description

If the dataset to merge is already available in the Select the dataset in the list above the right pane.

document

If the dataset to merge is not open Select Add New Dataset, and select the data source to
merge.

Columns that can be matched, based on the key column in the original dataset, are listed under LOOKUP
DATASET.

4. Selectacolumninthe LOOKUP DATASET list.
If the selected columns are compatible, the Merge button is enabled.

5. Select Merge.

Results

Columns in the second dataset are added to the original dataset.

1 Note

If you want to restore the original dataset, you can undo the merge operation, or remove the merged
dataset and reacquire the original dataset.

Related Information

Appending datasets (UNION) [page 79]

5.4 Appending datasets (UNION)

Use the UNION operator to append two datasets.

Prerequisites

Both tables in the union must contain an equivalent number of columns and compatible data types. Only a
dataset that is compatible with the target dataset can be appended.
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Procedure

W
1. Select the Combine icon, and select Append.

2. Inthe Append Data dialog, perform one of the following actions:

If the dataset to append is already available in the Select the dataset in the list above the right pane.
document

If the dataset to append is not open Select Add New Dataset, and select the data source to ac-
quire and append.

If the dataset to append is compatible with the original dataset, dimension columns are listed under
APPEND DATASET on the right side of the pane. A sample of distinct values for each selected dimension
appears in the Sample of Distinct Values column.

3. To select a different source dimension for the union with the matching target dimension, select another
dimension in the list.

If the selected dimension contains a compatible data type, the dimension can be appended. If a Union
cannot happen message appears, the selected dimension didn't contain a compatible data type and you
must select a compatible dimension.

4. Select Append.

Results

The two datasets are combined. The combined dataset retains the column names of the original dataset.

1 Note

If you want to restore the original dataset, you can undo the append operation, or remove the combined
dataset and reacquire the original dataset.

Related Information

Merging datasets (JOIN) [page 78]
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5.5 Removing a dataset

You can remove a dataset from a document.

Procedure

1. Expand the datasets list at the top of the Data pane.

2. Select the Remove Dataset o icon next to the dataset.

Results

The dataset and any visualizations based on it are deleted.

5.6 Dataset linking

If you have multiple datasets that contain related data, but you don't want to wait for your technical staff to

perform a time-consuming database merge, you can link the datasets while you're performing your analysis, i

a Lumira Desktop visualization.

A visualization with linked datasets contains one or more links between dimensions from separate datasets,
and measure values from those datasets. These datasets are not merged or joined prior to the visualization.
Instead, data is aggregated from each dataset separately, and then joined on one or more common linked
dimensions, to produce a result set that is visualized in a chart or table.

Dataset linking lets you enrich your own data, by adding columns that your IT organization may not provide.
For example, if you're tracking sales performance for several account managers, but you have them assigned

n

to virtual teams, or you have them weighted differently across different accounts, you can add this enrichment

to an offline spreadsheet of your own, and link that information with your visualizations or tables to properly
calculate the right sales numbers (performance and targets).

These terms are specific to dataset linking:
Primary dataset The dataset that is used when first creating a visualization.

Secondary dataset A dataset that is added to an existing visualization that is based on a primary
dataset. There is no limit to the number of secondary datasets you can add.

Primary (or A dimension from the primary (or secondary) dataset.
secondary) dimension
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Link A relationship between dimensions in different datasets. For example, a <Year>
dimension in Datasetl and a <Year> dimension in Dataset2 can be linked, so that a
visualization can display data from both datasets.

Active linked The set of dimensions that the datasets are linked on.
dimensions

With traditional database merging, if your data contains multiple instances of records, you have to decide
which level you want to roll up your data to, and then join the databases at that level. With dataset linking, the
data is automatically aggregated up to the level of the primary dimensions that you link.

When working with linked datasets, there are various visual indications:

e |nthe Visualize room, dimensions, measures, and filters from the primary dataset are identified by the

primary dataset icon E

e Thelinkiconis shown on the tokens for linked dimensions E
e When linking datasets, you can choose between these types of joins:

Join type Description

B [ eft Outer Join Returns all rows from the primary dataset, even if there are no matches
in the secondary dataset.

) inner Join Returns rows where there is a match in both datasets.
8 rui Outer Join Returns all rows from both datasets.
£ Exception Returns only the rows from the primary dataset that do not have a

match in the secondary dataset.

1 Note

e Some features are not available when working with linked datasets. For example, Related Visualizations
and influence analysis are not available if the current dataset doesn't match the dataset used in the
current visualization, or if the visualization uses linked datasets. Also, facet view is not available when a
visualization contains multiple datasets.

® You cannot link online data sources with offline data sources.

e Secondary datasets always link to the primary dataset; not to other secondary datasets.

e When you add a filter on a linked dimension, the list of values is the combination (union) of the lists of
values from all datasets used in the visualization.

e \When working with linked datasets, sometimes a measure from a secondary dataset may show
duplicated values. This is usually caused by insufficient linked dimensions. Lumira detects when the
duplicated measure values occur, and prompts you to update the linked dimensions.

e When linking datasets, a message may be displayed if the default java heap size is insufficient.
Depending on the size of your result set, you may need to increase the heap size value as follows:

1. Openthe sAPLumira.ini file, located at <LumiraInstallDir>\SAPLumira\Desktop.
2. Find the heap size setting: -xmx1024m (default value).
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3. Change the setting to a larger value; for example, -xmx2048m. The value must be no greater than
the amount of physical memory you have in your machine, in megabytes. For example, 2048 = 2
GB.

4. Save the file and restart Lumira Desktop.

Related Information

Creating a dataset from a visualization [page 141]

Adding or modifying a predefined chart [page 96]

Influence analysis [page 144]

5.6.1 Linking datasets in the Visualize room

Procedure

1

In the Visualize room, starting with a visualization that already contains dimensions or measures from one
dataset (the primary dataset), add a second dataset (the secondary dataset).

You can add a second dataset in two ways:

o From the menu, select|r Data » Add new dataset .

o From the dataset selector above the Chart Canvas, select the down-arrow and select Add Dataset.
In the Add new dataset dialog, choose a dataset and select Create.

The secondary dataset becomes active, and the Measures and Dimensions panel shows the objects in the
secondary dataset.

Add a dimension or measure from the secondary dataset to the visualization.
The Define Dataset Links dialog opens. Here, you define and manage links between dimensions in the two
datasets.

Inthe DATASETS IN USE area in the Chart Builder, the primary dataset is indicated by the “primary

dataset” icon E

You can also use the + button in the DATASETS IN USE area to start linking datasets, or to include
additional secondary datasets in the current visualization.

By default, the datasets are linked using a left outer join L 2T you want to change the join type, select the
joiniconinthe DATASETS IN USE area.

Results

When dimensions and measures from both datasets are added to the visualization, the primary dataset

icon appears in the tokens for the primary dimensions and measures E
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e \When alinked dimension is added to the visualization, a link icon appears in the dimension's token .

e \When you select a visualization with linked datasets in the Visualization Gallery, the visualization is
displayed in the Chart Canvas, the dataset selector displays the primary dataset used in the visualization,
and the Measures and Dimensions panel shows the objects in that primary dataset.

= Tip

Inthe DATASETS IN USE area, the Active Linked Dimensions area shows the set of linked dimensions for the
datasets. You can use the + button to add other linked dimensions from the primary dataset. You can also
remove a linked dimension from the active linked dimensions list, which automatically removes that
dimension from the visualization. However, removing a dimension from the visualization does not
automatically remove the dimension from the active linked dimensions.

= Tip

If any active linked dimensions aren't added to the visualization, a warning icon appears, to inform you that
nonmeaningful aggregations may be taking place. For example, consider this situation:

e Your chart shows population figures by country and city.
® Your datasets are linked on Country and city dimensions.

When you display both city and Country dimensions in your visualization, populations of Los Angeles and
New York appear as 4,000,000 and 9,000,000. But when you exclude the city dimension from your
visualization, the population values by country are calculated as averages by default. This results in an
aggregated figure of 6,500,000 for the USA, which may not be the aggregation you want. In such cases, you

can change the aggregation method for a measure: select the Settings ﬂ' icon beside a measure and then
select Calculate Total As.

5.6.2 Creating and managing dataset links

Context

Use the Define Dataset Links dialog to create and manage links between dimensions in your datasets.

Procedure

1. Inthe Visualize room, access the Define Dataset Links dialog in one of these ways:

o Fromthe menu, select | Data } Link Datasets J.
o From the dataset selector above the Chart Canvas, select the down-arrow and select Link Datasets.

o From the Measures and Dimensions panel, select the Options icon for a dimension and select
Link Datasets.
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2. From the dimension lists, select a dimension from one dataset.

Alink is initiated below the dimension lists.

Select the light-bulb icon ﬂto see which dimensions from the other dataset Lumira considers the best
linking candidates. Also, when you position the pointer over dimensions, sample values are displayed to
help you choose which dimensions to link.

3. Select adimension from the other dataset to complete the link.
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6 Visualize room—creating charts

These are the main areas where you interact with the Visualize room:

? ? ?
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Table 23: Legend: Areas in the Visualize room

Number Area
1 Measures and Dimensions
panel

Description

Use this panel to view, sort, select, and filter the data in a visualization. Data
is grouped into measures (for quantitative data) and dimensions (for catego-
rical data). Measures and dimensions can be dragged directly to the Chart
Canvas or to shelves in the Chart Builder.

The panel has two orientations:

e |nthe Vertical Orientation D layout, dimension hierarchies can be
viewed and expanded, and you can search for measures and dimensions

by name.

® |nthe Horizontal Orientation D layout, the data associated with each
dimension is displayed in a column above the Chart Canvas. You can
search for specific data values within a dimension, select multiple values
to include or exclude from a visualization, and view the measures asso-

ciated with a dimension.

SAP Lumira, desktop edition User Guide
Visualize room—creating charts

PUBLIC 87



Number Area Description

2 Chart Canvas Use this area to create, modify, and explore a visualization. Build a chart by
dragging measures and dimensions directly to the Chart Canvas or to
shelves in the Chart Builder.
Quickly adjust the content or appearance of a visualization with the toolbar
buttons in the upper-right corner of the Chart Canvas:

° EIN Fit Chart to Frame: For a bar, column, or line chart, activate this
setting to display all of the datapoints on the screen at once. Whenit is
deactivated, you can focus on a smaller set of members and use a scroll
bar to navigate the data.

o Reprompt: For data with SAP HANA variables or input parame-
ters, opens the prompt dialog, where you select new prompt values.

B " —

o Create new conditional formatting rule: For a bar chart, column
chart, or crosstab, select this icon to apply custom formatting to data
points that meet a condition that you define. To manage existing condi-
tional formatting rules, select the arrow next to the icon and select
Manage Rules.

° t} Sort: Organizes chart data by measure.

iz

° Add or edit a ranking by measure: Focuses a chart on a specified
number of the highest or lowest dimension members.

° 'ﬁ Clear Chart: Removes all dimensions and measures from a chart
and any filters applied to the chart, not including dataset filters.

—y
e | "~ | Refresh: Refreshes the chart data.
° # Settings: Sets the chart properties.
L¥

o | Y Maximize: Expands the Chart Canvas to full-screen mode.

o ml Undo: Reverses the last action. You can undo most actions, but
actions that change the underlying data, such as adding or updating the
data, clear the undo history.

° o Redo: Repeats the last action.
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Number Area

3 Visualization Tools

(The example shows the
Chart Builder.)

Description

To switch between a left or right layout for the Visualization Tools panel, se-

lect |} File > Preferences > Charts > Position of Chart Builder ]

Use the tools at the top of this panel to switch between the Chart Builder

o
-III tab and the Related Visualizations | _™® _ tab.

Use the Chart Builder tab to change the chart type and to customize a
chart.
Use the Related Visualizations tab to choose predefined charts that
were automatically generated from the measures and dimensions in the
current dataset.

o Add related visualizations to the current story and modify them.

o View all chart suggestions by selecting Show All.

o Remove measures or dimensions that were used to generate a vis-

ualization with the Filter related visualizations a\ icon. This re-

fines the list of related visualizations that are available to you.
Use the Related Visualizations tab to access influence analysis, which
suggests visualizations based on how dimensions contribute to a se-
lected measure.

4 Chart Picker

Use to select the type of chart to use for a visualization.

5 Shelves

Use to add measures and dimensions to a visualization. When you drag a
measure or dimension to a shelf, the Chart Canvas updates automatically.

6 Visualization Gallery

Use to create new visualizations and to select between visualizations in a
story.

Create a visualization by selecting the Create new visualization + icon.

Remove or copy a visualization by selecting the Settings # icon.
Change the order of visualizations in the Visualization Gallery by drag-
ging them to a different order.

Related Information

Creating charts [page 90]

Working with the Chart Builder [page 91]

Chart properties [page 93]
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6.1 Creating charts

You can create charts on the Chart Canvas or by using the Chart Builder. All charts included in a story are
accessible in the Visualization Gallery under the Chart Canvas.

6.1.1 Creating a chart directly on the Chart Canvas

You can quickly create a chart by dragging measures and dimensions to the Chart Canvas in the central area
of the Visualize room.

Context

A chart must have at least one measure. When you add a dimension to the chart, its values are calculated
based on the chart's measures.

Procedure

1. Inthe Visualize room, select the Chart Builder 1l icon.
2. Select a chart type from the lists in the Chart Builder.

Bar Chart is the default chart type, but you can change the chart type.
3. Select ameasure and drag it to an axis on the Chart Canvas.

Text in the chart body guides you to the correct axis for the measure. A check mark appears when you
drag the measure over an area where it can be dropped.

4. Select a dimension and drag it to the Chart Canvas.

Text in the chart body guides you to the correct axis for the dimension. A check mark appears when you
drag the dimension over an area where it can be dropped.

= Tip

When you add a measure or dimension to the chart, or remove one, Lumira queries the dataset even if
the resultant chart wil be incomplete. When working with large online datasets, you may be able to
improve performance by clearing the option Update data for incomplete charts in the Charts
preferences, and adding dimensions to the chart before adding measures (most charts are minimally
complete once they contain a measure).

5. Add additional measures and dimensions as required.
For example, if you selected Column Chart 2 Y-Axes, you must add a measure or dimension to the Y-Axis
on the left side of the Chart Canvas and to the Y-Axis on the right side of the Chart Canvas.
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6. Tofilter the data in the chart, select the Add filters Y. icon at the top of the Chart Canvas, and select a
dimension to filter on.

Results

The chart is available in the Visualization Gallery.

Next Steps

Each new chart that you create in the Visualize room is automatically saved in the current session and is
available in the Compose room, but it is not saved in the document. To access the chart the next time you open
the story, you must save the document.

Related Information

Filtering data in the Visualize room [page 117]
Saving a story [page 151]
Compose room—creating stories with visualizations [page 147]

6.1.2 Working with the Chart Builder

You can use the Chart Builder to change the chart type and to customize a chart.

The Chart Builder has different types of shelves (measures, dimensions, and trellis) for each chart type.
Measures and dimensions can be dragged or added to shelves.

Table 24: Measure shelves

Measure shelf

Description

Axis An X or Y axis of a bar and column chart, line chart, scatter chart, bubble chart, box plot,
radar chart, or waterfall chart. Multiple axis shelves may be available.

For example, when you select a Bar Chart With 2 X-Axes, the Top X Axis and Bottom X Axis
shelves appear.

Color The color used for each area in a heat map chart, or each word in a tag cloud.

Column Width The width of each column in a marimekko chart
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Measure shelf

Height

Description

The thickness of each section in a pie with depth chart

Measures

The measures that are displayed in a crosstab. You can move the Measures . token to
the Rows or Columns shelf to choose where the measures appear.

Primary Values

The primary values in a parallel coordinates chart

Size The size of sections in a pie chart, bubbles in a bubble chart, areas in a tree map, or the size
of words in a tag cloud

Value The primary value used in a funnel chart or the number displayed in a geographic chart or
numeric point chart

Word Weight The weighting of text in a tag cloud

Table 25: Dimension shelves

Dimension shelf Description

Animation Adds an animation to a scatter chart. When you select the play button below a chart, the
chart cycles through the values of the dimension added to this shelf.

Axis An axis of a bar and column chart, line chart, box plot, heat map, or waterfall chart. Multiple
axis shelves may be available. For example, if you select a Bar Chart, the Y Axis shelf ap-
pears.

Category A section of data in a funnel chart or parallel coordinates chart

Color The color of data points in a chart, including bar and column charts, line charts, pie charts,
scatter charts, geographic charts, box plot charts, and radar charts. To set a color palette
for the chart, select Choose Colors from the Settings # menu.

Geography A data point in a geographic chart

Radar Branches The quantitative variables represented on axes starting from the same point in a radar
chart

Shape The shape of each entry in a legend and of each data point for a scatter chart or radar chart

Tag The text displayed in a tag cloud

Time Dimension The horizontal axis of a Line Chart for Date/Time Series.
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Table 26: Crosstab shelves

Crosstab shelf Description

Columns The column axis of a crosstab. You can add dimensions to this shelf, and move the
Measures . token to this shelf to display measures on the columns.

Rows The row axis of a crosstab. You can add dimensions to this shelf, and move the Measures
. token to this shelf to display measures on the rows.

Table 27: Trellis shelves

A trellis chart is a set of small charts shown in a grid for comparison. Each small chart represents one itemina
section. For example, if you create a bar chart that compares revenue by region, and then add the <Country>
dimension to the trellis, multiple small charts appear. Each small chart displays the revenue by region for one
country.

Trellis shelf Description

Rows The rows in a trellis chart. For example, if you place the <year> dimension on the Rows
shelf, the trellis chart will contain a row for each year in the <year> dimension.

Columns The columns in a trellis chart. For example, if you place the <vyear> dimension on the
Columns shelf, the trellis chart will contain a column for each year in the <vear> dimension.

Related Information

Creating a chart with the Chart Builder [page 94]
Adding or modifying a predefined chart [page 96]

6.1.2.1 Chart properties

Setting the properties for a chart can enhance its usability. For example, adding labels and legends can
improve the visual analysis of data.

To set chart properties, select the Settings # icon above the Chart Canvas.
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Table 28: Chart properties

Property Description

Normal Stacking or 100% Stacking

Applies to charts where each data point is divided into segments, such as
stacked column charts and area charts.

Normal Stacking allows you to compare the absolute values of data points
and their segments.

With 100% Stacking, percentage values are displayed on the measures axis,
allowing you to compare the proportional value of each segment across dif-
ferent data points.

Horizontal or Vertical

Switches the orientation of the chart between horizontal and vertical.

Show Title

Adds a title to the chart. You can edit the title at any time.

Show Legend

Adds a legend that shows a different color for each measure in a chart. To
add dimensions to the legend in different colors, select Color in the Chart
Builder.

Choose Colors

Opens the Choose colors dialog, which allows you to choose the colors that
appear in the chart, as well as a template that sets the visual style of the
chart.

Show Data Labels

Displays measure values for each dimension in a chart.

Use Measures As a Dimension

Plots two or more measures as a dimension in a chart to show how data is
spread over multiple measures on a single axis.

You must add at least two measures to a chart before selecting this option.
The measures appear as a new dimension in the Chart Builder.

Set Axis Scale

Defines the limits for values displayed on the Y Axis, either as a range or auto-
matically to the highest measure value.

This option applies only to charts with measures on the Y Axis.

Show Gridlines

Displays gridlines on the chart.

6.1.2.2 Creating a chart with the Chart Builder

Use the Chart Builder when you need more control over chart creation. (You can use the Chart Canvas for

simpler charts.)

Procedure

1. Inthe Visualize room, select the Chart Builder £l icon.

94 PUBLIC
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2. Inthe Chart Builder, select the chart type to create.
Bar Chart is the default chart type, but you can change the chart type at any time.

3. Select an empty shelf in the Chart Builder, and select measures and dimensions in the list that appears.
Or, drag a measure or dimension to an empty shelf.

Each chart must have at least one measure. When you add a dimension to a chart, the dimension values
are calculated based on the chart's measures.

= Tip

When you add a measure or dimension to the chart, or remove one, Lumira queries the dataset even if
the resultant chart wil be incomplete. When working with large online datasets, you may be able to
improve performance by clearing the option Update data for incomplete charts in the Charts
preferences, and adding dimensions to the chart before adding measures (most charts are minimally
complete once they contain a measure).

4. Add additional measures and dimensions as required.
For example, if you selected Column Chart 2 Y-Axes, you must add a measure or dimension to the Y-Axis
on the left side of the Chart Canvas and to the Y-Axis that appears on the right side of the Chart Canvas.

5. Tofilter the data in the chart, select the Add filters Y. icon at the top of the Chart Canvas, and select the
dimension to filter on.

6. Select | File » Save 1 to save the visualization in the document.

Results

The chart is available in the Visualization Gallery and the Compose room.

Related Information

Filtering data in the Visualize room [page 117]

Saving a story [page 151]

Compose room—creating stories with visualizations [page 147]
Working with the Chart Builder [page 91]
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6.1.2.3 Adding or modifying a predefined chart

The Related Visualizations tab contains predefined chart suggestions that are based on the measures and
dimensions in a dataset.

Context

You can select any chart on the Related Visualizations tab to immediately start visualizing data and then
modify the chart for your information requirements.

Procedure

1. Inthe Visualize room, select the ¥ icon in the Visualization Gallery to add a new chart to the current
document.

This ensures that an existing chart is not replaced.

2. Select the Related Visualizations icon.

3. Inthelist of chart suggestions, select Show All to display all chart suggestions.

4. Select the chart to add.
The chart appears on the Chart Canvas and its measures and dimensions are loaded in the Chart Builder.

5. To add or modify dimensions and measures, select the Chart Builder al icon to switch back to the Chart
Builder:

© Toadd a measure or dimension to the chart, drag it to an empty shelf.

©o Toremove a measure or dimension, position the pointer over it and select the Remove {3 icon. Or,
drag a measure or dimension off a shelf.

6. Tofilter the data in the chart, select the Add filters Y. icon at the top of the Chart Canvas, and select a
dimension to filter on.

7. Select | File » Save Jto save the visualization in the document.

Results

The chart is available in the Visualization Gallery.
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Related Information

Filtering data in the Visualize room [page 117]

Saving a story [page 151]

Compose room—creating stories with visualizations [page 147]
Working with the Chart Builder [page 91]

6.1.2.4 Renaming a chart

The title displayed above a chart is generated automatically from the measures and dimensions added to the
chart.

Procedure

Select the Options # icon next to a chart title, select Rename, and enter a new title.

= Tip

You can double-click a chart title to quickly change it.

6.1.2.4.1 Restoring a chart's default title

After a chart's title has been changed, if necessary, you can restore the original title that was generated
automatically from the measures and dimensions in the chart.

Procedure

Select the Options # icon beside a chart title, and select Restore Default Title.

6.1.2.5 Modifying chart colors and appearance

In Lumira Desktop, you can create and customize the appearance of charts and perform the following:

e Fordimensions, you can create a custom palette from preferences or visualizations.
e For measures, you can create a custom palette from preferences or visualizations.
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You can create or edit palettes while in preferences and save them to palettes. While in visualizations however,
you can only modify the color palettes for the particular visualization you are in.

1 Note

e \When you create a chart, the color and template settings that you set in the Chart Style section of the

SAP Lumira Preferences dialog are applied by default. Select |+ File » Preferences j Charts 3 to access
these settings.

The Choose Colors option is not available for some chart types, such as crosstabs, numeric point
charts, and charts with two X or Y axes. Default palette colors are not applied to these charts. The
default template is applied to these charts, with the exception of the crosstab.

6.1.2.5.1 Color palettes for Dimensions

6.1.2.5.1.1 Creating a Dimension Color Palette from

Preferences

Context

This section describes how to create a custom dimension palette from preferences.

Procedure

To create a dimension custom palette from preference, launch the Lumira Desktop and choose ||» File
Preferences » Charts 3.

2. To create the dimension palette, select the Default Dimension Palette dropdown list.

3. Choose Create Dimension Palette.

98

The Create Dimension Palette dialog appears.

To choose the required custom color palette, perform the following:

Choose the :[’5 icon
Select the required color from the color picker.
Select the required color shade from the color picker.

a0 oo

Enter the name for the palette in the text box.
e. Choose Done.

If you want to set a color palette as default, select the required User Defined palettes or Standard palettes
from the Default dimension Palette dropdown list.
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Results
You have now created a color palette. The palette that you have created is listed under the Default Dimension

Palette dropdown list under User Defined Palettes.

6.1.2.5.1.2 Creating a Dimension Color Palette from
Visualizations

Prerequisites

Choose a chart type and add one or more dimensions and measures to the chart before customizing its
appearance.

1 Note

You can also use an existing visualization or chart for customizing its appearance.

Context

This section describes how to create a custom dimension palette from Visualizations.

Procedure

Launch Lumira desktop.
Open a document that you want to view.

Choose the required visualization.

A won o

Right click on the visualization and select Choose Colors...
1 Note

You can select the # (Settings icon) above the chart canvas and select Choose Colors...

5. Inthe Palette dropdown list, choose the Customize Dimension Palette option to customize your color
palette. Customize Dimension Palette appears.

6. Choose {’LJ

1 Note

If the boxes are already filled with colors, the {TL" icon is not displayed.
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7.

8.
9.

Select the required color from the color picker.
Select the required color shade from the color picker.

Select the Save As New Palette option.

1 Note

If you don’t choose the Save As New Palette option, the colors that you customized will only be
applicable for the particular visualization you are working in.

10. Enter the name for the palette.

11. Choose Done.

Results

You have now created a color palette. The palette that you created is listed under the Default Dimension
Palette dropdown list under User Defined Palettes.

6.1.2.5.1.3 Editing a Dimension Color Palette

Context

This section describes how to edit a dimension color palette from preferences.

Procedure

100

To edit a dimension color palette from preferences, launch the Lumira Desktop and select |} File »
Preferences  Charts ». 4

. To edit dimension color palette, choose the required color palette from the Default Dimension Palette

dropdown list.

Edit a color from the referenced palette by selecting the , .

The Create Dimension Palette dialog appears.

If you want to add more colors, perform the following:

a. Choose the :[rlj icon.
b. Select the required color from the color picker.
c. c. Select the required color shade from the color picker.

If you want to remove the existing color from the box, choose the color and choose Gl
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6. Choose Done.

Results

You have now edited a color palette.

6.1.2.5.1.4 Deleting a Dimension Color Palette

Context

This section describes how to delete dimension color palettes from preferences.

Procedure

1. To delete dimension custom palettes from preferences, launch the Lumira Desktop and choose ||» File »
Preferences » Charts 3.

2. Todelete dimension custom palette, select the required color palette from the Default Dimension Palette
dropdown list.

3. Choose the Q (delete) icon.

The Delete Custom Palette dialog appears.
4. Choose OK.

Results

You have now deleted a color palette.
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6.1.2.5.2 Color Palettes for Measures

6.1.2.5.2.1 Creating a Measure Color Palette from
Preferences

Context

This section describes how to create a custom measure palette from preferences.

Procedure

1. Tocreate a measure custom palette from preferences, launch the Lumira Desktop and select |+ File
Preferences @ Charts 3.
2. Tocreate the measure palette colors, select the Default Measure Palette dropdown list.

3. Choose Create Measure Palette.

The Create Measure Palette dialog appears.
4. To choose the required custom color palette, perform the following:

a. Inthe Number of Colors dropdown list, you can use between two and nine different colors in the
palette.

1 Note

The number of colors setting is reverted to five when you choose a new palette.

b. To create a single color gradient, choose the E[:: icon from the top or bottom box and select a color
from the color picker.

c. Tocreate adouble color gradient, choose the Eﬂ: icon from the top or bottom box and select a color
from the color picker.
d. Enter aname for the palette.
e. Choose Done.
5. If you want to set a color palette as default, select the required User Defined Palettes or Standard Palettes
from the Default Measure Palette dropdown list.

Results

You have now created a color palette. This is listed in the Default Measure Palette dropdown list, under User
Defined Palettes.
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6.1.2.5.2.2 Creating a Measure Color Palette from
Visualization

Prerequisites

You have chosen a chart type and added one or more dimensions and measures to the chart before
customizing its appearance.

1 Note

You can also use an existing visualization or chart to customize its appearance.

Context

This section describes how to create custom measure palette from Visualization.

Procedure

Launch Lumira desktop.
Open a document that you want to view.

Choose the required visualization.

N N

Right-click on the visualization and select Choose Colors....

The Choose Colors dialog appears.

1 Note

o You can select the ﬂ' (Settings icon) above the chart canvas and select Choose Colors...

o Some charts, such as heat maps, tree maps, tag clouds, geo maps, and geographic choropleth
charts, can display measure-based colors.

o For geographic choropleth charts, you can customize individual colors in each palette. Select one of
the color swatches at the top of the Choose colors dialog to change the color.

o For heat maps, tree maps, tag clouds, and geo map layers that use choropleth as the data point
type, several additional options are available.

5. Choose the required color palette from the Palette dropdown list.

6. Inthe Color Threshold area, under the Number of Colors dropdown list, you can use between two and nine
different colors in the palette.

The Number of Colors setting is reverted to five when you choose a new palette.

1 Note

This step is applicable to measure palettes created from visualization only.
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7. If you want to create a single color gradient, choose the :{’LJ icon from the top or bottom box and select a
color from a color picker in the Color Threshold area.

8. If you want to create a double color gradient, choose the # icon from the top or bottom box and select a
color from a color picker in the Color Threshold area.

9. Select the Apply Color Gradient check box. This automatically creates a new palette based on the selected
colors.

1 Note

1. Ifyou select the Apply Color Gradient button and increase or decrease the color count in the
Number of Colors dropdown list, then following changes occur:
o Threshold is regenerated.
o Colors are regenerated based on the first color
2. If you unselect the Apply Color Gradient button and increase the color count in the Number of
Colors dropdown list, then following changes occur:
o Threshold values for the additional steps remains same as the previous value.
o Colors for the additional steps remains same as the previous color.
3. If you unselect the Apply Color Gradient button and decrease the color count in the Number of
Colors dropdown list, then following changes occur:
o Thresholds are truncated.
o Colors are truncated.

10. In the Color Threshold area, you can type numeric values in the fields for each color in order to set the
color thresholds. Invalid entries are highlighted in red. You can also select Reverse to change the order of
the palette colors from light to dark, or vice versa.

11. Select the Save As User Defined Palette option.

1 Note
If you don't select the Save As User Defined Palette option, the colors that you have customized will only
be applicable for the particular visualization you are working in.
12. Enter the name for the palette.

13. To customize the style of the chart, select an option from the Template list.

The three template options available are Standard, Flashy and High contrast.
14. Choose OK.

You have now created a color palette. The palette that you created is listed in the Default Measure Palette
dropdown list dropdown under User Defined Palettes.
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6.1.2.5.2.3 Editing a Measure Color Palette

Context

This section describes how to edit measure color palettes from preferences.

Procedure

1. To edit measure color palettes from preferences, launch the Lumira Desktop and choose [|» File »
Preferences » Charts

2. Toedit measure color palettes, select the required color palette from the Default Measure Palette
dropdown list.

3. Edit acolor from the referenced palette by selecting the / (edit) icon.

The Create Measure Palette dialog appears.
4. To edit the palette colors, perform the following:

a. Inthe Number of Colors dropdown list, you can use between two and nine different colors in the
palette.

1 Note

The Number of Colors setting is reverted to five when you choose a new palette.

b. To edit a single color gradient, choose the icon from the top or bottom box and select a color from the
color picker.

c. Toeditadouble color gradient, choose the icon from the top or bottom box and select a color from the
color picker.

d. To switch from dual color gradient to single color gradient, choose :

5. Choose Done.

Results

You have now edited a color palette.

6.1.2.5.2.4 Deleting a Measure Color Palette

Context

This section describes how to delete a measure color palette from preferences.
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Procedure

1. Todelete a measure palette from preferences, launch the Lumira Desktop and select |+ File 3 Preferences

» Charts 3
2. Todelete measure palette, choose the required color palette from the Default Measure Palette drop down
list.

3. Choose the o (delete) icon.

The Delete Custom Palette dialog appears.
4. OK.

Results

You have now deleted a measure color palette.

6.1.2.6 Plotting measures as a dimension in a chart

Plotting measures as a dimension in a chart can show how data is spread over multiple measures on a single
axis.

Context

You can include two or more measures as a dimension in a chart. Each measure is plotted as a dimension
value on an axis or in a separate chart. (For trellis charts, measures always appear in a separate chart.) The
chart automatically updates to show the new measure dimension.

Procedure

1. Inthe Visualize room, drag a measure to the Measures and Dimensions panel on the Chart Canvas.

2. Drag a second measure directly under the first measure, and drag each additional required measure under
the previous measure.

3. Select the Settings ﬁ icon on the Chart Canvas menu bar, and select Use Measures as a Dimension.
For example, if the Revenue_Margin measure dimension is on an X Axis box and the Product_Line
dimension is in the Color box, each measure is plotted on the X Axis with Product_Line values shown in
distinguishing colors.

Measures appear as a new measure dimension on the Measures and Dimensions panel.
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4. Todisplay each measure in a separate chart, drag the combined measure to the Columns or Rows box on
the Trellis panel.
The chart displayed is split by each measure name.

6.1.2.7 Splitting measures by color

When working with combined column line charts with multiple measures, you can choose which measures are
split by the color dimensions.

For example, you may be analyzing the number of issues reported for retail goods each year, as well as the
customer satisfaction rating, on a combined column line chart with 2 Y-axes. You add product line to the Color
shelf to see which lines are responsible for the most issues, but you still want to see the overall customer
satisfaction for all product lines combined.

You can choose which measures to split on the following chart types:

e Combined Column Line
e Combined Stacked Line
e Combined Column Line Chart with 2 Y-Axes
e Combined Stacked Line Chart with 2 Y-Axes

Each measure is split by the color dimensions by default. To stop splitting a measure, select the Settings ﬂ'
icon for the measure in the Chart Builder, and deselect Split by color dimension(s). The measure is now shown
as a single line or a single set of columns. In the previous example, you can deselect this setting for the
customer satisfaction measure.

1 Note
The Split by color dimension(s) setting is available when the following conditions apply to a visualization:

e No rankings, running calculations, or predictive calculations are applied.

e Two or more measures from the primary dataset have been added. The setting is not available for
measures from a secondary dataset.

® The X Axis shelf has at least one dimension from the primary dataset.

e The Color shelf has at least one dimension from the primary dataset that is not present on the X Axis
shelf.

e For datasets linked by an inner join or exception, the linked dimension cannot be added to the Color
shelf.

If the visualization no longer meets all of these conditions, all measures are split by the color dimensions by
default.
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6.1.2.8 Custom charts

You can add custom charts to the chart selection bar by installing visualization extensions.

Visualization extensions let you use chart types that aren't included with the application. For information about
the sample charts provided with the application or how to create extensions, see the Visualization Extension
Plugin for SAP Web IDE Guide.

Related Information

Visualization extensions [page 190]

6.2 Chart types

Some types of data are especially suited to a particular chart type.

Table 29: Charts for different types of analysis

Type of analysis Description Charts available
Comparison Compares differences between values or shows a simple e Bar Chart
comparison of categorical divisions of measures. e Column Chart

For example, use a bar chart to compare the differencesin | ® Column Chart with 2'Y-Axes

sales revenue between countries. e 3D Column Chart
e Marimekko Chart
e Radar Chart

® AreaChart

e TagCloud
e Heat Map
e Crosstab
Percentage Shows the percentage of parts in a whole or values as ra- e Pje Chart
tios to a whole. The legend shows the percentage and the e Donut Chart
total values. *  Pie with Depth Chart
For example, use a pie chart to see who had the highest e Stacked Column Chart
sales as part of a total sales value directly: e Tree

Total sales = $200, Paul had 10% ($20), David had 65% | ® FunnelChart

($130), and Susan had 25% ($50)
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Type of analysis Description Charts available
Correlation Shows the relationship between values or compares mul- Scatter Plot
tiple measure values. Scatter Matrix Chart
For example, you can view the correlation of two meas- Bubble Chart
ures and understand the impact of the first measure on Network Chart
the second measure. Numeric Point
Tree
Trend Shows a trend in the data values (especially for dimen- Line Chart
sions that are time-based, such as Year) or the progres- Line Chart for Date/Time
sion of your data and possible patterns. Series
For example, you can use a line chart to view sales reve- Line Chart with 2 Y-Axes
nue trends of a product throughout a range of years. Combined Column Line
Chart
Combined Column Line
Chart with 2 Y-Axes
Scatter Plot for Date/Time
Series
Bubble Chart for Date/Time
Series
Waterfall Chart
Box Plot
Parallel Coordinates Chart
Geographic Shows a map of the country object used in the analysis Geo Bubble Chart
and can optionally show data for dimensions (sorted by Geo Choropleth Chart
the country on the map) or the geographical spread of Geo Pie Chart
data for a country. The dataset you use must contain geo- Geo Map
graphical data. Before creating a geographic chart, you
must have an Esri ArcGis Online account.

6.2.1 Combining Dimensions in a Date/Time Series Chart

You can add two or more date dimensions to a Date/Time Series chart.

Prerequisites

You have a dataset with two or more date columns.
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Context

Each date dimension in a continuous axis can now have a separate chart in the Time Series chart. You can plot
a chart by combining a date dimension from one column with two or more other date columns of the dataset.
In this release, the Date/Time series chart supports three chart types, such as Line Chart for Date/Time
Series, Scatter Plot for Date/Time Series, and Bubble Chart for Date/Time Series.

You can analyze the status of a project for example by plotting the following information:

® Running sum of tasks versus the scheduled completion date
® Running sum of tasks versus the actual completion date

The Time Series chart would then show whether a project was ahead of or behind schedule, and when the
largest deviations from the schedule occurred.

In this release, you can find the following enhancements in SAP Lumira desktop edition:

e |nthe Scatter Plot for Date/Time Series and Bubble Chart for Date/Time Series chart types, you can use
different shapes depending on your requirements using the Shape shelf. Different shapes for each entry
are highlighted in the legend with different colors. The legend shows the shapes of each entry selected in a
visualization for every date dimension.

® |nthe Line Chart for Date/Time Series, you can zoom to a specific data point. Drag your mouse on the
chart area, choose Zoom in the dialog box and select the range for a selected dataset.

e |nthe Line Chart for Date/Time Series, you can define reference line to show the most important values on
the visualization chart. For more information, see Adding a reference line [page 126]Adding a reference
line.

Procedure

1. Create anew chart for Date/Time Series chart.
2. Add one or more measures to the Y axis shelf.

3. Add a date dimension to the Time dimension shelf.

4. Select the # icon next to the dimension you added in the previous step, and choose Combine
Dimensions.

The Combine Dimensions dialog box appears. You can only combine columns of the same type.
5. Inthe Combine Dimensions dialog box, select the dimensions(s) you want to add to the chart, then choose
Apply.

Results

The date dimensions are combined and added to the Date/Time Series chart. The Color shelf is automatically
updated to show each combination of measure and dimension. The legend depicts the different date columns
that are used in a visualization with different colors.

You can use these additional features with this chart type:
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e |ink datasets to expand your analysis. For example, you can add team information by task from a
secondary dataset, and use input controls to see how well each team followed the schedule. Note that the
date dimension must come from the primary dataset.

Y.

e Use filters to focus on specific areas of the visualization. Use the icon, or select an area of the chart

and use the resulting context menu.

1 Note

In this release, you can combine two different date column for the datasets having Date type as the
dimension. Combination of date columns for data types such as DateTime and Date hierarchy are not
supported.

6.2.2 Analyzing data in crosstabs

Crosstabs show data points only as values, rather than providing a visual representation of those values. As a
result, they are useful when your analysis depends on viewing exact values, or examining data from multiple
measures with different scales or units of measurement.

In addition to regular sorting and ranking functionality, you can also use conditional formatting in crosstabs to
help identify noteworthy data points, and add totals on the rows or columns.

Crosstab shelves

With a crosstab, you can add one or more measures to the Measures shelf, and switch the display of the

measures between the columns and rows by moving the Measures é? token. Dimensions can be added to the
rows, columns, or both, allowing complex multidimensional analysis.

For example, a crosstab could be an effective way of examining the sales revenue for a list of products. You
could create a crosstab with the Revenue measure and Year dimension on the columns and the Product
dimension on the rows, making it easier to spot relationships between the two dimensions. You might also add
a Product Category dimension to the outside of the row axis and choose to display the Sum total for the
Product dimension, which would display the sum of sales revenue for the products in each category.

1 Note

You can sort a crosstab by a measure, however, the sort is removed if a dimension is added to the same
axis as the measures.

Right-click menu options

Right-click a crosstab cell in the Visualize room for these options:

SAP Lumira, desktop edition User Guide
Visualize room—creating charts PUBLIC 111



|
Cell type Right-click menu options

Dimension name e (Create a conditional formatting rule based on the dimension, or manage
conditional formatting rules.

e Add a total for the dimension, or manage totals.

e Set cell sizes and label sizes for the entire crosstab.

Dimension member name ® filter or Exclude the member.

e Create a conditional formatting rule based on the dimension, or manage
conditional formatting rules.
By default, the conditional formatting rule will apply to members greater than
the one that you right-clicked. If you selected multiple members, it will apply to
the list of selected members.

e Add atotal for the dimension, or manage totals.

e Set cell sizes and label sizes for the entire crosstab.

e Manage conditional formatting rules.
Measures . token o Manage totals.
e Setcell sizes and label sizes for the entire crosstab.
Measure name e Sort the data by the measure (not available if a dimension is added to the same
axis).
You can also sort data by measure by selecting the sort icon next to a measure
name.
e Create a conditional formatting rule based on the measure, or manage
conditional formatting rules.
e Add atotal for the measure, or manage totals.
e Set cell sizes and label sizes for the entire crosstab.
Measure value e (Create a conditional formatting rule based on the measure, or manage

conditional formatting rules.
e Manage totals.

e Set cell sizes and label sizes for the entire crosstab.

You can also filter and exclude dimension members after selecting them.

Adding totals in a crosstab

To get a summary of your data, you can choose to add totals for dimensions on the rows or columns of the
crosstab. Totals show an aggregation, such as a sum or an average, of the values of each measure.

Right-click a dimension in the crosstab, or select the Settings icon for a dimension in the Columns or Rows
shelf. Choose Totals to select a total that you want to display.

If you want to configure multiple totals, select |+ Totals » More 3. In the Totals dialog, you can choose a
dimension, select the totals that you want to display for that dimension, and drag the totals to reorder where
they will appear in the crosstab.
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To ensure that grand totals are always visible, select Anchored Totals. The crosstab will always show grand
totals while you scroll through the data. Anchored totals do not apply in exported PDFs.

Totals can be set in the Visualize room, in the Compose room, or while viewing a story.

Resizing crosstab cells

® Resizing individual columns:
Select and drag the border at the right side of the column. You can resize dimensions in the rows or
dimension members in the columns.
® Resizing individual rows:
Select and drag the lower border of the row. Increasing the row height allows text wrapping for the names
of dimensions, measures, and dimension members. Measure values remain on the same line, however.
e Managing cell and label sizes for the entire crosstab:
Right-click any cell in the crosstab and select Set Size Properties to set the column and row size for the
entire crosstab, as well as sizes for the column labels and row headers. Select Preview changes to show
the new cell sizes as you change them. If you select Reset defaults, all cells will be reverted to the default
size for a new crosstab.

You can resize crosstab cells and labels when working with stories in the Compose room, and when viewing
stories.

Migration of tables from previous versions of SAP Lumira

Documents created in SAP Lumira 1.25 and earlier versions may contain tables. When you open these
documents in the current version of the software, the tables are converted to crosstabs.

The following relationships between shelves are used to migrate tables to crosstabs:

Table Crosstab

Primary Values shelf Measures shelf

(The Measures . token is added to the Columns shelf in the crosstab by default.)

Rows Axis shelf Rows shelf

Rows Subtotals shelf The total is enabled for the appropriate dimension in the Totals dialog.

In addition, the crosstab shows all conditional formatting rules that were applied in the table.

Related Information

Working with crosstabs in stories [page 171]

SAP Lumira, desktop edition User Guide
Visualize room—creating charts PUBLIC 113



6.2.3 Analyzing data in Geo Maps

Prerequisites

e Your document contains a dataset with a geographical dimension.

® You have to enter the server details and select the connection type in the Geo Map Service section of the
SAP Lumira Preferences dialog. For more information see,Configuring Geo Maps in Preferences [page
198]

Procedure

1. Inthe Visualize room, add a new visualization and select Geo Map from the Geographic Charts list.

2. Forthe first layer, select the type of data point:

o Choropleth: Geographic regions are shaded with a color that represents their measure value. You can
customize the measure-based color palette by selecting Choose Colors from the layer Options list.

© Bubble: Bubbles are overlaid on each region, with different sizes and colors based on the measure and
dimension that you add. Select Cluster adjacent bubbles to group bubbles together for regions that
are close to each other.

o Marker: A marker is added to each geographic region in the dimension that you add. Adjacent data
points can be grouped together by selecting Cluster adjacent markers.

o Pie: A pie chart is overlaid on each region, sized according to the measure that you add and divided by
the dimension that you add to the Color shelf. You can display donut charts instead of pie charts by
selecting Show as donut.

3. Select the + icon next to the Geo Dimension shelf and choose a geographical dimension for the layer.
4. If necessary, add a measure or dimension to other shelves for the layer.
5. Toadd another layer, select Add Layer and repeat steps 3 to 5 for the layer.

There are several options for managing multiple layers in a geo map:

o Select the checkbox next to a layer to toggle the layer visibility.
o Select the Options icon for a layer to change the layer order, or to delete the layer.

1 Note

To customize the Esri map based on your requirements, choose the Import Esri Custom Service in the
Visualize room. This provides you with the option of customizing the Geo Map with feature services
that are added to your Esri ArcGIS account.

The feature services supported in Esri server connections are also supported in Esri On Premise server
connections.
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6.3 Data sorting in charts

You can sort measures and dimensions in charts in ascending or descending order.

6.3.1 Sorting by measure

Prerequisites

Before you can sort by measure, if chart data is filtered by rank, the rank must be removed.

Procedure

1. Select a measure on the Chart Builder.
2. Select the Settings ﬁ icon, and select Sort Ascending or Sort Descending.
= Tip

N

Select the Sort icon on the Chart Canvas toolbar to quickly change the sort order.

Results

The chart data is sorted.

6.3.2 Sorting dimensions

When the Measures and Dimensions panel is displayed in a horizontal orientation, you can sort dimensions
that are visible in the panel. Sorting dimensions does not affect the data displayed in a visualization.

Procedure

1. Select the Horizontal Orientation icon on the Measures and Dimensions panel.
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2. Select the dimension to sort, and select the Options # icon.

3. Choose asort order:

© For anumeric dimension, select Sort Lowest to Highest or Sort Highest to Lowest.
o For an alphanumeric dimension, select Sort A to Z or Sort Z to A.
o For adate or time dimension, select Show Earliest to Latest or Show Latest to Earliest.

Results

The data in the dimension column is sorted.

6.3.3 Sorting dimensions by occurrence on the Measures
and Dimensions panel

You can sort dimensions visible in the Measures and Dimensions panel by the number of times each dimension
value occurs in a dataset.

Context

Sorting dimensions does not affect the data displayed in a visualization.

Procedure

1. Select the Horizontal Orientation icon on the Measures and Dimensions panel.
2. Display the number of occurrences:

a. Position the pointer over the dimension to filter.

b. Select the Options ﬁ icon, and select Show Measure and Occurrences.
The number of occurrences appears beside each dimension value in the column.
3. Sort by occurrence:

a. Position the pointer over the dimension that you selected in step 2.
b. Select the Options # icon, and select Sort by Measure Lowest to Highest or Sort by Measure Highest

to Lowest.
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Results

Data in the dimension column is sorted by occurrence.

6.4 Filtering data in the Visualize room

In the Visualize room, you can create filters that affect all visualizations based on the current dataset, or just
filter data for the current visualization.

You can filter data in the Visualize room in the following ways:

e By selecting the Add filters Y. icon

e By selecting the Options # icon for a dimension on the Measures and Dimensions panel and selecting
Filter

e By selecting data points in a chart to filter or exclude them
e By selecting the data to display on the Measures and Dimensions panel

As well, you can use the ranking by measure feature to filter data by measure.

Related Information

Filtering data by rank [page 121]

6.4.1 Using the filter dialog in the Visualize room

Context

You use the filter dialog in the Visualize room to define a filter on the current visualization only, or on the
dataset and all of the visualizations based on it.

Tokens representing active filters are displayed above the Chart Canvas, including dataset filters and
visualization filters. Dataset filters appear to the left, and have a darker background.
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Procedure

+

1. To open the filter dialog in the Visualize room, select the Add filters icon above the Chart Canvas and

choose a dimension to filter, or select the Options icon for a dimension in the Measures and
Dimensions panel and select Filter.

If a dimension includes a dimension hierarchy i icon, select + to expand the list to show all dimensions
included in the hierarchy.
You can also select the token for an existing filter to edit it in the filter dialog.

2. Onthe filter dialog, choose an operator from the list.

3. Specify the values to filter:

Operator Description

Between Type a beginning value and an end value.

Equal to, Not Equal to, Type a value.
Greater than, Greater than
orequal to, Less than, or
Less than or equal to

Contains Type a string that is contained in all of the values that you want to include. For
example, filtering a dimension of clothing product categories for shirt would return
values such as T-shirts, long-sleeve shirts, shirt dresses, and so on.

Like or Not Like Type a pattern that matches all of the values that you want to filter or exclude. You can
use the following wildcard characters in the pattern:
© The _ character matches any single character. For example, filtering a dimension
of US state abbreviations for A_ would return the values AL, AK, AR, and AZ.
o The % character matches any number of characters. For example, filtering a
dimension of US state names for A%a would return Alabama, Alaska, and Arizona.

In List or Not In List Select values from the list in the filter dialog.

o Youcan hold|sHIFT|while clicking values to select a range of values.

o With alphanumeric dimensions or numeric integer dimensions, you can select the
box of filter values to show the values as comma separated text. You can then
type values, or paste a CSV list. If your values include commas, surround each
value with quotation marks. For example, "New York, NY", "Los
Angeles, CA", "Chicago, IL"

If you enter a value that does not exist in the dataset or visualization, it is saved
with the filter. This way, you can filter values that are added to the data after the
filter is created.
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Operator Description

o

including displaying the number of times that each record occurs in the dataset,
and sorting the data by value or by number of occurrences.

o You can also select the Options icon to change the filter dialog settings,

o When filtering an integer or alphanumeric dimension, you can select the Find C}\
icon to search for a member by name.

By selecting |I* Options * Enable wildcard search 3, you can search alphanumeric
dimensions using the _and % wildcards.

4. Choose Apply to Current Visualization to apply the filter only to the chart that you are working with, or
choose Apply to Entire Dataset to apply the filter to all visualizations that are based on the dataset.

5. Select Apply.

Results

The data is filtered and a token representing the filter is added above the Chart Canvas.

Next Steps

You can edit the filter by selecting the token in the Prepare room or Visualize room, or remove it by selecting

the Delete '53 icon.

Related Information

Exploring a visualization in a story [page 154]

6.4.2 Filtering or excluding data points in a chart

You can exclude non-relevant data points or filter data points to focus a chart on a specific set of data.

Procedure

1. Onthe Chart Canvas, select the data points to exclude or filter.
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= Tip

You can drag a box around a group of data points to select the group.

2. Inthe tooltip that appears, select Filter or Exclude.

Results

The data in the chart is filtered and a token representing the filter is added above the Chart Canvas.

Next Steps

You can edit the filter by selecting the token in the Prepare room or Visualize room, or remove it by selecting

the Delete *3 icon.

Related Information

Exploring a visualization in a story [page 154]

6.4.3 Filtering data with the Measures and Dimensions panel

Procedure
1. Select the Horizontal Orientation icon to display the Measures and Dimensions panel in a horizontal
layout.

2. Onthe Measures and Dimensions panel, select one or more data points in the dimension to filter.

3. Select the Options # icon.

4. Depending on the kind of filter to apply, select one of the following options:

Optin __Jowseptn |

Clear Selections | Clears all values selected in the dimension

Include Includes selected values in the chart. A filter token with the selected values appears on the filter bar.
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Description

Exclude Excludes selected values from the chart. A filter token with the selected values in a strike-through
font appears on the filter bar.

Results

The data in the chart is filtered and a token representing the filter is added above the Chart Canvas.

Next Steps

You can edit the filter by selecting the token in the Prepare room or Visualize room, or remove it by selecting

the Delete '53 icon.

6.4.4 Filtering data by rank

Filtering data by rank focuses a visualization on a specified number of data points with the highest or lowest
values.

Procedure

123
On the Chart Canvas toolbar, select the Add or edit a ranking by measure icon.

In the Ranking dialog, select the measure to rank.

Select Top or Bottom as the focus of the ranking.

A w oo

Choose the number of results to display.
The default number is three.
5. Select (ALL) to rank data based on all dimensions, or select the dimension to rank data on.

For example, if a chart shows Sales Revenue by Country and Product Line, ranking the top five data points
by Country shows data for each product line in the five countries with the highest sales revenue.

6. Select OK.
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Results

The data is filtered by rank and a token representing the filter is added above the Chart Canvas. Only one
ranking can be applied to a visualization at a time.

Next Steps

You can edit the ranking by selecting the token in the Prepare room or Visualize room, or remove it by selecting
the Delete & icon.

With visualizations that contain linked datasets, the ranking is applied to the result set of the linked datasets,
not the datasets prior to the link operation.

6.5 Conditional formatting

Conditional formatting can highlight important data points in a chart by distinguishing values that meet a
condition (such as being greater than a certain number or within a specific range).

You can define multiple conditional formatting rules on one or more measures or dimensions in the following
chart types:

e all types of bar and column charts, except 3D column charts

® piechart

e donutchart

e scatter chart

e bubble chart

® crosstab

For the following charts, you can define conditional formatting rules on dimensions that are added to the Color
shelf, or to the Rows or Columns shelves in the Trellis section:

e all types of line charts, except area charts

You can also apply conditional formatting rules to measures displayed as lines in all types of line charts. The
only operator available for these rules is the is any value operator.

These rules are preserved when you switch between chart types, and will be applied to any valid chart type.
The Rules Manager dialog allows you to work with the rules that you have created for a chart.
Crosstabs support custom formatting for the text and background color of cells. For other charts, you can
change the color of bars, columns, line, and pie slices, but text formatting does not apply.

Example

In a bar chart with a measure that shows inventory shrinkage at your company's retail outlets, you could
use conditional formatting to identify stores with high rates of shrinkage. A conditional formatting rule could
change the bar color to red for each store with shrinkage higher than an amount you specify.
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Multiple conditional formatting rules

e When you create multiple conditional formatting rules based on the same measure or dimension, data
points may meet the condition for multiple rules. When this happens, the formatting for each rule that
applies to a data point (that is, active rules) is considered a set. Formatting for each set will be applied or
ignored, depending on the rule priorities.

e [oreach data point, the formatting set for the highest-priority active rule is applied first. Formatting for
lower priority rules can also be applied. However, if two formatting sets for active rules modify the same
attribute, none of the formatting defined for the lower priority rule is applied to the data point.

e Foreach data point, bold and italic formatting can be applied only by the highest priority active rule.

Example

A crosstab cell meets the conditions for three conditional formatting rules. The highest-priority active rule
sets the font to Times New Roman. The rule with the second highest priority sets the background color to

red. A final rule would set the background color to black and the font color to white, but that rule is ignored
because it conflicts with the second rule.

6.5.1 Creating a conditional formatting rule
Prerequisites

Before you can define a conditional formatting rule, the chart must have a measure added to it.

Procedure

1. Select the Create new conditional formatting rule L4 icon.

For crosstabs, you can also right-click a cell, a measure, a member, or a selection of members, and choose
|» Conditional Formatting # New Rule 3to create a rule based on it.

2. Inthe Rule Editor dialog, enter a name for the rule.
The name allows you to identify the rule in the Rules Manager dialog, and also appears in the legend of the

chart, if applicable. If you do not enter a name, the rule will be named automatically, based on the
condition that you set.

3. Inthe Based On list, select a measure or dimension.
This measure determines the values that are used in the rule and the data points where formatting
appears. You can set multiple conditional formatting rules on a single measure or dimension.

4. Select an operator, and enter one or more values for the condition.

In all types of line charts, conditional formatting rules based on measures displayed as lines can only use
the is any value operator.
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For conditional formatting based on dimensions, choose in list or not in list to select values from a list of
dimension members. In this list, you can also sort members, search for members using wildcard
characters, and paste CSV lists of member names.

5. Select Format, choose the appearance of data points that meet the condition, and select OK.

Crosstabs can display the background color as well as the text style that you set. For other chart types,
only the background color can be applied.

6. Inthe Rule Editor dialog, select OK.

Results

The conditional formatting rule is applied to the chart. By default, new conditional formatting rules have higher
priority than older rules.

Next Steps

If needed, you can use the Rules Manager dialog to change the priority of rules.

6.5.2 Managing conditional formatting rules

Use the Rules Manager dialog to edit, add or remove, turn on or off, and set the priority order of conditional
formatting rules.

Prerequisites

Before you can manage conditional formatting rules, a chart must have a measure added to it.

Procedure

1. Select the arrow beside the Create new conditional formatting rule B‘;E icon, and select Manage Rules.

2. Inthe Rules Manager dialog, perform any of these actions:

Description

To create arule Select the ¥+ icon.
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I —
Option Description

To delete a rule Select the - icon.
To modify a rule Select a rule and select Edit Rule.
To disable a rule Clear the check box in the Applied column next to the rule name. Disabled rules are

not applied to the chart, but you can turn them on again if necessary.

To change the priority of a rule | Select a rule and use the Change Rule Order icons to move it higher or lower in the
list.

3. Select OK.

6.6 Reference lines

On some chart types, you can define reference lines to show important dates or values on your chart. For
example, you can add reference lines that represent the dates of key project milestones.

You can add reference lines to these types of charts:

® Line Chart

e Line Chart for Date/Time Series

e Area Chart (100% Stacking not supported)

e Combined Column Line Chart

e Combined Stacked Line Chart

® Line Chart with 2 Y-Axes

e Combined Column Line Chart with 2 Y-Axes

e Combined Stacked Line Chart with 2 Y-Axes

e Bar Chart

e Column Chart

e Stacked Bar Chart (100% Stacking not supported)
e Stacked Column Chart (100% Stacking not supported)
e Bar Chart with 2 X-Axes

e Column Chart with 2 Y-Axes

e Scatter Plot

e Bubble Chart

Lumira provides two types of reference lines: Fixed Value, and Dynamic Value. Fixed-value reference lines are
created with a specific reference value, and don't change when you change the data in your chart; for example
if you filter your data. Dynamic-value reference lines are updated when filters, ranking, and sorting are applied
to the chart.

Reference lines aren't visible on unsupported chart types, but once created, they will appear if you switch to
one of the supported chart types listed above.

When you place the pointer over a reference line, a tooltip shows you the corresponding value and label.
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6.6.1 Adding a reference line

Procedure

1. Inthe Visualize room, or while exploring a visualization in the Compose room, right-click an empty area in
the visualization, and select Add Reference Line.
>
You can also select the toolbar button S
2. Choose whether you want to create a reference line at a fixed value or a dynamic value.
For example, if your visualization is showing parts costs, you could choose the fixed value 500, or you
could select the dynamic value Average by choosing the Cost measure and the Average aggregation.
3. Ifyou chose a fixed value, follow these steps:
a. Select an axis to add the reference line to.
b. Enter areference value.
For a date/time axis, you can choose a date value for each reference date, or you can specify that you
want the line to always appear at the current date (Today) on the axis. For other axes, accept the
reference value if one is provided, or type a new value.
4. Or, if you chose a dynamic value, select a measure to base your reference line on, and choose an
aggregation type.
5. Type alabel for the reference line, or leave this field blank to use the reference value as the label.
6. Choose line formatting options, and then select OK to create the reference line.
You can also create reference lines using the Reference Lines Manager: select the arrow beside the toolbar

+
S

button , and select Manage Reference Lines. Select the + icon to add a reference line.

6.6.2 Removing a reference line

Procedure

1. Inthe Visualize room, or while exploring a visualization in the Compose room, select the reference line you
want to remove.

2. Select Delete.
You can also remove reference lines using the Reference Lines Manager: select the arrow beside the

.
" i

toolbar button , and select Manage Reference Lines. Select the - icon to remove a reference line.
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6.6.3 Moving or changing a reference line

Procedure

In the Visualize room, or while exploring a visualization in the Compose room, select a reference line and select
Edit.

You can also move or change a reference line using the Reference Lines Manager: select the arrow beside the
o
toolbar button 4

Edit Reference Line.

, and select Manage Reference Lines. Select a reference line from the list and then select

6.7 Hierarchical data

The Dimension Hierarchy i icon indicates that a hierarchy is associated with a dimension. There are multiple
ways you can find and interact with hierarchical data.

6.7.1 Finding dimensions in a hierarchy

Hierarchical relationships between dimensions are visible on the Measures and Dimensions panel.

Context

Only the dimension containing the highest level of a hierarchy appears on the Measures and Dimensions panel,
but you can expand the dimension to see additional levels.

You can add a dimension at any level of the hierarchy to a chart.

Procedure

Perform one of the following actions:

o If the Measures and Dimensions panel is in the vertical orientation, select the ¥ icon beside a dimension to
display all dimensions in the hierarchy.

o If the Measures and Dimensions is in the horizontal orientation, look for dimensions displayed beside each
other in the hierarchy.
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6.7.2 Choosing the level of hierarchy displayed in the Chart
Builder

If a dimension containing a hierarchy is included in a chart, the level displayed in the chart can be changed in
the Chart Builder.

Procedure

1. Select a dimension that contains a hierarchy.

2. Select the Settings ﬁ icon and choose a level in the hierarchy.

Results

The chart displays data from the selected level.

6.7.3 Drilling through hierarchical data

Context

If hierarchical dimensions are included in a chart, you can drill up or down through dimensions on the Chart
Canvas to explore the data at different levels. If the chart contains more than one hierarchical dimension, you

can select which dimension to drill into. You can use the drill back icon to undo the drill operation and
restore the chart to its original state.

The drill operation comprises:

e applying afilter
® redrawing the visualization at the new level in the hierarchy

When you drill, a filter token may appear above the chart, or the filter may be added to an existing filter token.

Procedure

1. Select an areain the chart or a label on the axis.
For example, you can select one or more bars in a bar chart, or an axis label in a trellis.

The selected area in the chart is highlighted.
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[ oh
2. Inthe tooltip that appears, select the drill down %o ordrillup — ® icon.

If the area you selected contains more than one hierarchical dimension, you can choose which dimension

to drill into.

Afilter is applied to the data and the chart is re-drawn at the new level in the hierarchy.

3. To step back through the drill operation, select the drill back icon.

The filter created by the drill operation is removed and the visualization is re-drawn at the previous level.
Any filters applied by hand are maintained. Note that the drill back history is reset when you switch to the

Visualize room.

$6,475,050

ogo Filter () Exclude

L ] OWnN &
Erance Lo Drill Down e e

Y, :5..:1.| 1 Q l—. _~ Revenue Q e e

Related Information

Drilling through hierarchical data in a story [page 168]

6.8 Finding measures, dimensions, and data values

You can search text and integer dimension values for the name of a measure or dimension.

The find 0\ icon is located on the Measures and Dimensions panel
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e \When the panelis in a vertical orientation, you can use the find Q icon to search for measures and
dimensions by name.

® \When the panelis in a horizontal orientation, the find 0\ icon becomes available when the pointer is
positioned inside a column, and you can use it to search each dimension for specific values.

Table 30: Operators for searches

Operator Description

* Matches any character zero or more times. For example, entering a*a matches any word con-
taining the letter "a" followed by any combination of letters, followed by another "a."

? Matches any character one time. For example, entering a?a matches any word containing the
letter "a" followed by any single letter, followed by another "a."

If a dimension contains mapped labels, select the Options # icon, and select Find by Key or Find by Label.

Restriction

Date, time, time stamp, and non-integer numeric dimensions cannot be searched.

Restriction

Literal * and 2 characters cannot be used in search text or values.

6.9 Measures associated with dimensions

You must display the Measures and Dimensions panel in the horizontal orientation to view the measure values
associated with a dimension. You can also view the number of times each dimension value occurs in a dataset.

Example

Suppose a dataset contains a measure called “Number of Games Won" (calculated as a sum) and a
dimension called “Name of Team". You can display the total number of games that each team won beside
each team name on the Measures and Dimensions panel.
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6.9.1 Viewing a measure associated with a dimension

Procedure

-

1. Select the Horizontal Orientation icon to display the Measures and Dimensions panel in a horizontal

layout.

2. Position the pointer over a dimension, and select the Options ﬁ icon next to the dimension.

3. Select Show Measure, and select the measure to view.

Results

A measure value appears beside each value in the dimension column.

6.9.2 Viewing the nhumber of occurrences of dimension
values

You can view the number of times each dimension appears in your dataset.

Procedure

-

1. Select the Horizontal Orientation icon to display the Measures and Dimensions panel in a horizontal

layout.

2. Position the pointer over the dimension, and select the Options # icon next to the dimension name.

3. Select |k Show Measure » Occurrences 3.

Results

The number of occurrences appears beside each dimension value in the column.
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Related Information

Sorting dimensions by occurrence on the Measures and Dimensions panel [page 116]

6.10 Using calculations in the Visualize room

You can create a calculation and add it to your chart.

Context

You can use any measure from the dataset or any dimension from the chart when you create a calculation. The
calculation appears as a measure in the chart. It appears only in the current chart, and is not added to the
dataset. To add a calculated measure or dimension to the dataset, use New Calculated Dimension or New
Calculated Measure.

The following calculations are available:

e Counter
® Running Calculations
o Average
o Count
o Minimum
o Maximum
o Sum
e Moving Average
e Percentage Of
e Difference From
e Custom Calculation

Running count, running maximum, and running minimum calculations can be performed on numerical
measures, or on non-numerical measures such as date. Counter is performed on a dimension. Custom
calculations are performed on aggregated values. All other calculations are performed on numerical measures
only.

Procedure

1. Select Options # icon next to the measure to use for the calculation, and select | Add Calculation »

<Select a calculation> 1

Alternatively, select the Calculations icon on the Chart Canvas toolbar.
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2. Select a calculation in the list.

3. Enter the required parameters in the calculation dialog and select OK.

You can use multiple measures in your calculation.

Results

The chart is updated to include the calculation, and the calculation token appears in the measure shelf in Chart
Builder.

Example

This example shows how to use the Difference From calculation. Suppose you have a crosstab containing
the profit from three products for the years 2011 to 2014: the Measure is Profit and the rows are Year and
Product. You can use a Difference From calculation to create a year-over-year comparison of the profit.

In the [p Calculation ¥ Difference From 4 dialog, enter the following values:

Table 31:
Parameter Value
Name Use the default name.
Measure Profit (Sum).
Base Value Previous (Value).
Base Dimension Year.
Show as values Selected.
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The profit from a product in the current year is compared to the profit from a product in the previous year:

Profit and Difference From: Profit by Year, Product

Measures
Year Product Profit Difference From: Profit
20Mm ALA
BBB 21,032

cee 14,232 \

2012 AAA 20,000 @

BEB 33,453 12,421
ccc 12,030 -2,202
2013 AL 22,040 2,040
BEB 35,604 2,151
ccc 11,030 -1,000

Related Information

Counter [page 135]

Running Calculations [page 135]
Moving Average [page 136]
Percentage Of [page 137]

Difference From [page 137]

Custom Calculation [page 137]

Lumira functions reference [page 205]

SAP Lumira, desktop edition User Guide
134 PUBLIC Visualize room—creating charts



6.10.1 Counter

Use Counter to create a measure that counts the number of occurrences of a dimension. The measure can be
used directly in a chart, or used in other calculations.

For example, you can create a measure to count the number of members in the tops dimension. The measure,
Count (A): Tops, is added to the Measures panel. You can then use Count (A): Tops directly in a chart or as the
basis for another calculation.

Table 32: Parameters for Counter

Parameter Description

Name The name of the calculation. Use the default name or enter a new name.

Dimension The dimension to count.

Counter Type e Select Count (All) to count all members in the selected dimension.
Select Count (Distinct) to count only the unique values of members in the selected di-
mension.

6.10.2 Running Calculations

Use running calculations for cumulative operations on the measure values.

Table 33: Parameters for Running Calculations

Parameter Description

Name The name of the calculation. Use the default name or enter a new name.

Measure The measure to use in the calculation.

Running Kind The type of running calculation. The following types are supported:

e Average
e Count

® Max

e Min

e Sum
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Parameter

Reset At

Description

The dimension to use for restarting the calculation. Select none if you do not want the cal-
culation to restart.

For example, if your visualization contained a dimension called year, you could select

year to restart the calculation for each year.
Stop at last datapoint

This option automatically detects the last data point and stops the running sum line at that
point.

For example, if you have a growth chart with a combined time dimension in which data does
not exist for the entire time period, the running calculation line will stop at the last valid data
point.

Empty values excluded

Used in running average and running count calculations. Select to exclude empty values
from the calculation.

For example, if this option is not selected, empty values will be included as "0" in running
average calculations.

6.10.3 Moving Average

Use moving average to calculate the average of different subsets of the measure values.

Table 34: Parameters for Moving Average

Parameter Description

Name The name of the calculation. Use the default name or enter a new name.

Measure The measure to use in the calculation.

Reset At The dimension to use for restarting the calculation. Select none if you do not want the cal-

culation to restart.

For example, if your visualization contained a dimension called year, you could select year
to restart the calculation for each year.

Values Before

The number of values before the current value to include in the calculation.

Values After

The number of values after the current value to include in the calculation.

include self

Select to include the current value in the calculation.
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6.10.4 Percentage Of

Use Percentage Of to calculate the current value's percentage of the total of all the values for the measure.

Table 35: Parameters for Percentage Of

Parameter Description

Name The name of the calculation. Use the default name or enter a new name.

Measure The measure to use in the calculation.

Base Dimension The dimension used to create a subtotal for the selected measure. For example, select Year
to calculate the current value's percentage of the total of all the values for the current year.
Select (Grand Total) to use the total of all the values for the measure in the calculation.

6.10.5 Difference From

Use Difference From to compare different subsets of the measure values.

Table 36: Parameters for Difference From

Parameter Description

Name The name of the calculation. Use the default name or enter a new name.
Measure The measure to use in the calculation.
Base Value The value to subtract from the current value. For example, if you select Previous (Value),

the previous value of the measure is subtracted from the current value of the measure.

Base Dimension The dimension used for the comparison. For example, you could select Year to create a
year-over-year comparison, or select Product to compare measures from different prod-
ucts.

Select Row (Table) to treat the entire table as a single group.

Show as value Display the Difference From value as a number.

Show as percentages Display the Difference From value as a percentage.

6.10.6 Custom Calculation

Custom calculations are used for cumulative operations on aggregated measures.

You can create custom calculations on aggregated measures and on dimensions. You can even include other
custom calculations in new custom calculations.
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You can choose to remove a custom calculation from your visualization, but still keep the calculation for future
use. The calculations will be available on the Calculations menu, even if you are not currently using them in the
visualization.

When Custom Calculation is selected from the Calculations menu, the calculation editor is launched. The
calculation editor is also launched when you edit an existing custom calculation.

Related Information

Lumira functions reference [page 205]

6.11 Prompting and SAP HANA variables and input
parameters

SAP HANA variables, input parameters, and default values are defined in SAP HANA Studio.

After opening a story or dataset that includes SAP HANA variables or input parameters, a prompt dialog
displays a list of required and optional variables. The values you select for the variables set filters that
determine which data is included in a story. Multiple values can be selected when a SAP HANA variable allows
for multiple values. After setting prompt values, when you save a story, the prompt values are saved. (You will
not need to re-enter values.)

You can reset a prompt value by selecting the Reprompt icon.

6.12 Refreshing data in a document

The data that is saved with a document can become stale or invalid. Refresh the document to get fresh data
from the data source.

Context

For example, if you have an Excel data source comprising two columns <Name> and <Age>, and you acquire
the Excel data into SAP Lumira, but later the numbers in the Excel data are updated, you may want to refresh
the document to reacquire the updated Excel data.

Data isn't automatically refreshed if the data source has undergone a model change, such as columns being
added or removed. For example, if in the above Excel file the <Name> column is splitinto <First Name>and
<Last Name> columns, the <Name> column in the data source no longer exists and the refresh fails.
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If the data can't be refreshed automatically, the Data Mapping dialog helps you to refresh your data manually,
by mapping columns in your dataset to columns in the data source.

Procedure

1

Ty
If your document is open in the Prepare room, select the =~ licon. Or, if you're working in the Visualize

Ty

L

room, select the down-arrow next to the icon and select either Refresh or Refresh data with prompts.

If your data source contains variables, choosing the Refresh data with prompts option lets you reselect
variable values before the data is refreshed. These data sources support refreshing with prompts:

o Connect to SAP HANA

o Download from SAP HANA

© Download from SAP Business Warehouse
o SAP Universe Query Panel

If the data source model has not changed, the data is refreshed.

If the data source model has changed, the Data Mapping dialog appears. The dialog lists the datasets in
your document that can't be automatically refreshed. Complete the rest of these steps:

For query-based data sources, for example MySQL, select Edit Query.

In the Edit data source dialog, redefine your query, and select OK when finished.

Select a dataset in the Data Mapping dialog.

The Changed Columns for that dataset are shown.

Using the drop-down lists, choose columns from the data source to map the Changed Columns to.

You can map columns only to other unused columns of the same type. You can also remove any columns
that you no longer need in your dataset, but be aware that any dependencies based on the removed
columns will be removed as well.

Using the above Excel example, you could choose the changed column <Name>, and map it to the <Last
Name> Or <First Name> column from the drop-down list.

Related Information

Showing the latest data in a story page [page 156]

Editing an acquired dataset [page 49]

Specifying values for SAP HANA variables and string input parameters [page 35]

Prompting and SAP HANA variables and input parameters [page 138]
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6.12.1 Printing a chart

Context

You can print the visualization charts. Only the charts that are saved inVisualize room can be printed; you
cannot print tables.

Procedure

Start SAP Lumira.
Choose the Visualize room.

In the Chart Gallery, select the required visualization.

Choose || Settings ¥ Print 3

A owon o

The Print Visualization dialog box appears.

o

In the Printer list, select a printer connected to your computer or select Adobe Portable Document Format
(PDF)

Enter the number of print copies.
Select the required size.

Select the required page orientation.

O 0 N O

To select the Layout, perform any one of the following actions :

a. To print one chart per page, select One visualization per page.

b. To print two charts per page, select Two visualizations per page.

c. To print comments for each chart, select Visualizations with notes.
10. Select Print.

The chart is either sent to the selected printer or opens as a PDF file in your default document viewing
application.

6.13 Zooming in on data in a Line Chart for Date/Time
Series

You can zoom in to focus on specific time periods when analyzing data in a Line Chart for Date/Time Series.

Context

Zooming is available in the Visualize room, and when viewing stories.
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Procedure

1. Add at least one measure and one time dimension to the chart.
2. Inthe chart canvas, select the range of data that you want to focus on, and choose Zoom.

3. Toview the entire chart again, select Zoom Out at the top right of the filter bar.

6.14 Creating a dataset from a visualization

After creating a visualization that contains filters, merged columns, calculated measures or dimensions, and
other customizations, you can create a new dataset from that visualization.

Context

The resulting dataset contains objects that are visible in the visualization and hidden objects that are used in
merges and calculations (because they are required to calculate or refresh data), but it may not use all of the
objects from the original dataset. Hidden objects are visible when you edit the dataset. The new dataset is
saved with the name of the visualization and is saved in the document.

When you edit a dataset created from a visualization, columns in the Edit source pane correspond with the
acquisition dataset but not with the current dataset. For example, some names are a concatenation of the new
dataset column header and the original object column header(s), and some columns cannot be removed.
Columns that cannot be removed are used in the intermediary workflow (for example, inside a calculated
measure) and are needed to retrieve data, even if they do not appear in resulting dataset.

Procedure

1. Select the Options # icon in the thumbnail of a visualization, and select Create New Dataset.
A dataset is created, with the same name as the visualization.

2. Inthe dialog that appears, select OK.

3. Inthe Prepare room, select the expand list next to the current dataset name.
A list of datasets available in the document appears.

4. Select the new dataset.
The dataset opens in the Prepare room.
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6.15 Forecasting

The forecasting capability in SAP Lumira lets you use historical data as the basis for predicting future values.

Context

The forecasting feature analyzes the trends and cycles of a time series to predict future values. Forecasting
uses a measure and a dimension that is part of a time hierarchy (for example, Month) as its inputs. You specify
how many forecasted values you want the algorithm to produce.

SAP Lumira provides two algorithms for forecasting future data: SAP Predictive Analytics, and Triple
Exponential Smoothing.

An SAP Predictive Analytics time series analysis computes several models that are compared for best results.
It does this by breaking a time series into four components:

e Trend

e C(Cycles

e Fluctuations

e |nformation Residue

Here is an example of how an SAP Predictive Analytics time series analysis can predict future values. The blue
line on the chart represents the actual data, and the red line represents the forecasted values.
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In addition to SAP Predictive Analytics forecasting, the Triple Exponential Smoothing (TES) algorithm can be
used, in particular for situations where SAP Predictive Analytics can't produce a forecast. The TES algorithm
always produces a result, but the result is usually of lower quality.

To learn more about how forecasting and other predictive analytics techniques can help your business
succeed, visit our SAP Predictive Analytics site: http://www.sap.com/learn-predictive .
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Procedure

1. Select the Settings ﬁ icon beside a measure on the MEASURES shelf in the Chart Builder.
2. Select |} Predictive Calculation » Forecast 3.

3. Choose aforecast type.

The SAP Predictive Analytics algorithm is more accurate, but needs more data before it can produce a
meaningful forecast. The Triple Exponential Smoothing algorithm is less accurate, but can produce a
forecast with any amount of input data.

4. Choose a name for your calculation, then choose a number of time periods to predict, and select OK.

6.16 Linear Regression

You can apply a linear regression to your data, to visualize a linear trend or to predict future data based on the
linear trend in your data. Linear regression uses a measure and a dimension that is part of a time hierarchy (for
example, Month) as its inputs.

Context

Here is an example of how a linear regression can predict approximate future values. The blue line on the chart
represents the actual data, and the red line represents the linear regression forecast.

Cordwrarn wed Bagrappon Lordmrars by blord

A

& artamam
/ B bigeuisis (aasan

Loniurura § Fegraason: Contsrea
- e

SAP Lumira, desktop edition User Guide
Visualize room—creating charts PUBLIC 143



Procedure

1. Select the Settings ﬁ icon beside a measure on the MEASURES shelf in the Chart Builder.

2. Select | Predictive Calculation ¥ Linear Regression .

3. Choose a name for your calculation, then choose a number of time periods to predict, and select OK.

6.17

Influence analysis

Using SAP Predictive Analytics influence analysis, you can look at a specific measure in your data to determine
which dimensions are influencing that measure the most. SAP Lumira then suggests related visualizations
based on the analysis.

Context

To learn more about how influence analysis and other predictive analytics techniques can help your business
succeed, visit our SAP Predictive Analytics site: http://www.sap.com/learn-predictive .

Procedure

1. Tofind the Top Influencers of a measure, enter the Explain workflow by first navigating to the Related
Visualizations tab from the Visualization Tools panel.

2. From the Measures and Dimensions panel, select the measure you wish to analyze and select Run
Analysis.

A list of charts is generated, which represents the dimensions that have the most influence on your
selected measure. A special Top Influencers summary chart appears at the top of the list and summarizes
the amount of influence each dimension has on the selected measure. You can select and explore an
influencer from the summary chart, and you can add any of those visualizations to a story except for the
summary chart itself.

1

o

Note

If your data doesn’t contain a statistically significant result, the influence analysis won't show any
visualizations.

Influence analysis is performed on the underlying dataset, and therefore filters are not considered
when running an analysis.

If the option to run an influence analysis doesn't appear, it could be because of one of these
reasons:

o Online data sources (for example, SAP HANA) are not supported for influence analysis. Data

must be downloaded to SAP Lumira before running an influence analysis.
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o Inthe Preferences, the Would you like to display Related Visualizations and allow influence
analysis? check box needs to be selected.

6.18 Sharing Visualizations

After creating visualizations, you can share them by either sending the visualization chart by e-mail or by
printing the visualization chart.

Table 37: Visualization sharing options

Description
Send by e-mail Send a visualization to an e-mail recipient.
Print Visualization Send a visualization to a printer.

6.18.1 Sending a chart by e-mail

Context

You can share a visualization chart by sending it through e-mail. Charts are attached as graphic files, while
table charts are attached as Excel files (not as graphic files) in e-mail messages.

Procedure

Start SAP Lumira.
Choose Visualization room.

In the Chart Gallery, select the required visualization.

Choose | Settings ¥ Send by Mail... 3

A owon o

The Send by e-mail dialog box appears.

o1

Select the required size.
6. Choose OK.

You can see the chart added as an email attachment.
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6.18.2 Printing a chart

Context

You can print the visualization charts. Only the charts that are saved inVisualize room can be printed; you
cannot print tables.

Procedure

A owon e

o

© o N o

10.

146

Start SAP Lumira.
Choose the Visualize room.

In the Chart Gallery, select the required visualization.
Choose | Settings ¥ Print 3

The Print Visualization dialog box appears.

In the Printer list, select a printer connected to your computer or select Adobe Portable Document Format
(PDF)

Enter the number of print copies.
Select the required size.

Select the required page orientation.
To select the Layout, perform any one of the following actions :

a. To print one chart per page, select One visualization per page.

b. To printtwo charts per page, select Two visualizations per page.

c. To print comments for each chart, select Visualizations with notes.
Select Print.

The chart is either sent to the selected printer or opens as a PDF file in your default document viewing
application.
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7 Compose room—creating stories with
visualizations

A story is a presentation-style document that uses visualizations, text, graphics, and other customizations to
describe data. Data can be explored using filters, input controls, and by drilling.

These are the main areas where you interact with the Compose room:
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Table 38:

Number

Description

1 Content Panel

Contains different types of content that you can drag on to the story page. The

Visualizations picker is open by default, but you can select other pickers to display

other types of content. For example, select the Text picker to display text boxes.

Select an item in the picker and drag it to a section in the story page.
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Number | Area Description

2 dataset selector The story may contain multiple datasets. Use the dataset selector to choose a different
dataset. Visualizations based on the currently-selected dataset are displayed in the
Visualizations picker.

3 story selector The document may contain multiple stories. Use the story selector to choose a differ-
ent story to work on.

4 Preview Select Preview to see how the story will appear when published.

5 filter bar Displays filter tokens that represent any filters applied to the dataset or to the current
page.

6 Add Page Select to add a new page to the story. Each page in a story can have its own format.

7 story page Every story has one or more pages that can contain items such as visualizations, text,
graphics, and input controls. You can change the page size in the Page Settings panel.
Drag items from the Content Panel to the story page to describe and explore your data.

8 zoom control Select to choose a zoom level.

9 story page gallery Expand to create story pages or to manipulate story pages.

e Create a story page by selecting the Add Page + icon.

e Rename or delete a story page by selecting the Settings # icon. (To delete the
entire story rather than the current page, use the Delete Story ]]]] icon near the
top of the Compose room.)

e Change the order of the story pages by dragging them to a different order.

10 Settings Contains panels that enable customization of the currently-selected item on the page.
The Page Settings and Story Settings panels are always available.
For example, the Visualization Properties panel appears if you select a visualization on
a page. This panel enables customization of colors, axis layout, and other areas.
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7.1 Getting started with stories

Use visualizations together with pictures and text to create a story about data. Explore and analyze the data
using filters, input controls, calculations, conditional text, and other tools.

Context

1 Note

In the 1.27 release, the Board and Report formats are removed from the application. The Infographic layout
is used for all story pages in 1.27 and later releases. All functionality from Board and Report pages has been
added to Infographic pages, and all existing Board and Report pages are automatically converted to the new
format when opened. All functionality in the existing story pages is preserved.

Various templates are available to help you develop professional-looking documents. Each page in a story can
have its own template, and you can add, move, and delete pages as you work. You can also save your story and
create a new one at any time. Select from the following templates:

® Blank - Use this template to create a custom format. Sections on the page will be created as content is
added.

e Standard, Overview and Detailed - Use these templates as a starting point for common types of
documents. Pages are pre-formatted with sections for visualizations and text.

e Slideshow - Use this template to automatically create a story using every visualization from the Visualize
room. Each visualization is added to its own page.

1 Note
Use Slideshow to automatically create a story with every visualization on its own page.

The Content Panel on the left side of the Compose Room contains content such as Visualizations and Text.
Drag content from these areas onto sections of the story page.

= Tip

The content panel displays visualizations based on the currently selected dataset. If the selected dataset is
a primary dataset for any visualizations, those visualizations are included in the content panel. But if the
selected dataset is a secondary dataset for any visualizations, those visualizations are not included in the
content panel.

The Board Settings panel on the right side of the Compose Room contains panels for formatting different types
of content. Panels appear as the corresponding elements are selected: for example, the Section Color panel
appears when a section on the page is selected.
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Procedure

1. Inthe Compose room, select New Story.

2. Select the template for the first page in the story, and select Create.

The Compose room opens, displaying a page with the selected format. Visualizations are displayed in the
Content Panel on the left side of the window. If the document contains more than one dataset,
visualizations based on the first dataset are displayed, but you can select a different dataset to display
other visualizations.

3. Dragavisualization from the Content Panel to a section in the story page.

(Optional) Reposition the visualization, or re-size it by dragging a corner of its bounding box.

4. (Optional) Select Expand | < to enlarge the visualization to the size of its section.

Position the pointer over the visualization to display the Expand | < icon on the options menu.

5. Select Explore 'E' to customize a visualization in the story by adding filters, rankings, calculations, or by
drilling through hierarchical data.

Position the pointer over the visualization to display the Explore IEP icon.

6. Use Undo “ and Redo o to experiment with different layouts and tools, then revert the page to its
original state.

7. Select Preview to see how the story will appear when published.
8. To create additional pages, select Add Page.
9. Save the story.

Related Information

Formatting a story page [page 151]
Formatting a visualization [page 152]
Linking to a web page or to another page in the story [page 159]

7.1.1 Modifying a story
Context
You can make changes to a saved story.
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Procedure

Open a saved story.

The story opens in the Compose room, where you can modify it.
Related Information

Compose room—creating stories with visualizations [page 147]

7.1.2 Saving a story

You can save a story or make a copy of an existing story by using the Save As option.

7.2 Formatting a story page

Context

Use the PAGE SETTINGS panel to format the size, general appearance, and behavior of each page.

Table 39: Page Settings Panel

Option Description

Size Select Standard (4:3) or Widescreen (16:9), depending on the preferred layout and the type
of device that the published story will be viewed on. Select Continuous Scrolling to display
all data rows in a crosstab in a single page.

Width, Height Set the default page size (in pixels). This option allows you to design story pages based on
the size of the screen they will be viewed on, whether it is larger or smaller than the screen
used to create the pages.

You only need to set one value; the other will be set automatically.

Select a background color for the page.

Background Color

Grid Properties Select the Show check box to display grid lines. Grid lines make it easy to align elements
and achieve a professional appearance for your story.

Show latest data Automatically refreshes the data when the page opens. To stop the automatic refresh, se-

lect OFF.
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Description

Show page filter indicators Select ON to enable page filter indicators for visualizations on the story page. Page filter in-
dicators give visual cues that a page-level filter applies to the data in a visualization.

1 Note

If the story page contains a crosstab that has a scrollbar (because the viewable region is not big enough to
show all the cells) and the story page has Show latest data turned on, when the story page is exported to
PDF the crosstab in the PDF will be displayed with the default scroll position. It will not show the scroll
position that you see in the Compose room.

Procedure

1. Inthe Compose room, open the page of the story to format.
The Page Settings panel displays the options available.

2. Select page formatting options as needed.

3. Save the story.

7.3 Formatting a visualization

Visualizations can be easily customized to emphasis the data message.

Context

Use the Visualization Properties panel to modify the appearance of each visualization in the page. Different
options are available for formatting, depending on the type of chart in your visualization.

To display the Visualization Properties panel, select a visualization in the page.
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Table 40: Visualization Properties Panel

Area

General

Description

Show Chart Title: Select to display the chart title and format it.

Show Legend: Select to display the chart legend and format it.

Show Data Labels: Select to display the values for each dimension in a chart.
Format Data Labels: Select to format the values for each dimension in a chart.

Optimize Chart Alignment: This option is available for most charts with axis lines. Po-
sitions a chart in its section with optimal area for displaying data, while preserving
space for labels and text. All visualizations that are the same size and that have this
option selected will have horizontal and vertical axis automatically aligned. Deselect
to align axis by hand.

Xand Y axis

Show Axis: Select to display the axis.
Show Axis Title: Select to display the axis title and to format it.

Show Axis Labels: Select to display axis labels and to format them.

Select a bar shape or pictogram to display as the bars in a bar chart, and choose the color

of the bars.

Column

Select a column shape or pictogram to display as the columns in a column chart, and

choose the color of the columns.

Line Chart

Chart Area: Select the background color of the chart area.

Chart Title: Display the chart title and format it.

Plot Area: Select the background color of the plot area.

Legend: Display a chart legend and to display a legend title and format it.

Data Label: Display data labels or data-label pictograms.

Horizontal Axis: Display the axis line and ticker, display axis labels and format them,
and display axis pictograms.

Horizontal Axis Title: Display the axis title and format it.

Vertical Axis: Display the axis line and ticker, display axis labels and format them, and
adjust the axis value scale.

Vertical Axis Title: Display the axis title and format it.

Marker: Select and format a pictogram to represent data points.

Line: Set the line color, thickness, and style.

Plot Area: Show or hide grid lines.

Donut Chart

Chart Area: Change the size of the inner circle in the donut.

Chart Title: Display the chart title and format it.

Plot Area: Change the background color of the plot area.

Legend: Display a chart legend and to display a legend title and format it.

Slice: Change the color of a slice of the donut (to draw attention to that data point).
Data Label: Select the Show Data Labels check box to display the data labels and for-
mat them.
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Area Description

Crosstab Chart elements e (Crosstab area formatting: You can set formatting separately for different areas in a
crosstab. Choose an area:

o  Column Dimension Header

o Column Labels

o Row Dimension Header

o Row Labels

o Data Cells
The affected part of the crosstab is outlined on the story page. You can format the

text, set the text alignment, and choose a background color. For data cells, you can
choose to alternate between two colors for the rows.

e Fxpand Crosstab to See All rows: Expand the crosstab vertically to see all the rows it
contains. The page size is changed to continuous scrolling when this option is se-
lected.

Procedure

1. Inthe Compose room, select a visualization on a story page.
The VISUALIZATION PROPERTIES panel displays the options available. Different types of charts have
different options.

2. From the drop box, select the area of the visualization you want to format.
The formatting options for the selected visualization area appear.
3. Format the visualization area.

4. Save the story.

7.4 Exploring a visualization in a story

You can explore visualizations while working on a story in the Compose room, or while viewing a story. For
example, you can drill down and up, filter values, and add rankings.

Context

While exploring a visualization, you can make some of the changes that are available in the Visualize room,
such as:

e Drilling down on a value and drilling up
e Applying filters or modifying filters that are applied to the visualization, including filters created in the
Visualize room
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Changing how the data is sorted

Zooming and panning on geographic charts

Changing the title and chart settings

Setting whether to fit all of the chart data inside the frame at once

The updates are applied to the copy of the visualization that you added to the page. Other visualizations are
not affected.

Filters applied to the story or page are displayed in the filter bar while exploring a visualization, but they can't

be edited. These types of filters are distinguished with the following icon: 50

Procedure

In the Compose room, open a page and add a visualization.
You can also explore visualizations while viewing a story.

Select the Explore 'E" icon in the upper-right corner of a visualization.
The visualization opens in a new window.

Explore the visualization and make changes as needed.

4. Select Update to apply your changes.

In the Compose room, save the story.

Related Information

Visualize room—creating charts [page 86]

Drilling through hierarchical data in a story [page 168]

Using the filter dialog in the Visualize room [page 117]

Filtering or excluding data points in a chart [page 119]

Filtering data by rank [page 121]
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7.5 Showing the latest data in a story page

The latest data in a story page is automatically shown when you open the page, but you can turn that option off
if you would prefer to refresh the data yourself.

Context

Showing the latest data each time you open the story page can change the narrative message of an
infographic because it changes the data that the infographic is built on. You may want to refresh the data
yourself.

1 Note

If you use a pictogram to represent a chart element, such as a bar in a bar chart, the size of the element may
change when the data on the page is refreshed.

Procedure

1. Inthe Compose room, open the page that you want to update.
2. Expand the PAGE SETTINGS panel.

3. To stop automatically refreshing data each time you open the page, select the OFF button under Show
latest data.

Results

When you reset the option to ON, a dialog appears, indicating that visualizations will be updated to use the
most recent data and this may change existing customizations.
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7.6 Rearranging story pages

You can easily change the order of your story pages.

Context

When you move the story pages around, the hyperlinking between pages is automatically updated to reflect
the new page order.

Procedure

1. Inthe Compose room, expand the story page gallery.

A thumbnail image is displayed for each page in the story.

2. Drag athumbnail image to a new position.

The page numbers automatically change to reflect the new order of the pages.

7.7 Renaming story pages

Provide your own descriptive names for story pages.

Procedure

1. Inthe Compose room, expand the story page gallery.

A thumbnail image is displayed for each page in the story.
2. Select the thumbnail image for the page that you want to rename.
3. Select the settings icon on the image and then click Rename.

4. Typeinaname and then click OK.
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7.8 Deleting story pages

Delete individual story pages.

Procedure

1. Inthe Compose room, expand the story page gallery.

A thumbnail image is displayed for each page in the story.
2. Select the thumbnail image for the page that you want to delete.
3. Select the settings icon on the image and then click Delete.

4. Inthe Remove Page dialog, click Yes.

7.9 Pictograms and shapes

Shapes and pictograms can add visual flair to your story.
You can insert them in two ways:

® Asaseparate element
In the Compose room, drag a pictogram or shape from the Content Panel to a page. The graphic can then
be formatted using the Board Settings panel.

e As part of a visualization
You can use pictograms to represent certain visualization elements, such as columns, bars, data point
markers, data labels, and axes. These display options are available on the VISUALIZATION PROPERTIES
panel when you select the element or group of elements. You can use the same pictogram for each
member or select individual members to customize the appearance of each one.

1 Note

If you use a pictogram to represent a visualization element, the size of the element may change when
the data on the page is refreshed.
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7.9.1 Uploading custom pictograms and shapes

Before you can add your own pictograms and shapes to stories, you must upload them to the application. The
graphics must be in Scalable Vector Graphics (SVG) format.

Procedure

1. Inthe Compose room, select Pictograms or Shapes on the Content Panel.
2. Select the +icon and select Add from Local.
3. Choose the .svg file to add, and select Open.

The file must be an SVG file with valid XML encoding.

Results

The graphic appears in the Personal section of the Content Panel for Pictograms or Shapes. You can add the
graphic to infographic or report pages. You can add custom pictograms as part of a visualization on an
infographic page, as well.

1 Note

e (Changing the line color, fill color, or line width of custom shapes and pictograms is not supported.
e [f you open a story with a custom shape or pictogram added by a different SAP Lumira user, the custom
graphic is displayed as normal. However, it does not appear in your Content Panel.

7.10 Linking to a web page or to another page in the story

You can add a hyperlink to an external web page, or to another page in the same story. The hyperlink can be
added to highlighted text in text boxes, pictograms, shapes, and pictures.

Procedure

1. Inthe Compose room, select the text, pictogram, shape, or picture that you want to link from.

For text, select the text itself; not just the frame containing the text.

2. Select the Hyperlink #icon on the right side of the window, in the properties area.

3. IntheLink to list, select External URL or Page.
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4. Enter aweb page's URL, or select a page in the story to link to.

5. Ifyou're linking to a web page and you want the web page to open in a new window, select the Open in new
window check box.

6. Select OK.

7.10.1 Modifying a hyperlink

You can modify a hyperlink so that it points to a different web page, or to a different page in the story.

Procedure

1. Inthe Compose room, select the object that you want to modify the link for.

2. Select the Hyperlink #icon on the right side of the window, in the properties area.
3. Inthe Edit Hyperlink dialog, modify the URL or change the page to link to.
4. Select OK.

7.10.2 Removing a hyperlink

You can remove a hyperlink.

Procedure

1. Inthe Compose room, select the object that you want to remove the link from.

2. Select the Hyperlink #icon on the right side of the window, in the properties area.

3. Select Remove.
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7.11 Adding text to a story

You can add text to sections in a story page, or overlay the text on a visualization.

Context

When a page has multiple elements (visualizations, pictures, pictograms, and shapes), use text to reinforce
the intended message.

Procedure

1. Inthe Compose room, select the visualization or the page section to add text to.

no

A blue bounding box shows the position of the text box in the visualization.

Enter the required text in the box.

(Optional) To move the text box, drag the bounding box to a new location.

(Optional) To resize the text box, select an anchor on the bounding box, and drag it to the desired size.
(Optional) To format the text, use the options under TEXT PROPERTIES on the Board Settings panel.

S e

7.12 Adding dynamic text to a story

You can add dynamic text that is based on the measures in the dataset. Dynamic text is updated when the
dataset is refreshed.

Procedure

1. Inthe Compose room, select the page to add dynamic text to.

2. Select the text element and position the pointer where you want to insert dynamic text. You can also
highlight existing text you want to change to dynamic text.

{}
3. Onthe TEXT PROPERTIES panel, select the Add or Edit Dynamic Text icon.
4. Inthe New Formula dialog, enter a name for the formula.
5. Double-click the measures and functions you want to add to the Formula syntax box.

You cannot create dynamic text objects based on dimensions.
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6. Enter the parameters for the function and associated information, based on the function task.
You must enter the names of columns used in the formula. After you enter the first letter, if the application
can match an existing name to the letter, it displays the name.

7. If you are inputting calendar information, select the Select a Date button at the bottom of the functions list
to use the date picker.

8. Select OK to apply the formula.
You cannot add both dynamic text and a hyperlink to the same text.

Results

The dynamic text element is added to the text object and will be updated each time the dataset is refreshed.

7.12.1 Modifying dynamic text in a story

You can modify dynamic text in a story.

Procedure

1. Inthe Compose room, select the page to edit.

2. Select the dynamic text to edit.

{}
3. Inthe TEXT PROPERTIES panel, select the Add or Edit Dynamic Text icon.

The Edit Formula dialog appears.
4. Modify the text in the Formula box or change other options as needed, and select OK.

7.12.2 Removing dynamic text from a story

You can remove dynamic text from a story.

Procedure

1. Inthe Compose room, select the page to remove dynamic text from.

2. Select the dynamic text to remove.

3. Onthe TEXT PROPERTIES panel, select the Remove Dynamic Text 4 icon.
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7.13 Filtering data in stories

In the Compose room, or while viewing a story, you can apply filters to individual visualizations, or to an entire
page or story.

While exploring a visualization, you can filter that instance of the visualization using most of the functionality
that is available in the Visualize room. Filters that were applied to the visualization in the Visualize room can be
modified or removed. Other copies of the visualization are not affected.

Also, the following actions apply filters to the entire story, or to the current page in the story:

e Choosing values for input controls in the Compose room or while viewing a story.
e Selecting data points in a chart to drill through hierarchical data while viewing a story.
e Selecting data points in a chart to filter or exclude the chart members while viewing a story.

Tokens appear in the filter bar on pages where these filters are active. Filters that apply to the entire story are

distinguished by the following icon: 50

You can set the scope of a filter by selecting the token in the filter bar and choosing All Pages (Story Filter) or
Current Page (Page Filter). In the Story Settings panel, you can switch the default scope for these filters as well.

You can also turn on the Show page filter indicators setting for a page to provide a visual cue that visualizations
are being filtered.

1 Note

e |nstories with multiple datasets, filters are automatically applied to matching dimensions from other
datasets. Matching dimensions are linked in the Define Dataset Links dialog, or have the same name
and type.

e By default, the filter scope is set to All Pages. In documents created using versions of SAP Lumira
earlier than 1.28, however, the default setting is Current Page.

e Sometimes, two filters on a page may apply to the same dimension. For example, you may apply a filter
on the Country dimension for all pages and then filter a single page by the Country dimension as well. In
this case, the filter selections are merged for that page. For example, if you select USA and Germany for
the story filter and France and Germany for the page filter, the page shows data for USA, France, and
Germany.

e Fach member can appear multiple times in a Line Chart for Date/Time Series that has combined
dimensions in the Time Dimension shelf. When you select a range in the chart to exclude, some of the
excluded members may have other instances that still appear in the chart. In this case, those members
are not filtered out of other charts in the story or page. That is, a member is excluded only if every
instance is inside the excluded range.

Any filters that were applied to the dataset or to individual visualizations in the Prepare or Visualize room are

applied in the Compose room as well. Dataset filters are shown in the filter bar with this icon: E

SAP Lumira, desktop edition User Guide
Compose room—creating stories with visualizations PUBLIC 163



Related Information

Exploring a visualization in a story [page 154]
Filtering data [page 61]

7.13.1 Using input controls

Use input controls to interactively filter data in your story's visualizations.

Context

Use input controls to apply interactive filters to a story, making it easy to highlight different areas of the data in
the Compose room, or while viewing the story. The filter created by the input control applies to each relevant
visualization. A visualization is relevant if its dataset contains the dimension you are filtering, or a matching
dimension.

The input control's filter will apply to any matching dimension in any of the story's datasets. Matching
dimensions are determined first by any links established in the Define Dataset Links dialog. In the remaining
datasets without matched dimensions, dimensions with the same name and type as the selected dimension
will match automatically, regardless of upper or lower case. If you need to manually add or remove links
between dimensions from different datasets, you can select edit input control.

Procedure

1. Select Input Controls on the Content Panel.
Dimensions from the selected dataset appear on the gallery above the Content Panel. If you want to view
dimensions from a different dataset, choose it from the dataset selector.

2. Drag a dimension to the story.
You can add input controls to a section in the story, or you can overlay the input control on a visualization.

A blue guide box indicates the placement of the input control in the visualization. You can optionally re-size
or move the input control.

A CONTROL PROPERTIES panel appears on the Page Settings panel, allowing you to modify the input
control and view a list of affected datasets, or datasets that contain a dimension with the same name as
the selected dimension.

3. Inthe CONTROL PROPERTIES panel, choose the Style for the input control.
Both combo boxes and list boxes allow users to view, search, and sort a list of members. List boxes may

be more appropriate for smaller input controls, because they show dimension members in a drop down
list.

4. Inthe CONTROL PROPERTIES panel, choose the Selection Mode for the input control.
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Select Single to restrict the input control to a single dimension value. Select Multi to allow users to select
multiple values.

5. If necessary, select the check box beside each value that you want to show for the dimension.

In longer lists of values, you can find a value by scrolling through the list or by entering text in the Search

box. You can also use the sort arrow H to sort values in ascending or descending order.
All relevant visualizations on either the current page or in the entire story are updated with the values you
chose for the dimension, and a filter token appears for the input control.

6. Tochange the scope of the input control, select the filter token and choose Current Page (Page Filter) or
All Pages (Story Filter) from the APPLY TO list.

7. Repeat steps these steps for each dimension that you want to add an input control for.

Results

When viewing the story, your collaborators can customize the data by selecting new values for each input
control.

If you export the story to PDF, the dimension and the selected values for each input control are displayed in
the PDF.

Related Information

Apply page filter indicators [page 169]
Configuring input controls for multiple datasets [page 165]

7.13.1.1 Configuring input controls for multiple datasets

Context

The CONTROL PROPERTIES panel for an input control lists the affected datasets and the dimension in each
dataset that the input control applies to. The dimensions that are affected by an input control are determined
as follows:

e First, if the dimension selected for the input control is linked to a dimension in another dataset, those
dimensions are mapped together. Links are established in the Visualize room, from the Define Dataset
Links dialog.

e Forthe remaining datasets, dimensions that have the same name as the dimension selected for the input
control are mapped together. This mapping is not case-sensitive, but the dimension type must be the
same.

If you want to change how a dimension in a dataset is mapped to an input control, select Edit affected datasets.
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To map affected datasets, your story must contain two or more visualizations and contain two or more
datasets.

Procedure

1. Select aninput control on a page of a story.

The CONTROL PROPERTIES panel for the selected input control appears.
2. Select edit input control.
The Edit Input Control dialog appears. Displayed on the left are the dataset and dimension that the input

control is based on. Other datasets in the story are listed on the right, with each dimension that is
currently mapped to the input control.

3. From the list of dimensions for each dataset, select the new dimension to map to the input control, or
select Does not affect to prevent the input control from filtering that dataset.

You can only map dimensions of the same type, for example string type or number type.

4. Foronline datasets based on SAP HANA views, select the Join ©

configure the list of values for the input control.

icon for each secondary dataset to

o Select Left Outer Join " to show the values from the first dataset. Values that exist only in the
secondary dataset will not appear in the input control.

o Select Full Outer Join "™ to show values that exist in either dataset.

5. Select Apply.

Results

The input control mapping is updated.

Related Information

Using input controls [page 164]
Apply page filter indicators [page 169]
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7.13.2 Using the filter dialog in the Compose room

Use the filter dialog in the Compose room to define a filter on the current story page or on all story pages.

Context

Tokens representing active filters are displayed above the Chart Canvas.

Procedure

+

1. To open the filter dialog in the Compose room, click the Add filters icon above the Chart Canvas and

choose a dimension to filter.

If a dimension includes a dimension hierarchy ot icon, click # to expand the list to show all dimensions
included in the hierarchy.
You can also select the token for an existing filter to edit it in the filter dialog.

2. Onthe filter dialog, choose an operator from the list.

3. Specify the values to filter:

Operator Description

Between Type a beginning value and an end value.

Equal to, Not Equal to, Type a value.
Greater than, Greater than
or equal to, Less than, or
Less than or equal to

Contains Type a string that is contained in all of the values that you want to include. For
example, filtering a dimension of clothing product categories for shirt would return

values such as T-shirts, long-sleeve shirts, shirt dresses, and so on.

Like or Not Like Type a pattern that matches all of the values that you want to filter or exclude. You can
use the following wildcard characters in the pattern:
© The _ character matches any single character. For example, filtering a dimension
of US state abbreviations for A would return the values AL, AK, AR, and AZ.
o The % character matches any number of characters. For example, filtering a

dimension of US state names for A%a would return Alabama, Alaska, and Arizona.

In List or Not In List Select values from the list in the filter dialog.

o Youcan hold|sHIFT |while clicking values to select a range of values.
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|
Operator Description

o With alphanumeric dimensions or numeric integer dimensions, you can select the
box of filter values to show the values as comma separated text. You can then
type values, or paste a CSV list. If your values include commas, surround each
value with quotation marks. For example, "New York, NY", "Los
Angeles, CA", "Chicago, IL"

If you enter a value that does not exist in the dataset or visualization, it is saved
with the filter. This way, you can filter values that are added to the data after the
filter is created.

©  You can also select the Options # icon to change the filter dialog settings,
including displaying the number of times that each record occurs in the dataset,
and sorting the data by value or by number of occurrences.

o When filtering an integer or alphanumeric dimension, you can select the Find C}\
icon to search for a member by name.

By selecting |I* Options  Enable wildcard search 3, you can search alphanumeric

dimensions using the _and % wildcards.

4. Click Apply.

Results

The data is filtered and a token representing the filter is added above the Chart Canvas.

7.13.3 Drilling through hierarchical data in a story

Context

Drilling through hierarchical data in a story has the same capabilities as drilling in the Visualize room. Input
controls and filters applied to the page are maintained during the drill and drill back operations.

The drill operation consists of:

e applying a filter to the current page or all pages, depending on the Default Filter Scope for the story
e redrawing the visualization at the new level of the hierarchy

When you drill through one visualization in a page, the filter is applied to other visualizations on the page or in
the story, including visualizations based on other datasets.

In order for hierarchies to match across datasets, both the dimension name and type must match, or the
dimensions must be linked in the Define Dataset Links dialog.
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Procedure

1. Select an areain the visualization to drill through.

[ O
2. Inthe tooltip that appears, select the drill down “o ordrillup ® icon.

The filter is applied to relevant visualizations and a token is added to the filter bar. The selected
visualization is re-drawn at the new level in the hierarchy.

3. To step back through the drill operation, select the drill back icon.

The filter created by the drill action is removed from all visualizations in the page. The selected
visualization is re-drawn at the previous level. Any filters or input controls applied by hand are maintained.
Note that the drill back filter is reset when you switch to the Compose room.

Related Information

Drilling through hierarchical data [page 128]

7.13.4 Apply page filter indicators

5

Page filter indicators L give visual cues that a page-level filter applies to the data in a visualization.

Context

Page filter indicators can be triggered by drilling, input controls, or filtering or excluding chart members. When
you have multiple visualizations on a page, these operations can affect more than one visualization, so the
filter indicators can help you understand how a filter has changed the data on each visualization.

1 Note
Filters that you apply in Explore mode, which affect only a single visualization, do not trigger the page filter

indicator for that visualization.

For each filter applied to the visualization, the icon's tooltip shows the affected dataset, the filtered dimension,
and the number of filtered values. You can turn page filter indicators on or off for each page in a story.
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Procedure

1. Onthe PAGE SETTINGS panel, turn on Show page filter indicators.

5

2. The icon appears in the upper left corner of every visualization that is displaying filtered data. If a
number appears next to the icon, it indicates the number of filters applied to the visualization.

(3
3. Hover over the Y icon on a visualization. Each affected dataset is listed in bold. The filtered
dimensions are listed underneath each dataset, along with the number of values being filtered for each
dimension.

4. Toremove page filter indicators from a page, turn off Show page filter indicators.

Related Information

Using input controls [page 164]
Configuring input controls for multiple datasets [page 165]

7.14 Viewing stories

After you publish and share a story, collaborators can view it. Depending on their rights and how the story was
shared, they may not be able to edit it in Lumira. However, stories allow collaborators to make certain changes
to visualizations to customize how the data is displayed. In the Compose room, you can select Preview to test
the features that are available while viewing the story. You can also pick a resolution for the preview, for
example, if you intend to share the story with colleagues using mobile devices or tablets.

Some changes affect only a single visualization, while others can affect all data on the current page, or in the
entire story.

Table 41: Features available while viewing stories

Feature Description Scope

Drilling You can drill up or down in hierarchical data by selecting | Page-level or story-level filter
a data point in a visualization.

Filtering You can apply filters to visualizations by choosing data | Page-level or story-level filter
points and selecting Filter or Exclude.

Selecting input control values | If input controls were added to the story in the Compose | Page-level or story-level filter
room, you can select values for the input controls to fil-
ter data while viewing the story. Input controls apply a
story-level or page-level filter that can affect multiple
visualizations.
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Feature Description Scope

Exploring visualizations Single visualization only

You can select the Explore & icon for a visualization
to apply much of the functionality that is available in the
Visualize room, such as filtering, ranking, and sorting
data in the visualization.

Related Information

Drilling through hierarchical data in a story [page 168]
Filtering or excluding data points in a chart [page 119]
Exploring a visualization in a story [page 154]

Using input controls [page 164]

7.15 Working with crosstabs in stories

Crosstabs are used in stories to display all the original data from a dataset. You can use the VISUALIZATION
PROPERTIES panel to customize how a crosstab appears in a story.

Expanding a crosstab to see all rows

By default, a crosstab is sized to fit into its container, but you can use Expand Crosstab to See All Rows to show
all rows of data on a single page. This setting changes the page to continuous scrolling mode.

If the width of the crosstab is greater than the width of the page, you can use the scroll bars to view all
columns.

= Tip

If you can't see the vertical scroll bar, double-click the crosstab to enable the crosstab properties. Then you
can scroll down through all the rows.
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Date, Country, Category and Quantity sold SECTION COLOR B

VISUALIZATION PROPERTIES b
112012 Australia Mini city 150
Chart Title L4

[#] show Chart Title

Arial w 16
B

Metherlands Jewelry 17.200 Expand Crosstab to See All Rows

Italy Party pants 600

Japan Cardigan

Russia T-Shirts 20,550 . OFF

You can overlay pictograms and shapes on a crosstab if Expand Crosstab to See All Rows is not selected. If
Expand Crosstab to See All Rows is selected, these items cannot be placed on the crosstab.

The amount of data you can retrieve from a data source is customized by your administrator. This may result
in the crosstab displaying fewer rows than are available in original data source.

Stories with crosstabs can be shared. Data is preserved when the story is published, so all of the data retrieved
from the original data source is shared to the new destination. Users with sufficient rights can select Expand
Crosstab to See All Rows in the shared story and see all of the original data.

The data in the shared stories can be refreshed. Note that data size limits in the destination may be different
from the data size limits on SAP Lumira (desktop).

Stories that contain crosstabs can be exported to PDF. If Expand Crosstab to See All Rows is selected, only the
first 100 rows are exported.
Customizing fonts and colors

You can customize formatting such as font, text alignment, and background color. Different types of areas in a
crosstab, for example, row labels, column labels, and data cells, can be formatted separately. Select an area
from the list in the VISUALIZATION PROPERTIES panel, or select the area of the crosstab that you want to
format in the story page. Formatting options appear in the VISUALIZATION PROPERTIES panel.

Setting crosstab area size and configuring totals

Options for crosstab area sizes and subtotals are available when composing and viewing stories. For more
information, see the Analyzing data in crosstabs section of this guide.

Related Information

Analyzing data in crosstabs [page 111]
Pictograms and shapes [page 158]
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7.16 Exporting records

When viewing a visualization, you may want to export the values of the data points shown in the visualization.
Alternatively, you may want to export the records from your dataset that are being aggregated to create those
values.

For example, if your visualization shows sales by country from a dataset that contains all of your sales orders,
you can export those aggregated sales values for each of the countries. You also have the option to export the
individual sales order records behind those data points, which may be useful if there are additional columns of
value in the data that aren't easily accessible from the visualization.

When exporting detailed individual records, you can choose which dimensions and measures will be exported.

Any global filters (filters applied to the entire dataset), page-level filters, and story-level filters are applied
when exporting records from a visualization.

You can export the records to Excel or comma-separated-values (CSV) formats.

1 Note

If there are too many values to export, the exported set of data will be truncated, and the exported file will
include a warning message at the beginning of the file to indicate this. The Excel file format is more complex
than the CSV file format, and therefore the number of cells that can be exported is more limited when using
the Excel format. When exporting a large number of records, the CSV format may be a better output format
if data truncation is occurring.

1 Note

You can set the default export type (aggregated or detailed) by selecting |+ File » Preferences » Charts .

7.16.1 Exporting records for all data points

Context

You can export records for all data points in a visualization, while previewing the visualization in the Compose
room or editing the visualization in the Visualize room.

Procedure

1. Select Export Records by one of these methods:

e
o Inthe Compose room, select the Export Records icon L' at the top-right corner of the visualization.
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o Inthe Compose room, while exploring a visualization (select the Explore 'E’ icon in the upper-right
[~
corner of a visualization), select the Export Records icon .

[~

o Inthe Visualize room, select the Export Records icon

2. Choose whether you want to export the aggregated values or the detailed records.

3. If you're exporting detailed records, select the dimensions and measures that you want to export.

4. Choose whether you want to export the records to a csv (comma-separated values) file or to an Excel

XLSX file.

Select Export, and choose a directory and filename.

7.16.2 Exporting records for selected data points

Context

You can export records for selected data points in a visualization, while previewing the visualization in the
Compose room or editing the visualization in the Visualize room.

Procedure

o s WD

174

Select the data points whose records you'd like to export.

For example, if you're working with a bar chart on a Windows PC, click bars to select them. If you select an
unwanted data point unintentionally, + [c1ick]the data point to deselect it. Or click an empty area
of the visualization to clear your selection.

In the tooltip box, select Export Records.
Choose whether you want to export the aggregated values or the detailed records.
If you're exporting detailed records, select the dimensions and measures that you want to export.

Choose whether you want to export the records to a csv (comma-separated values) file or to an Excel
XLSX file.

Select Export, and choose a directory and filename.

1 Note

When you export running calculations, forecasts, or linear regressions for selected data points, you're
essentially filtering the values so that the resulting aggregates apply only to those data points.
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For example, here is a data set:

Table 42:
Date ’ Profit ‘ Running Calculation - Sum
2015/01/01 100 100
2015/02/01 100 200
2015/03/01 100 300
2015/04/01 100 400
2015/05/01 100 500

If you create a chart for this dataset, add a Sum running calculation, and then select only the bottom
three data points in the chart, the running calculation will be recalculated for those three data points
only. Notice that the results differ from the original results:

Table 43:
Date ’ Profit ‘ Running Calculation - Sum
2015703701 100 100
2015/04/01 100 200
2015/05/01 100 300

7.17 Sharing Stories

Context

You can export the story to a PDF format.

Procedure

1. Start SAP Lumira.

2. Choose Compose room and select the story that you want to export.

3. Choose | File » Export As File 4.

The Export as File dialog box appears.

4. Inthe Export As File dialog box, perform the following:

a. Select PDF as your Format.

PDF is the default format.

b. Under Pages, you can select one of the following options:
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o ALL: Exports all the pages in the document.

o Range: Enter the range of pages that you want to export. The range entered should be in the
following format: <Start Page> - <End Page>.

c. Under Dataset Filters , choose one of the following options:

o Do notdisplay: If no appendix is required.
o Display in appendix: To generate an appendix of the dataset and page filters used in the story.

5. Choose Export.

The PDF file of the story is available for sharing.
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8 Enabling share room using -Dhilo option

If you want to share your Lumira documents using Share room, you can enable the Share room in SAP Lumira.

Prerequisites

You have used the text editor with administrator rights only.

Context

1 Note

In this release, the Share room is deprecated. You can however share datasets, visualizations and stories
from the Prepare room, the Visualize room, and the Compose room respectively.

e For more information on sharing datasets in the Prepare room,see Sharing Datasets [page 75] Sharing
Datasets.

e For more information on sharing visualizations in the Visualize room, see Sharing Visualizations [page
145] Sharing Visualizations.

e For more information on sharing stories in the Compose room, seeSharing Stories [page 175] Sharing
Stories.

If you are an existing SAP Lumira Desktop user, using an earlier versions of SAP Lumira Desktop and want to
retain the Share room in SAP Lumira Desktop, perform the following:

Procedure

—

Navigate to the location where you have installed SAP Lumira Desktop, for example Program Files.

2. Inthis directory, choose |# SAP Lumira » Desktop » SAP Lumira.ini 3

3. Openthe SAP Lumira.ini file and enter the following code snippet:

Sample Code

-Dhilo.shareroom.enabled=true

4. Save and replace the SAP Lumira.ini file.
5. Restart SAP Lumira.
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Results

The Share room is enabled in your SAP Lumira Desktop application.
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9 Application extensions

A standard installation of SAP Lumira lets you acquire data from many different data source types, and
provides a wide variety of visualization types. But by installing extensions, you can have an even broader
choice.

SAP Lumira extensions are similar to the extensions, add-ons, and plug-ins that are available for popular web
browsers. Extensions can add new features or provide enhanced connectivity.

Two kinds of extensions are available for SAP Lumira: data access extensions, and visualization extensions.
Data access extensions let you acquire data from data sources that are not otherwise supported by SAP
Lumira. Visualization extensions let you design your own custom chart types.

Extensions can be either provided by SAP, or created by your own developers or third parties. For example,
your organization may be using a custom database type. Your developers can create an extension that will
allow SAP Lumira users to use your organization's data.

Extensions provided by SAP are available from the SAP Extension Repository. Users install those extensions
from the repository using the Extension Manager. For details on how to create and publish extensions, see the
Data Access Extensions for SAP Lumira Developer Guide and the Visualization Extension Plugin for SAP Web
IDE Guide.

1 Note

Some extensions, for example all data access extensions, require a paid license for SAP Lumira.

9.1 Data access extensions

If you want to acquire data from a data source that SAP Lumira doesn't normally support, you can develop a
data access extension, or use an extension available from SAP.

Any data access extensions you install appear in the list of data source types in the Add new dataset window.

9.1.1 SAP Universe Query Panel extension

The SAP Universe Query Panel extension, provided by SAP, lets you use advanced query capabilities to
acquire data from . unx universes.

Using the query panel lets you acquire a highly specific subset of data, relevant to the analysis you want to
perform. For example, you can include filters and prompts in a query to customize the data returned from the
data source.
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1 Note

The SAP Universe Query Panel extension is available only if you have a Trial or Full license for SAP Lumira.

Related Information

Acquiring data from universes [page 36]
Where to find extensions [page 193]

Installing or uninstalling an extension [page 193]

9.111 Connecting to a universe query panel data source

Procedure

1. Onthe Home page, select Create New Document.
2. Inthe New Dataset window, select SAP Universe Query Panel, and select Next.
3. Inthe SAP Universe Query Panel dialog, enter the following details:
a. Enter the name or IP address of the server that hosts your Central Management Server (CMS).

If you are connecting to a CMS that belongs to a different network domain, make sure the hosts file
located at C: \Windows\System32\drivers\etc has the corresponding host name entry. For
example, x.x.x.x<NameOfMachineHostingCMS>

b. Enter the CMS user name, password, and authentication type.

To use Windows AD authentication to connect to the CMS, append the following two entries in the
SAPLumira.ini file, located at: <LumiraInstallDir>\SAPLumira\Desktop

-Djava.security.auth.login.config=<Path to bscLogin>\bscLogin.conf
-Djava.security.krb5.conf=<Path to kbr5>\krb5.ini

For example:

-Djava.security.auth.login.config=C:\Windows\bscLogin.conf
-Djava.security.krb5.conf=C:\Windows\krb5.ini

c. Select Next.
A list of universes available in the CMS appears.

4. Select a universe and select Next.
The query panel opens, displaying the universe tree, called the business layer.

Related Information

Connecting to a universe data source [page 36]
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Troubleshooting messages about universe data connections [page 37]

9.11.2 Building a query

You can run queries on published universes.

Context

1 Note

For detailed information about querying universes, see the topic “Using the Query Panel” in the Information
Design Tool User Guide, available on the SAP Help Portal http://help.sap.com/.

Procedure

1. Toselect the objects you want to include in the query, drag objects from the business layer (the universe
tree) into the Result Objects pane.

2. For hierarchy result objects, select members to include or exclude in the results.

To open the Member Selector, click the arrow to the right of the hierarchy object name:
3. Tofilter the results of the query, drag objects from the business layer into the Query Filters pane.

If a mandatory filter is defined on an object, the filter is triggered when you add the object to the Result
Objects pane. The mandatory filter is visible in the query script, but not in the Query Filters pane.

Non-mandatory pre-defined filters are listed in the business layer. You can drag these pre-defined filters
into the Query Filters pane to limit the results. The filter is visible in the query script.
You can also build business filters, including filters that use prompts.
4. For relational universes, you can build combined queries. To open the Combined queries pane, click the
@ icon.
fral
5. To set query properties, click the == icon.
6. To see or edit the query script, click View script.

7. To preview the query results, click Refresh in the Data Preview pane.
You can profile the values in the result columns. In the Data Preview pane, click the Advanced Preview icon

L
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To change the layout of hierarchical data, click the Result set display options icon @‘@ and select an option

from the list:
Flat layout Displays repeated values for a level in every row.
Hierarchical layout Displays repeated values once for a level.

8. Torunthe query, click Finish.
The Visualize room opens, and you can start building charts and analyzing the data. If you want to modify a
dataset first, use the Prepare room.

Related Information

Using prompts to filter data [page 182]

9.11.3 Using prompts to filter data

You can use prompts to customize a dataset for your needs.

A prompt is a special type of query filter. It is a dynamic filter that displays a question every time you refresh
the data in a query. You answer prompts by specifying the values you want to view before you refresh the data.
You can specify values by typing them, selecting them from the list of values, or searching the list for the
values you're interested in. The query returns only the values you specified.

1 Note

If you search for values, only values that have been retrieved from the server are searched. As you scroll
down the list of values, more values are retrieved from the server.

Prompts allow multiple users viewing a single document to specify a different sub-set of the database
information and display it in the same report tables and charts. Prompts also reduce the time it takes for the
data to be retrieved from the database.

When you define a prompt query filter, you can either build a new prompt, or use an existing prompt defined as
a parameter in the business layer.

If you define more than one prompt in a query, you can change the order in which prompts are presented.
Change prompt order in the query properties.

1 Note

For detailed information about using prompts, see the topic “Using the Query Panel” in the Information
Design Tool User Guide, available on the SAP Help Portal http://help.sap.com/.
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9.11.4 Limitations of the Query Panel extension

The SAP Universe Query Panel extension has these limitations:

e The SAP Universe Query Panel extension does not support OLAP universes.
e Universe parameter prompting does not support hierarchical prompts.

e Currently, the SAP Universe Query Panel extension does not support multiple flows of SQL. If a query will
result in two separate SQL statements, you will need to modify your query before the Query Panel
extension can execute it.

9.1.2 Download data from SAP Business Warehouse
extension

The “Download data from SAP Business Warehouse” extension, provided by SAP, lets you directly connect to
SAP Business Warehouse (BW) systems using Business Intelligence Consumer Services (BICS) connectivity.
This allows you to download a slice of BW data to Lumira Desktop.

This connectivity allows you to connect to SAP Business Explorer (BEx) queries or InfoProviders. Once the
datais acquired in Lumira Desktop, users can perform data discovery:

® Interact with, manipulate, and experiment with the BW data

e Apply data transformations to the BW data

o Merge BW data with other data sources

e Build visualizations and compose stories

® Share datain a visual manner with other users in your organization

1 Note

The “Download data from SAP Business Warehouse” extension is available only if you have a Trial or Full
license for Lumira Desktop.

Related Information

Where to find extensions [page 193]

Installing or uninstalling an extension [page 193]
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9.1.2.1

Downloading a BW dataset

Learn how to connect to BEx Queries or InfoProviders, select dimensions and measures, and set values for BW
variables (for BEx queries).

Procedure

1. Tocreate a new dataset, select ||» File » New 1.

2. Inthe Add new dataset dialog, select Download from SAP Business Warehouse, and select Next.

3. Fromthe Connect To list, select either a direct connection to Local BW System, or log onto the SAP
BusinessObjects Bl Platform to access the managed OLAP connections to BW.

o Foraconnectionto aLocal BW System:
1

1

Prerequisites:

Before you can connect to an SAP Business Warehouse (BW) system, it needs to be registered
through SAP GUI for Windows on the same computer. It is recommended to test the connectivity
of the registered BW system via SAP Logon before using it in Lumira Desktop. Refer to the SAP
GUI for Windows documentation on the SAP Help Portal at http://help.sap.com to configure a
new system. To download SAP GUI for Windows, go to SAP Service Marketplace .

The list of available BW servers is derived from SAP Logon.

Enter the BW connection details, and select Connect.

Search for and choose a BEx Query, and then select Create.

You can apply a search, based on key words, for your BEx Query, using the Roles or InfoAreas
view.

Enter values for variables of the BEx Query, if any.

Select the dimensions and measures you want to download to your Lumira Desktop dataset.
Select Create.

Note

While acquiring or editing the data from BW dataset to SAP Lumira desktop or while refreshing the
BW dataset in SAP Lumira, server for Bl platform, if you obtain the following error message: Result
set too large (XXXXXX cells). Data retrieval restricted by configuration (Maximum=XXXXXX cells),
then perform the following:

1.

5.

Navigate to the location where you have installed SAP Lumira Desktop. For example, Program
Files.

In this directory, choose |» SAP Lumira ¥ Desktop  SAPLumira.ini 3.

Open the SAPLumira.ini file with administrator rights.

Modify the cell limit by increasing the Maximum value according to your requirements in the
following code snippet:

-DBICS DA RESULT SET LIMIT DEF=500000

-DBICS DA RESULT SET LIMIT MAX=1000000

Ensure that the MAXIMUM value is always greater than the DEFAULT value.

Save the file and restart the application.

o For aconnection to SAP BusinessObjects Bl Platform:
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1. Enter the BI Platform connection details, and select Connect.

2. Select an OLAP connection, and select Next.
You can filter the list of available OLAP connections to BW using the Show Connections drop-down
list. Alternatively, you can apply a search, based on key words, for the specific OLAP connection.

3. Enter values for variables of the BEx Query, if any.
4. Select the dimensions and measures you want to download to your Lumira Desktop dataset.
5. Select Create.

Next Steps

For details on supported BEx query features relevant to SAP BW data acquisition, see this SAP note: 1869560
Pir .

1 Note

In SAP Lumira, each SAP BW variable defines a filter on a dimension of a view.In this release, you can select
dimensions and filter the selected dimensions while acquiring the dataset in SAP BW.

9.1.2.2 Understanding SAP BW data acquisition

Lumira Desktop includes a data access extension that lets you access BEx queries from an SAP BW system.
You can connect to BW queries and acquire a slice of BW data into Lumira Desktop. How the data is being
acquired is an important topic to understand. The following sections describe specific BEx query concepts that
you should be aware of, and known limitations.

The SAP BW data access extension lets you do the following:

Connect to existing BEx queries on a BW 7.x system

Your organization might have invested in and refined your BEx queries over time. While Lumira Desktop is not
positioned for the same use cases (OLAP analysis) as the Analysis client applications, Lumira Desktop is able
to leverage that investment in queries by allowing connection to the BW 7.x systems.

Answer the BEx variables

It is common for BEx queries to have BW variables defined in them. Variables are important not only for
filtering data, but also for guaranteeing that users see the correct data (for example, using key date and exit
variables) and only the data they have permission to see (using authorization variables).
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Select the BW metadata

You can choose the specific dimensions and measures to acquire. The selection of dimensions and measures
is important because it influences the volume of data acquired, and because certain BEx query concepts
directly influence the acquired BW data values (for example, BEx conditions and zero suppression).

Acquire BW data into Lumira Desktop

Although your organization's BEx queries may be highly developed, a query rarely corresponds to 100% of a
user's needs. In many cases, you may need to trim, split, or concatenate fields in preparation for creating a
visualization, or merging with another dataset. You can benefit from the many data preparation features that
Lumira Desktop offers.

Once the BW data is acquired, the data is stored in a local Lumira Desktop file. Interactions and calculations
performed on the BW data do not access the BW OLAP engine. Refreshing of the BW data values in Lumira
Desktop is possible, but the refresh is based upon the dimensions and measures that were selected at data-
acquisition time. For information on key design behaviors and limitations while interacting with local BW data,
see the following sections.

1 Note

In this release, you can choose the date format while acquiring data in BW. However, if you have not chosen
any specified format, then the BW considers default date format.

9.1.2.3 Data acquisition design behaviors and known
limitations

Be aware of the following design behaviors and limitations regarding BW query concepts. For details on
supported BEx query features relevant to SAP BW data acquisition, see this SAP note: 1869560 #r .

Related Information

BW hierarchy support [page 187]
BW filtering support [page 188]
Limitations with BW measures [page 189]

Limitations with mixed currency and units symbols [page 189]
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9.1.2.3.1 BW hierarchy support

BW hierarchies can be acquired into Lumira Desktop. The BW hierarchies are flattened into level-based
dimensions as part of the acquisition process.

The parent-child relationship of BW hierarchies is not supported, but after the hierarchy is acquired as level-
based dimensions, you can use the custom hierarchy feature to build the acquired dimensions into a level-
based hierarchy. The custom hierarchy can then be used for visualizations.

BW time-generated hierarchies

Lumira Desktop supports a time hierarchy concept as a single data type. For any given level of a standard BW
time hierarchy, nodes and leaves may be of mixed data types (for example, nodes are of data type String, while
leaves are of data type Date or Time). Lumira Desktop assigns only the data type String to a hierarchy level
column. You can create visualizations with the acquired hierarchy, but the data points may not be ordered
chronologically as expected, because of the mapping to data type String.

BW hierarchical structures

BW hierarchical structures (both dimension-based and measure-based) cannot be acquired.

BW hierarchies with link nodes

BW hierarchies and the data relating to link nodes can be acquired. However, the context of data values that
represent the link node is not persisted. Be careful when performing aggregations on the BW data, because
double-counting of link nodes cannot be avoided.

See this page for more information about link nodes: http://help.sap.com/saphelp_erp60_sp/
helpdata/en/b3/fa3d3806136268e10000009b38f8cf/content.htm

Changing of hierarchies in Lumira Desktop

Changing of BW hierarchy context within a visualization or story is not supported. This applies to BEx queries
containing the following BW prompting scenarios:

e Hierarchy variables (and hierarchy node variables)
e Key date variables driving a change in context, where entire hierarchies are modelled as time-dependent
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9.12.3.2 BW filtering support

Filtering of BW data is an integral part of the overall BW data acquisition workflow. Lumira Desktop is able to
leverage data filtering defined in the BEx query via the following configurations:

e BEx query filters defined on dimensions
e BW variable prompting

e BEx conditions

® Zero suppression

Lumira Desktop offers limited support of BEx conditions and zero suppression:

BEx conditions

BEx conditions defined along the row are supported at the time of data acquisition. You can select the
dimensions to acquire, and define a specific ordering for the dimensions. The ability to order the dimensions
prior to data acquisition is necessary, because the acquisition of data takes into account the BEx condition rule
defined in the query (for example, Top 3 Product Sales), and how the aggregation will be applied (for example,
Top 3 per Region for all Countries).

1 Note

At the time of selection of dimensions and measures for data acquisition, the row/column structure of the
underlying BW query is not reflected. When you select the dimensions, they are conceptually placed into a
row axis. Because of this behavior, BEx conditions at data acquisition time in Lumira Desktop may not
produce the results you expect, compared to the underlying BW query definition.

Once data is acquired in Lumira Desktop, the concept of BEx conditions is not supported. The calculation of
the data aggregation based on the placement or ordering of dimensions in a Lumira Desktop crosstab or
visualization is performed locally on the acquired data.

BEx conditions defined along the column are not supported at the time of data acquisition. When there are
active BEx conditions along the column defined in the BW query, the conditions are ignored and do not
influence the acquisition of BW data in Lumira Desktop.

For more information on BEx conditions, see this page: https://help.sap.com/saphelp_nw70/helpdata/en/
43/2695d2fd2f0d23e10000000a1553f7/content.htm.

Zero suppression

Zero suppression defined along the rows is supported at the time of data acquisition. Zero suppression
defined along the columns is not supported at the time of data acquisition.

Once data is acquired in Lumira Desktop, the concept of zero suppression is not supported. The calculation of
selected measures in a Lumira Desktop crosstab or visualization is performed locally on the acquired data.

For more information on zero suppression, see this page: http://help.sap.com/saphelp_nw70/
helpdata/en/a4/dd3841d132d92be10000000a1550b0/content.htm.
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9.1.2.3.3 Limitations with BW measures

For BW formula-based measures, the aggregation state in Lumira Desktop is detected as “none” because the
aggregation is not known during data acquisition. Lumira Desktop is unable to determine the aggregation
based on available information from BICS. This can lead to unexpected data results when the acquired
measure is used in Lumira Desktop visualizations, where aggregation is expected.

In this scenario, Lumira Desktop will not automatically determine how to aggregate the BW data. However, you
can manually change the aggregation of a measure in Lumira Desktop, once data is acquired.

9.1.2.3.4 Limitations with mixed currency and units
symbols

Lumira does not support the acquisition of a unit or currency symbol assigned to a measure. A measure can
be configured with a custom symbol, such as a unit or currency, by using the Display Formatting feature in
Lumira. However, Lumira does not support the situation where the display of mixed units and currency
symbols is required.

In addition, Lumira does not support the situation where aggregation of values of different currencies is
required.

9.1.2.3.5 Restrictions and usage patterns

Delegated search for prompts

Delegated search is supported for LOV (list of values) prompts, with the exception of the following prompt
types: Date, Time, hierarchy variable, and hierarchy node variable. When using delegated search on LOV
prompts, these are the restrictions and usage patterns:

e Searchis based on the selected LOV presentation (Text or Key or Text & Key), and is case sensitive.

e \When Text & Key presentation is selected, the delegated search is based on Key first. If no Key values are
returned, then a delegated search is performed by Text.

e Use of search wildcards is supported: *, +. “+" represents a single character.

Selection Option variable support

Manual entry of Key values is possible as part of Selection Option variable support. The use of the “*" wildcard
pattern as part of the Key value is permitted (but not the “+" wildcard).

Examples:

® 3% \works.

e *3 works.

SAP Lumira, desktop edition User Guide
Application extensions PUBLIC 189



e * works.

e Avalue followed by a wild card (for example, 3*) does not work.

Other known limitations:

e [Entering Key values by using pattern matching does not trigger the highlighting of associated selections in
the list of values.

e Pattern matching is supported only in conjunction with the use of the operators = or ! =. For example,
combinations of the operator > and *3 do not work.

9.1.2.4 Support for SAP BW structures

SAP Lumira can connect to and acquire data from SAP BW queries with structures. Lumira supports data
acquisition from two types of structures: dimension structures, and measure structures.

Known data acquisition behaviors

The dimension structure is always added to the metadata explorer result set, and can't be removed.

The hierarchical context is lost when data from a BW structure is acquired, both for dimension-based and
measure-based structures. For example, the result set of the dimension structure is always a pivot, and not a
hierarchy. This is to ensure that the measure values are accurate. Also, the aggregation type for the measure
values is set to “None".

An auto-generated ordinal numeric key (1, 2, 3, and so on) is required as part of the data acquisition step, to
drive the order of the dimension structure. This key will appear as a column in the Prepare room, and should be
associated with the dimension structure so that when the dimension structure is displayed in a visualization,
the datais in the correct order.

9.2 Visualization extensions

If you want to use a custom chart type in SAP Lumira, you can develop a visualization extension, or use an
extension available from SAP.

Any visualization extensions you install appear in the Chart Extensions group in the Chart Builder.
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9.2.1 Tutorial: installing and using the flagbar visualization
extension

A sample visualization extension that uses flags instead of bars to display results.

During installation of SAP Lumira, some visualization extension samples are also installed. The helloworld
extension displays the words “Hello World”, while other extensions rely on data files.

The Flag Bar chart visualization extension shows how you can use images within your chart results. The
tutorial explains how to set up the data to use with the extension.

1. Manually install the flagbar extension [page 191]
Install the flagbar visualization extension example.

2. Create the flagbar CSV data file [page 192]
Create a text data file to use with the flagbar extension.

3. Create a flagbar visualization extension document [page 192]
Use the sample flagbar visualization extension to create an SAP Lumira document.

9.2.11 Manually install the flaghar extension

Install the flagbar visualization extension example.

Procedure

1. Select | File » Extensions 3.
2. From the Extension Manager dialog, select Manual Installation.

3. Browse to the exension sample directory. (<installdir>\SAP Lumira\Desktop\samples

\extensions\charts)
4. Select sap.viz.ext.flagbar.zip and click Open.
5. Close the Extension Manager dialog.
6. Shutdown SAP Lumira.

Task overview: Tutorial: installing and using the flagbar visualization extension [page 191]

Next task: Create the flagbar CSV data file [page 192]
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9.2.12 Create the flagbar CSV data file

Create a text data file to use with the flagbar extension.

Procedure

1. Open a text editor.
2. Paste the following data into the text editor:

Medal Type,Country,Athens (2004),Beijing (2008)
Gold,USA, 35, 36

Silver,USA, 39,38

Bronze,USA, 29, 36

Gold, China, 32,51

Silver,China,17,21

Bronze,China, 14,28

Gold, Russia, 27,23

Silver,Russia, 27,21

Bronze,Russia, 38,29

3. Savethefile as flagbar.csv.

Task overview: Tutorial: installing and using the flagbar visualization extension [page 191]

Previous task: Manually install the flagbar extension [page 191]

Next task: Create a flagbar visualization extension document [page 192]

9.2.1.3 Create a flagbar visualization extension document

Use the sample flagbar visualization extension to create an SAP Lumira document.

Procedure

—

Start SAP Lumira.

Select | File » New 1.

Double-click Text.

Find your £lagbar. csv file and Open it.

Select Create.

In the Chart Builder, select the Flag Bar Chart.
Add the measures: Athens (2004) and Beijing (2008)

N o ook W
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8. Add the dimensions to the appropriate shelves.

Results

Your SAP Lumira document shows a breakdown of medals by country, using images of flags in the chart.

Task overview: Tutorial: installing and using the flagbar visualization extension [page 191]

Previous task: Create the flagbar CSV data file [page 192]

9.3 Where to find extensions

You can get extensions in two ways:
e From the SAP Extension Repository

o Select|p File ¥ Extensions 3. The Extension Manager opens, showing the extensions available from
the SAP Extension Repository, including extensions you've already installed.

© You can also select Get partner extensions to get extensions published by SAP partners.

® Transport units

o If your organization's developers have created an extension, they can make it available to users as a
transport unit, which the users can manually install from a shared network folder. Or if a third party
develops an extension, they can distribute the extension as a transport unit.

o  Whenyou click Manual Installation in the Extension Manager, it opens the file browser. When you open
atransport unit, packaged as a . zip file, it is automatically verified as an SAP Lumira extension,
installed, and then added to the list of installed extensions in the Extension Manager.

9.4 Installing or uninstalling an extension
Procedure

1. Select | File » Extensions 3.

The Extension Manager opens, showing the extensions available from the SAP Extension Repository,
including extensions you've already installed.

2. Toinstall an extension, select Install 9

1 Note

Some extensions are available only if you're using a paid version of the application.
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You can also select Get partner extensions to get extensions published by SAP partners. Or, select Manual
Installation to browse for an extension packaged as a transport unit (saved as a . zip file). Select the . zip
file and select OK.

3. Touninstall an extension, select Uninstall @

4. Restart the application after installing or uninstalling any extensions.

Results

1 Note

If SAP Lumira is uninstalled, extensions are not uninstalled.

9.5 Updating an extension

Some extensions are compatible only with a particular version of SAP Lumira. When you install a new version
of SAP Lumira, your installed extensions should update automatically. But if for any reason the extensions
don't update automatically, you can update them manually from the Extension Manager.

Procedure

1. Select | File » Extensions 3.

The Extension Manager opens, showing the extensions available from the SAP Extension Repository,
including extensions you've already installed.

2. Select Upgrade Q
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10 Managing SAP Lumira

You can optimize your SAP Lumira settings, upgrade the product, send feedback, and so on.

10.1 Optimizing memory usage

You can customize SAP Lumira configuration parameters to optimize memory usage in the SAP Lumira.ini
file, located at \\<InstallDir>\SAP Lumira\Desktop\.

Context

Table 44: Configuration parameters in the SAP Lumira.ini file

Parameter Default Description

value
- 10000 The maximum number of data points permitted in a chart before a message ap-
Dhilo.maxvizdata pears advising you to filter or rank the values to reduce the data points. You can
setsize increase this value to increase the threshold. If you increase the value, also con-

sider increasing the virtual memory allocated to SAP Lumira and the SAP HANA
server-side setting for the maxFetchS1ize property.

-Xmx 1024M The virtual memory allocated to SAP Lumira. If 4 GB is available on the com-
puter, allocate 1024-2048 MB of memory to SAP Lumira. If more system mem-
ory is available, you can increase the available memory for SAP Lumira, ensuring
you keep sufficient memory to run the operating system.

Procedure

1. Browsetothe <InstallDir>\SAP Lumira\Desktop\SAPLumira.ini file.
2. Open thefile in a text editor, and set the required configuration parameters.

3. Restart SAP Lumira to activate the new parameters.
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10.2 Setting application preferences

You can modify the default settings for some SAP Lumira preferences.

Context

Table 45: Application preferences

Preference area Description

General e | anguage: Select the language to use in the SAP Lumira user interface.

e Auto Recovery: Select the Save Auto Recovery information every <n> minutes check
box and enter the time interval at which to automatically create a recovery file of the
current document. (The default time interval is five minutes.)

When the check box is selected and SAP Lumira shuts down unexpectedly, the next
time the application starts, the recovery file is located and a Lumira has found
an auto recovery file for "<DocumentName>" from the last
session. Do you want to open this file? If you select
Discard or close this window, the file will be removed.
message appears.

e Font: Select the font to use in user interface text and messages.

e Default Room: Select the default room to open documents in.

Views Set the preferred view to open when starting SAP Lumira. You can select a default view
for each type of data source.

Charts ® Chart Canvas Layout: Choose whether to position the Chart Builder on the left or
right side of the Visualize room.

® (Chart Style: Select the default colors and visual template for new charts that you
create. The Default Measure Color Palette applies to charts with measure-based
color schemes. The Default Color Palette applies to any other chart that has the
Choose Colors setting available.

e [fxport Records: Choose the default export type. See the Exporting records section
for more information.

e Data Update: By default, Lumira queries for data every time you add a measure or
dimension to a chart, or remove one, even when more measures or dimensions are
needed to define a complete chart. You can change this behavior by clearing the
Update data for incomplete charts check box. Lumira will then query for data only if
the result will be a complete chart. Disabling this option can reduce the time it takes
to build charts when you are working with larger data volumes or more complex on-
line datasets.
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Preference area Description

Datasets ® Online Datasets: Specify how hierarchies and measures are detected when data is
acquired. This is called enriching your dataset.
e Offline Datasets:

o Specify how hierarchies and measures are detected when data is acquired.
This is called enriching your dataset.

o Specify whether to show dataset statistics in the status bar.

o Choose whether to display the Related Visualizations tab in the Manipulation
Tools panel and enable influence analysis. The Related Visualizations tab dis-
plays predefined charts proposed by SAP Lumira, based on the dimensions
and measures available in the Measures and Dimensions panel. Use this tab to
access influence analysis, which suggests visualizations based on how dimen-
sions contribute to a selected measure.

Software Updates ® Check For Updates: Select the frequency for checking for software updates.

Network ®  Proxy:

o If your network doesn't use a proxy server, select No Proxy.

o If your network uses a proxy server and you want to use the system's Internet
proxy settings, select Use System Proxy Settings.

o If your network uses a proxy server and you want to enter the HTTP proxy
server address, port number, user, and password, select Manual Proxy
Configuration, and enter the information.

This information may be necessary for automatic updates and viewing maps
with Esri.

e SAPBI Server: Enter the URL to the SAP BusinessObjects Business Intelligence
platform RESTful web services. Set this URL to open and save documents on the
Business Intelligence (BI) platform repository. The default URLishttp://
<ServerName>:<port>/biprws/, where <ServerName> is the Bl platform
server name or IP address, and <port> is the RESTful web services port, by default
6405.

e Server for teams: Enter the URL to SAP Lumira, server for teams. Use SAP Lumira,
server for teams to save documents and share them with collaborators in deploy-
ment environments without SAP HANA or the Bl platform.

® Give Feedback: Enter the URL to the feedback server. The default URL is https://
analytics-feedback.itc.sap.com/FeedbackOffice/sap/ P

SQL Drivers Select the SQL drivers to install.

Geo Map Service Enter account information for the Esri Geo map data provider. The Esri map is used by
the Geo map chart in the Visualize room.
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Procedure

1. Select | File » Preferences 3, and select a preference area.

2. Choose preferences as needed, and select Done.

Related Information

Acquiring data using Query with SQL [page 38]
Adding or modifying a predefined chart [page 96]

10.2.1 Configuring Geo Maps in Preferences

You can use Esri ArcGIS technology to overlay data on maps with detailed geographic information. You can
use Geo Map, which has multiple layers and different types of data markers.

Using geographic information system (GIS), you can integrate, store, edit, analyze, share and display
geographic information for decision making. ArcGIS is a GIS software program used for working with maps
and geographic information. It is used for creating and using maps, compiling geographic data, analyzing
mapped information, sharing, discovering and managing geographic information in a database.

Esriis aninternational organization supplying Geographic Information System (GIS) software, Web GIS and
geo database management applications. Esriis a suite of ArcGIS products. It compiles a detailed user
basemap information into a common cartographic format called Topographic Basemap.

You need to have an ArcGIS account in order to access Esri maps.

10.2.1.1 Connecting to Esri ArcGIS Server

Context

In SAP Lumira desktop, if you want to use Geo Map, then you need to connect to ESRI ArcGIS, to do so,
perform the following steps:

Procedure

1. Start SAP Lumira.
2. Choosel|p File » Preferences » . 4

The SAP Lumira Preferences dialog box opens.
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3. Choose Geo Map Services.
4. Tologonto Esri ArcGIS server directly, select the Esri ArcGIS Online option and proceed as follows:
o If you want to access the basic features of Esri map, perform the following steps:

1. Select the Default Account (*) option.

2. Choose Done.
You can only access the basic features of ESRI map and cannot customize it according to your
requirements. Therefore, you cannot modify the map, when you choose the Import Esri Custom
Service option in Visualize room.

o If you want to customize the Esri map based on your requirements, perform the following steps:
1. Select the Use this account (*) option.
2. Enter the user name and the password of your Esri ArcGIS server account.

3. Choose Apply.
To customize the Esri map, choose the Import Esri Custom Service in the Visualize room. This
provides you with the option of customizing the Geo map with feature services that are added to
your Esri ArcGIS account.

The proxy setting is set to Use System Proxy Settings by default in Network. If you select No Proxy
however, you cannot use Geo Map, as the Esri map is not loaded to your visualization.

10.2.1.2 Connecting to Esri ArcGIS with On Premise Server

In SAP Lumira Desktop, you have to configure the settings in Preferences before using Geo Maps.

Context

When you connect to Esri ArcGIS server using an On Premise server connection, you can connect to the Esri
ArcGIS server that is locally deployed in your enterprise. To connect to Esri ArcGIS server for On Premise
server connections, perform the following:

Procedure

1. Start SAP Lumira.
2. Choosel|p File » Preferences .

The SAP Lumira Preferences dialog box opens.
Choose Geo Map Services.
To log on to the local Esri ArcGIS server, select the Esri On Premise option.

Enter the User Name, Password and the Portal URL of your local Esri ArcGIS server account.

o o~ W

Choose Done
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1 Note

The feature services that are supported in Esri server connections are also supported in Esri On
Premise server connections.

The default proxy setting in Network is Use System Proxy Settings. If you select the No Proxy option
however, you cannot use Geo Map, as the Esri map is not loaded to your visualization.

10.3 Optimizing display settings for SAP Lumira

Depending on your operating system and display settings, you may need to make adjustments to optimize the
display for SAP Lumira.

To ensure that the edges of fonts and icons appear properly in Lumira, tune your computer's ClearType

settings. On Windows 7, for example, open the Control Panel and select | Display » Adjust ClearType text .
Follow the instructions in the ClearType Text Tuner dialog.

To ensure that the background color appears correctly in Lumira when remotely connecting to a Windows
Server 2008 machine, follow the steps described in this topic to set the maximum color depth for the
connection to 32 bit: https://technet.microsoft.com/en-us/library/cc772048.aspx # . Then, set the color
depth of the remote session to 32 bit when connecting to the machine. In Windows 7, for example, select

| Options # Display 3 in the Remote Desktop Connection dialog, and set Colors to 32 bit.

10.4 Upgrading from SAP Lumira Trial Edition

You can purchase a license for SAP Lumira Desktop Edition to access all of the features for this application.

Context

When you initially download and install SAP Lumira, you have access to the features that are available for the
trial edition. In trial addition, you can access all these features for a period of 30 days. Once this period has
expired, you cannot access these features any more. To continue using Lumira Desktop, you therefore need to
enter a valid license key. You can enter any of the following license keys based on your requirements:

e Personal key

e Trial key

® Permanent key
Some features are available only with a license for SAP Lumira Desktop Edition., These features include
database connections, saving documents to SAP Lumira, server for teams or the Bl platform, or publishing
datasets to SAP HANA.
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1 Note

To obtain the keycode for the personal and trial editions, contact support.lumira@sap.com.

To purchase a permanent Desktop Edition license, follow these steps:

Procedure

1

Select Buy on the Home page.

A window opens where you can register or log on, enter your payment information, and confirm your
purchase of SAP Lumira Desktop Edition.

. Complete the purchase in this window.

The Desktop Edition features are activated by a temporary license. You will receive an e-mail with your
permanent Desktop Edition keycode.

To activate your permanent license, open Lumira and choose | Help » Enter Keycode 3. Copy the
permanent Desktop Edition keycode from the e-mail and press OK.

10.5 Sending feedback about the application to SAP

You can provide feedback to SAP technical consultants directly from SAP Lumira. Your feedback can be sent
via email or from the Send your feedback dialog (when you need to include log details or a snapshot of the
active application window).

You may want to provide feedback for reasons such as:

You are unable to complete a non-urgent task during data preparation or in the charting area.
A message appears and you need non-urgent help to resolve the issue.

You want to suggest a change that could make the application easier to use.

You want to rank the application.

Related Information

Sending a snapshot of the active window with feedback [page 202]
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10.5.1 Sending feedback via email

Procedure

1. Atthe bottom of the Home page, select support.lumira@sap.com.
An email message opens.

2. Enter a subject for the message and a description of the issue or suggestion for improvement, and select
Send.

Results

Your message is sent to support.lumira@sap.com.

10.5.2 Sending a snapshot of the active window with
feedback

You can annotate a snapshot of the active SAP Lumira window and include a log file that shows activity in the
window, before sending the information to SAP technical consultants.

Prerequisites

You have configured mail repository in your local system. For example, MS Outlook, Gmail.

Context

Table 46: Annotation toolbar

Tool Icon Description

Undo Select the button to reverse the last action.
ey

Redo Select the button to repeat the last action.
al
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Tool Icon Description
Pencil Select the button, select an image, and drag the cursor to create a free-form shape
L
L that you can use to encircle or highlight irregular areas of the window.
Square Highlight D Select the button, select an image, and drag to create a square shape that you can
use to highlight an area of the window.
Square Hide % Select the button, select an image, and drag to create a solid square shape.
&
Text T Select the button, enter a comment, and drag the comment to the image.

To retract your feedback for any reason, create an SAP CSS case with "Feedback ID" as the subject.

Procedure

o K~ LN

o

Select the Send your feedback - icon in the lower-right corner of the window that you want to provide
feedback on.

The Send your feedback dialog appears, displaying a snapshot of the active application window, a rating
scale, a Comments box, and an annotation toolbar.

To provide a quick evaluation of SAP Lumira, select a rating star.

To include a description of the issue or a suggestion for improvement, enter text in the Comments box .
To highlight areas of or add text to the snapshot, use the annotation toolbar.

To send the snapshot with your feedback, select the Screenshot check box.

Do not select this check box if you only want to send a comment to SAP technical consultants.

To send a log file that traces activity before the active window opened, select the Log file check box.

Attaching a log file can be useful because it helps SAP technical consultants to reproduce your activity
when examining a problem.

Select Submit.
Your comments and a snapshot and log file (if included) are sent to SAP for evaluation.

Results

A dialog box with Thank You message appears. An email message opens with the following attachments:

1. Subject line contains version of SAP Lumira Desktop.
2. Attachment field contains (if you have attached any, while sending the feedback).

3.

o Snapshot of active application window
o Logfile.
Message body contains
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© Yourrating
o Your comment

Related Information

Setting application preferences [page 196]

10.5.3 Resetting the URL to the feedback server

You may want to reset the URL to the feedback server (for example, if the URL was deleted from the
application preferences).

Procedure

1. Select | File » Preferences » Network 3 to locate the URL of the feedback server.

The URL of the server is specified under Give Feedback on the Network tab of the SAP Lumira Preferences
dialog.

2. Copyhttps://analytics-feedback.itc.sap.com/FeedbackOffice/sap/ and pasteitinthe URL
box under Give Feedback.

3. Select Done.
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11 Lumira functions reference

Overview of the functions that are available.

You can use functions to create formulas for calculated measures or dimensions or for custom calculations.
The following table shows the high-level grouping of the available functions.

Table 47: Categories of functions

Category Description
Aggregate [page 206] Aggregates data (for example, by summing or averaging a
set of values)
Character [page 212] Manipulates character strings
Date and Time [page 219] Returns date or time data
Expression [page 233] Functions that are used in custom calculations.
Miscellaneous [page 245] Functions that do not fit in any other category
Numeric [page 248] Returns numeric data
Operator [page 253] Returns true or false
1 Note

Aggregate functions are implemented in the definition of a measure.

Aggregate functions [page 206]
Functions that can be used for custom calculations on aggregated values.

Character functions [page 212]
Use a character function to manipulate character strings in a formula.

Date and time functions [page 219]
Date and time functions return date or time data.

Expression functions [page 233]
Functions to be used for custom calculations and running calculations.

Miscellaneous functions [page 245]
Miscellaneous functions reference.

Numeric functions [page 248]
Functions that return numeric data.

Operator functions [page 253]
Operator functions include logical functions and other functions that return true or false.
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Related Information

Creating a calculated measure or dimension [page 74]
Using calculations in the Visualize room [page 132]

11.1 Aggregate functions

Functions that can be used for custom calculations on aggregated values.
All functions are case-sensitive:

e Average [page 206]

e Count [page 207]

e CountDistinct [page 208]
e Max [page 209]

® Min [page 210]

e Sum [page 210]

Average

Returns the post aggregated average value of a measure.
Code Syntax
Average (ob7j)
® ob7: User object (column)

Example

Average ({Sales})

returns:
Country Product Sales Avg
DE A 70 74
DE B 90 74
us A 100 74
us B 50 74
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Product

“» Example

Average ({Sales}) For [{Country}]

returns the sum of Sales divided by the count of all the Products displayed in the result set per Country:

Country Product Sales Avg

DE A 70 80

DE B 90 80

us A 100 70

us B 50 70

us C 60 70
Count

Returns the post aggregated count of a measure.

‘=, Code Syntax

Count (obj)

® obj: User object (column)

“» Example

Count (Product)

returns the count of all the Products in the result set:

Country Product Sales Count
DE A 70 5
DE B 90 5
us A 100 5
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Country Product Sales Count
us B 50 5}
us © 60 5
CountDistinct
Returns the post aggregated distinct count of a measure.
‘s, Code Syntax
CountDistinct (obj)
® obj: User object (column)
“» Example
CountDistinct ({Product})
returns the distinct count of all the Products in the result set:
Country Product Sales CountDistinct
DE A 70 3
DE B 90 3
us A 100 3
us B 50 3
us © 60 3
“» Example
CountDistinct ({Product}) For [{Country}]
returns the distinct count of all the Products per Country in the result set:
Country Product Sales CountDistinct
DE A 70 2
DE B 90 2
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Country Product Sales CountDistinct
us A 100 3
us B 50 3
us © 60 3
Max
Returns the post aggregated maximum of a measure.
‘=, Code Syntax
Max (obj)
® ob5: User object (column)
“» Example
Max (Sales)
returns the maximum Sales in the result set:
Country Product Sales Max
DE A 70 100
DE B 90 100
us A 100 100
us B 50 100
us © 60 100
“» Example

Max ({Sales})For [{Country}]

returns the maximum Sales value of Product in each Country:

DE

Product

70

90
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Country Product Sales Max
DE B 90 90
us A 100 100
us B 50 100
us C 60 100
Min
Returns the post aggregated minimum of a measure.
‘=, Code Syntax
Min (ob7)
® ob7: User object (column)
“» Example
Min ({Sales})
returns the minimum Sales value in the result set:
Country Product Sales Min
DE A 70 50
DE B 90 50
us A 100 50
us B 50 50
us C 60 50

Sum

Returns the post aggregated sum of a measure.

‘s, Code Syntax

Sum (obj)
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® obj: User object (column)

“» Example

Sum ({Sales})

returns:

Country Product Sales Sum
DE A 70 370
DE B 90 370
us A 100 370
us B 50 370
us C 60 370

“» Example
Sum({Sales}) ForAllExcept [{Product}]

returns the sum of Sales for each Country:

Country Product Sales Sum
DE A 70 160
DE B 90 160
us A 100 210
us B 50 210
us C 60 210

Parent topic: Lumira functions reference [page 205]

Related Information

Character functions [page 212]
Date and time functions [page 219]
Expression functions [page 233]

Miscellaneous functions [page 245]

Numeric functions [page 248]
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Operator functions [page 253]

11.2 Character functions

Use a character function to manipulate character strings in a formula.

The following character (string) functions can be used for calculations (all functions are case-sensitive):

Concatenate [page 212]
ExceptFirstWord [page 213]
ExceptLastWord [page 213]
FirstWord [page 213]
LastWord [page 214]
Length [page 214]
LowerCase [page 215]

Lpad [page 215]

Replace [page 215]

Rpad [page 216]

SubString (length) [page 216]
SubString [page 217]

Trim [page 217]

TrimLeft [page 218]
TrimRight [page 218]
UpperCase [page 219]

Concatenate

Concatenates two strings into a single string.

The operator + can also concatenate strings.

Code Syntax
Concatenate (strl, str2)
strl:Firststring

str2: Second string

Example

Concatenate ("Mxr", "Brown")

returns "MrBrown"

212
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ExceptFirstWord

Returns a copy of a string, with the first word removed.
Code Syntax

ExceptFirstWord(str, sep)

® str:nputstring
® sep: Aseparator

Example

ExceptFirstWord("Level 3, Standford Street", "

returns "Standford Street"

ExceptLastWord

Returns a copy of a string, with the last word removed.
Code Syntax

ExceptLastWord(str, sep)

® str:Inputstring

® sep: Aseparator

Example

ExceptLastWord ("james.brown@company.com",

returns "james.brown"

FirstWord

Returns the first word of a string.

Code Syntax

FirstWord(str, sep)
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® str:lnputstring
® sep: Aseparator

Example
FirstWord("Senior Developer", " ")

returns "Senior"

LastWord

Returns the last word of a string.
Code Syntax

LastWord(str, sep)

® str:Inputstring

® sep: Aseparator

Example
LastWord ("Red/Purple", "/")

returns "Purple™

Length

Returns the length of a string.
Code Syntax

Length (str)

® str:Inputstring

Example
Length ("How long")

returns 8
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LowerCase

Returns a copy of a string, with all characters converted to lowercase.
Code Syntax
LowerCase (str)
® str:lnputstring

Example
LowerCase ("GOOD JOB")

returns "good job"

Lpad

Returns a copy of a string, padded with leading characters to the specified total length.
Code Syntax

Lpad(str, length, pad)

® str:Inputstring
® length: Expected length
® pad: Character sequence to add

Example
Lpad ("Incomplete field", 20, "#")

returns "####Incomplete field"

Replace

Returns a string, with all occurrences of a specified string replaced with another specified string.

Code Syntax

Replace (str, target, replacement)
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® str:lnputstring
® target: String to be replaced

® replacement: String value to insert

Example
Replace ("hyperthermia", "ert", "ot")

returns "hypothermia"

Rpad

Returns a copy of a string, padded with trailing characters to the specified total length.

Code Syntax

Rpad(str, length, pad)

® str:Inputstring
® length: Expected length

® pad: Character sequence to add

Example
Rpad ("Incomplete field", 20, "#")

returns "Incomplete field####"

SubString (length)

Returns a substring (of a specific length) of a string.

Code Syntax

SubString(str, start, length)

® str: String from which a substring is computed
® start: Start position in the input substring
® length: Length of the substring to return

Example

SubString ("Wong", 2, 2)
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returns "on"

SubString

Returns a substring of a string.

Code Syntax

SubString (str, start)

e str: String from which a substring is computed
® start: Start position in the input substring

Example

For example:
SubString ("Wong", 3)

returns "ng"

Trim

Returns a copy of the string, with the leading and trailing repetitions of a character removed. This function is

case-sensitive.

Code Syntax

Trim(str, toTrim)

® str:nputstring
e toTrim: Character to be removed

Example
Trim ("Aurora”™, "a")
returns "Auror"

Table 48: Example of the Trim(str, toTrim) function: Trim ({Name},"a")

Trimmed string

Auror Auror
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Name Trimmed string

auror uror

aurora uror
TrimLeft

Returns a copy of the string, with the leading occurrence of a character removed. This function is case-
sensitive.

Code Syntax

TrimLeft (str, toTrim)

® str:Inputstring

e toTrim: Character to remove

Example
TrimLeft ("Above", "A")

returns "bove"

TrimRight

Returns a copy of a string, with trailing repetitions of a character removed. This function is case-sensitive.

Code Syntax

TrimRight (str, toTrim)

® str:Inputstring
® toTrim: Character to be removed

Example
TrimRight ("Laura", "a")

returns "Laur"
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UpperCase

Returns a copy of a string, with all characters converted to uppercase.
Code Syntax

UpperCase (str)

® str:Inputstring

Example
UpperCase ("Little Boy")

returns "LITTLE BOY"

Parent topic: Lumira functions reference [page 205]

Related Information

Aggregate functions [page 206]
Date and time functions [page 219]
Expression functions [page 233]
Miscellaneous functions [page 245]
Numeric functions [page 248]
Operator functions [page 253]

11.3 Date and time functions

Date and time functions return date or time data.

The following Date and Time functions can be used for calculations (all functions are case-sensitive). Note that

you may need to convert the format of your source data in the application:

e AddDayToDate [page 220]

e AddMonthToDate [page 221]
e AddTime [page 221]

e AddWeekToDate [page 221]
e AddYearToDate [page 222]
® (CurrentDate [page 222]

e CurrentDateTime [page 223]
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CurrentTime [page 223]

DateDiffInDays [page 223]
DateDifflInMonths [page 224]

Day [page 224]
DayOfWeek [page 225]
DayOfYear [page 225]
Hour [page 225]

LastDayOfMonth [page 226]
LastDayOfWeek [page 226]

MakeDate [page 226]

MakeDateTime [page 227]

MakeTime [page 227]
Minute [page 228]
Month [page 228]
Quarter [page 229]
Second [page 229]
TimeDiff [page 229]
ToDate [page 230]
ToDateTime [page 230]
ToTime [page 231]
Week [page 232]
Year [page 232]

AddDayToDate

Returns the date produced by adding a specified number of days (periods) to a specified date (date).

returns 2015-01-22 11:59:45 PM

220

Code Syntax

AddDayToDate (date, periods)

date: A Date or Datetime object
periods: A number of days

Example

AddDayToDate (ToDateTime (“2015-01-20 23:59:45",

PUBLIC

“yyyy-mm-dd hh:mi:ss”), 2)
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AddMonthToDate

Returns a date that is produced by adding a specified number of month(s) to a specified date.

Code Syntax

AddMonthToDate (#date#,periods)

® idate#: Original date
® periods: Number of periods to add

Example
AddMonthToDate (#2012-01-014#,1)

returns 2012-02-01

AddTime

Returns the time produced by adding a specified amount of time (numberofunits) to a specified time
(datetime), in the specified format (format).

Code Syntax
AddTime (datetime, numberOfUnits, format)
® datetime: A Time or Datetime object
® numberOfUnits: A number of time units. The time unit type is specified by the format.
® format:
© hh: hours

© mi:minutes

o ss:seconds

Example
AddTime (ToDateTime ("2015-01-20 23:59:45", "yyyy-mm-dd hh:mi:ss"),1,“hh")

returns 2015-01-21 12:59:45 AM

AddWeekToDate

Returns a date that is produced by adding a specified number of week(s) to a specified date.
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Code Syntax

AddWeekToDate (#date#, periods)

® #date#: Original date

® periods: Number of periods to add

Example
AddWeekToDate (#2012-01-01+#,1)

returns 2012-01-08

AddYearToDate

Returns a date that is produced by adding a specified number of year(s) to a specified date. Use negative
numbers to remove a year.

Code Syntax

AddYearToDate (#date#, periods)

® idate#: Original date

® periods: Number of periods to add

Example
AddYearToDate (#2012-01-01#,1)

returns 2013-01-01

CurrentDate

Returns the current date as a Date object.

Code Syntax

CurrentDate ()

Example

CurrentDate ()
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returns the current date: 2015-01-01

CurrentDateTime

Returns the current Datetime (combined date and time).

Code Syntax

CurrentDateTime ()

Example
CurrentDateTime ()

returns the current datetime: 2011-06-12 8:39:45 PM

CurrentTime

Returns the current time as a Time object.

Code Syntax

CurrentTime ()

Example
CurrentTime ()

returns the current time: 8:39:45 PM

DateDiffInDays

Returns the number of days between two dates.

Code Syntax

DateDiffInDays (#start#, #end#)

e i#start#: Start date of the interval
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e #end#: End date of the interval

Example
DateDiffInDays (#2012-03-234#,#2012-01-304#)

returns -53

DateDiffInMonths

Returns the number of months between two specified dates.

Code Syntax

DateDiffInMonths (#start#, #end#)

e i#start#: Start date of the interval
e i#end#: End date of the interval

Example
DateDiffInMonths (#2013-02-01#, #2014-01-01#)

returns 11

Day

Returns the day of the month as a number from 1 to 31.

Code Syntax

Day (#date#)

e i#date#: Adate

Example
Day (#2012-03-23#)

returns 23
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DayOfWeek

Returns the day of the week as a number from 1 (Sunday) to 7 (Saturday).

Code Syntax

DayOfWeek (#date#)

e #date#: Adate

Example
DayOfWeek (#2012-03-23#)

returns 6

DayOfYear

Returns the day of the year as a number.

Code Syntax

DayOfYear (#date#)

® i#date#: Adate

Example
DayOfYear (#2012-03-23#)

returns 83

Hour

For a specified time (time), returns the hour.

Code Syntax

Hour (time)

e time: A Time or Datetime object
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Example
Hour (ToTime ("20:39:45"), "hh:mi:ss"))

returns 20

LastDayOfMonth

Returns the date produced by computing the last day of the month of a specified date.
Code Syntax
LastDayOfMonth (#date#)
® i#date#: Adate

Example
LastDayOfMonth (#2012-03-23#)

returns the date 2012-03-31

LastDayOfWeek

Returns the date produced by computing the last day of the week of a specified date.
Code Syntax
LastDayOfWeek (#date#)
® i#datet#: Adate

Example
LastDayOfWeek (#2012-03-234#)

returns the date 2012-03-24

MakeDate

Returns a date that is built from a specified year, month, and day.
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Code Syntax

MakeDate (year,month,day)

e vyear: Number that represents a year (0001-9999)
e month: Number that represents a month (1-12)

® day: Number that represents a day of the month (1-31)

Example
MakeDate (2011,6,12)

returns the date 2011-06-12

MakeDateTime

Returns the Datetime (combined date and time) that corresponds to the specified date and time.

Code Syntax

MakeDateTime (date, time)

e date: A Date object
e time:ATime object

Example

® date: A Date object
e time: A Time object

MakeDateTime (MakeDate (2011,6,12), MakeTime (20,39,45))

returns 2011-06-12 8:39:45 PM

MakeTime

Returns the time that corresponds to the specified hours, minutes, and seconds.

Code Syntax

MakeTime (hour,minute, second)
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e hour: Number that represents the hour (0-23)
® minute: Number that represents the minute (0-59)
® second: Number that represents the second (0-59)

Example
MakeTime (20,39, 45)

returns 8:39:45 PM

Minute

For a specified time (time), returns the minute.
Code Syntax
Minute (time)
e time: A Time or Datetime object

Example
Minute (ToTime ("20:39:45"), "hh:mi:ss"))

returns 39

Month

Returns the month of the year as a number from 1 to 12.
Code Syntax
Month (#date#)
® i#date#: Adate

Example
Month (#2012-03-234)

returns 3
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Quarter

Returns a number that represents the quarter of a specified date.
Code Syntax
Quarter (#date#)
® idate#: Adate

Example
Quarter (#2012-03-23#)

returns 1

Second

For a specified time (time), returns the seconds.
Code Syntax
Second (time)
e time: A Time or Datetime object

Example
Second (ToTime ("20:39:45"), "hh:mi:ss"))

returns 45

TimeDiff

Returns the amount of time between a specified start time (start) and a specified end time (end), in the
specified format (format).

Code Syntax

TimeDiff (start,end, format)

® start andend: Time, Date, or Datetime objects
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The format includes:

® hh:hours
® mi:minutes
® ss:seconds

Example

TimeDiff (MakeDateTime (MakeDate (2015,1,14), MakeTime (1,23,45)),
MakeDateTime (MakeDate (2015,1,15), MakeTime (6,40,58)), “ss”)

returns 105433

ToDate

Converts an input string to a date in a specified format, when the dates in a column of an original data source
are in string format.

Code Syntax

ToDate (string, format)

® string:Input string to convert

e format: Date format

The date format is a combination of the following reserved tokens, separated by delimiters:

® dordd: Day of month (1-31)

e MorMM: Month of year (1-12)

e vy oryy: Abbreviated year without century (00-99)

e yyyy: Year with century (1956, 2012, 2014, and so on)

All other characters are considered delimiters.

Example
ToDate (Obj, 'yyyy/dd/MM'")

converts a string in the format yyyy/dd/MM to a date

ToDateTime

Converts a specified input string (datetime) in the specified format (format) to a Datetime (combined date and
time).
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Code Syntax

ToDateTime (datetime, format)

® datetime: Input string to convert

® format: Datetime format
The datetime format is <yyyy>-<mm>-<dd> <hh>:<mi>:<ss>.<ff>where:

e yyyyoryyyy:year (0001-9999)

e mmor MM: month (1-12)

® ddor DD: day (1-31)

® hh or #HH: hours (0-23)

® mi or MI: minutes (0-59)

® ssorss:seconds (0-59)

e fforFF: fractional seconds. Include “ff” only if the input string contains fractional seconds. If fewer than 7

decimal places are provided, the value will be padded with zeros. If more than 7 decimal places are
provided, the value will be truncated to 7 decimal places.

All other characters are considered delimiters.

= Tip
The date elements can be in any order.

For example, instead of <yyyy>-<mm>-<dd>, you could use <mm>-<dd>-<yyyy> Or <dd>-<mm>-<yyyy>.

Example
ToDateTime (“2011-06-12 20:39:45.123”, “yyyy-mm-dd hh:mi:ss.ff”)

returns 2011-06-12 8:39:45.1230000 PM

ToTime

Converts a specified input string (time) in the specified format (format) to a Time object.

Code Syntax

ToTime (time, format)

e time:Inputstringto convert

e format: Time format

The time format is a combination of the following reserved tokens, separated by delimiters:

® hh or HH: hours (0-23)
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® mi or MI: minutes (0-59)
® ssorss:seconds (0-59)

All other characters are considered delimiters.

Example
ToTime (“20:39:45”, “hh:mi:ss”)

returns 8:39:45 PM

Week

Returns a number that represents the week of a specified date.

Code Syntax
Week (#date#)
® #date#: Adate

Example
Week (#2012-03-234#)

returns 12

Year

Returns the year of a specified date.
Code Syntax
Year (#date#)
® i#date#: Adate

Example
Year (#2012-03-23#)

returns 2012
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Parent topic: Lumira functions reference [page 205]

Related Information

Aggregate functions [page 206]
Character functions [page 212]
Expression functions [page 233]
Miscellaneous functions [page 245]
Numeric functions [page 248]
Operator functions [page 253]

11.4 Expression functions

Functions to be used for custom calculations and running calculations.

The following functions can be used for custom calculations on aggregated values (all functions are case-

sensitive):

® For [page 234]
® ForAllExcept [page 234]

e CumulativeDistribution [page 234]

e DenseRank [page 235]
® First[page 236]

® Index [page 236]

e Key [page 237]

e |ast[page 237]

e Median [page 238]

® MovingAverage [page 238]

e MovingSum [page 239]
e Next[page 239]

e NthValue [page 240]

® PercentRank [page 240]
® Previous [page 241]

® Rank [page 241]

® RunningAverage [page 241]
e RunningCount [page 242]

® RunningMax [page 242]
® RunningMin [page 243]

® RunningSum [page 243]
e Value [page 244]

® Variance [page 244]
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For

Returns the context for a calculation.

Code Syntax

<calculation> For <context>

Example
RunningSum ({Sales}) For [{Country}, {Product}]

returns the running sum of Sales and resets it at Country and Product level.

ForAllExcept

Returns everything else in the dimensions as the context for a calculation.

Code Syntax

<calculation> ForAllExcept <context>

Example
Previous ({Sales}) ForAllExcept [{Country}, {Product}]

returns the previous value of Sales, resetting at all dimensions other than Country and Product.

CumulativeDistribution

Returns the cumulative distribution of a measure object (obj). The parameter (bool) is used to set the relative
rank order. (true) is ascending order and (false) is descending order.

Code Syntax

CumulativeDistribution (obj, bool)

® obj: User object (column)
® bool:ABoolean
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“» Example
CumulativeDistribution ({Sales}, false)

returns the relative rank of the current Sales value: (number of rows preceding or peer with the current
Sales value divided by the total number of rows).

Year Product Sales Cumulative Distribution
2010 B 160 25
2010 A 110 50
2011 B 10 100
2011 A 10 100
DenseRank

Returns the density rank of a measure. The second parameter is a Boolean value used to set the dense rank
order: true ranks the number from high to low and false ranks the number from low to high.

‘=, Code Syntax

DenseRank (obj, bool)

® obj: User object (column)

® bool:ABoolean

“» Example
DenseRank ({Sales}, true)

returns Sales in a ranked manner (without gaps).

Country Product Sales Dense Rank
DE A 70 g
DE B 90 2
us A 100 1
us B 50 5
us C 60 4
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First

Returns the first value of a measure.

‘s, Code Syntax

First (ob7j)

® obj: User object (column)

“» Example

First (Sales)

returns the first value of Sales in the result set:

Year Quarter Sales Last
2014 Q1 500 500
2014 Q2 0 500
2015 Q1 400 500
2015 Q2 700 500
“» Example

First (Sales) For [{Year}]

returns the first value of Sales in the result set for each Year:

Year Quarter Sales Last
2014 Q1 500 500
2014 Q2 0 500
2015 Q1 400 400
2015 Q2 700 400

Index

Returns the row number of the current row in the result set.
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Code Syntax

Index ()

Key

Returns the key value of a dimension member.
Code Syntax

Key (ob7j)

® ob7: User object (column)

Example
Key (Month)

returns the key value of the Month level in a time hierarchy.

Year_lvi Month_|vl Key

2010 1 [2010].[1]

2010 2 [2010].[2]

2011 1 [2011].[1]

2011 2 [2011].[2]
Last

Returns the last value of a measure.
Code Syntax
Last (ob7j)
® obj: User object (column)

Example

Last (Sales)
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returns the last value of Sales in the result set:

Year Quarter Sales Last
2014 Q1 500 700
2014 Q2 0 700
2015 Q1 400 700
2015 Q2 700 700
Median
Returns the median of a measure
‘=, Code Syntax
Median (obj)
® obj: User object (column)
“» Example
Median (ob7j)
returns the median of Sales in the result set:
Country Year Sales Median
CA 2013 100 60
us 2014 50 60
us 2014 60 60
MovingAverage

The moving average returns the sum of the previous n values and the current value divided by n+1.

‘=, Code Syntax

MovingAverage (obj,
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® obj: User object (column)

® int:aninteger; the first integer sets the number of values before the current value.

® int:aninteger; the second integer sets the number of values after the current value.

® bool: ABoolean; true includes the current value, false excludes the current value.

Example

MovingAverage ([Sales], 1,0, true)

For [Country])

The moving average returns the sum of the previous Sales value and the current value divided by 2. The For

operator is used to reset the moving average at the Country level.

Country Product Sales Moving Avg

DE A 70 70

DE B 90 80

us A 100 100

us B 50 75

us C 60 55
MovingSum

Returns the moving sum of a measure.

Code Syntax

MovingSum (obj, int,

int, bool)

® ob5: User object (column)

® int:aninteger; the first integer sets the number of values before the current value.

® int:aninteger; the second integer sets the number of values after the current value.

® bool: ABoolean; true includes the current value, false excludes the current value.

Next

Returns the next value of a measure.

Code Syntax

Next (obj, int)
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® obj: User object (column)

® int:aninteger

NthValue

Returns the nth value of a measure.

Code Syntax

NthValue (obj, int)

® obj: User object (column)
® int:aninteger
Example
NthValue ({Sales}, 3)

returns the Sales value at the 3rd row of the result set (counting from 1); returns null if there is no such row.

Year Product Sales NthValue

2010 B 160 10

2010 A 110 10

2011 B 10 10

2011 A 10 10
PercentRank

Returns the percent rank of a measure.

Code Syntax

PercentRank (obj, bool)

® obj: User object (column)
® bool: ABoolean; true is ascending order, false is descenting order.
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Previous

Returns the previous value of a measure.

Code Syntax

Previous (obj, int)

® ob7: User object (column)

® int:aninteger

Rank

Returns the rank value of a measure.

Code Syntax

Rank (obj, bool)

® obj: User object (column)

® bool: ABoolean; true ranks from high to low, and false ranks from low to high.

RunningAverage

Returns the running average of a measure. The parameter true excludes empty sales values.

Code Syntax

RunningAverage ([Sales], true)

Example

Returns running average of Sales and resets it at the Country level.

RunningAverage ([Sales], true)

for [Country])

for [Country])

Country Year Sales R Avg
DE 2013 70 70
DE 2014 90 80
us 2013 100 100
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Country Year Sales R Avg
us 2014 50 75
us 2015 60 70
RunningCount
Returns the running count of a measure.
‘=, Code Syntax
RunningCount ([Sales], true)
“» Example
Returns running count of Sales and resets it at the Country level.
RunningCount ([Sales] for [Country])
Country Year Sales R Count
DE 2013 70 1
DE 2014 90 2
us 2013 100 1
us 2014 50 2
us 2015 50 3
RunningMax

Returns the running maximum of a measure.

‘=, Code Syntax

RunningMax ([Sales])

“» Example

Returns running maximum of Sales and resets it at the Country level.
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RunningMax ([Sales] for [Country])

Country Year Sales R Max
DE 2013 70 70
DE 2014 90 90
us 2013 100 100
us 2014 50 100
RunningMin
Returns the running minimum of a measure.
‘=, Code Syntax
RunningMin ([Sales])
“» Example
Returns running minimum of Sales and resets it at the Country level.
RunningMin ([Sales] for [Country])
Country Year Sales R Min
DE 2013 70 70
DE 2014 90 70
us 2013 100 100
us 2014 50 50
RunningSum

Returns the running sum of a measure.

‘s, Code Syntax

RunningSum([Sales])
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Example

Returns running sum of Sales and resets it at the Country level.

RunningSum([Sales] for [Country])
Country Year Sales R Sum
CA 2014 100 100
us 2013 100 100
us 2014 50 150
Value

Returns the value of a dimension member.

Code Syntax

Value (ob7j)

® obj: User object (column)

Variance

Returns the variance value of a member.

Code Syntax

Variance (obj)

® ob7: User object (column)

Parent topic: Lumira functions reference [page 205]

Related Information

Aggregate functions [page 206]
Character functions [page 212]
Date and time functions [page 219]
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Miscellaneous functions [page 245]
Numeric functions [page 248]
Operator functions [page 253]

11.5 Miscellaneous functions

Miscellaneous functions reference.

The following miscellaneous functions can be used for calculations (all functions are case-sensitive):

e (Contain[page 245]

e GroupValues [page 245]

e ifthen else [page 246]

e |sNotNull [page 246]

e [sNull [page 247]

e ToNumber [page 247]

e ToText[page 247] number

e ToText[page 247] parameter

Contain

Returns occurrences of a string within another string. The search is not case-sensitive.
Code Syntax

Contain (whereStr, whatStr)

® yhereStr: String in which a search is conducted
e ywhatStr: Substring that is the object of the search

Example
Contain ("Cats are grey", "aRe")

returns true

GroupValues

Groups a list of values.
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Code Syntax

GroupValues (column, ListOfValues, newValue)

® column: User object to apply the grouping to
® TListOfValues: Listof values to be grouped
® newValue: Value that will replace the grouped values

Example
GroupValues (CountryColumn, ["USA", "India", "France"], "My Countries")

returns "My Countries" whenthe CountryColumn column contains "USA", "India", or "France"

If Then Else

Chooses between two alternatives, based on a Boolean condition. The second alternative is optional and
evaluates to null when missing.

Code Syntax

if<cond> then <altl> else <alt2>

® cond: Boolean condition to test
e a1tl:Alternativel
® a1t2:Alternative 2

IsNotNull

Returns a Boolean value that indicates whether a supplied field does not contain a null value. When a field
contains a null value, the function returns false. For all other values, the function returns true.

Code Syntax

IsNotNull (obj)

® obj: User object (column)
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IsNull

Returns a Boolean value that indicates whether the supplied field contains a null value. When a field contains a
null value, the function returns true. For all other values, the function returns false.

Code Syntax

IsNull (ob7j)

® obj: User object (column)

ToNumber

Converts any type of parameter to a numeric value. Numbers are truncated to zero decimal places.
Code Syntax

ToNumber (param)

® param: Parameter to convert

ToText (number)

Converts a specified number to a string. The number is truncated to the specified number of decimal places.
Code Syntax

ToText (num, digits)

e num: A number

e digits: Number of decimal places to use. This parameter is optional, and its default value is O.

Example
ToText (12.1451, 2)

returns 12.14

ToText (parameter)

Converts a parameter to a string. All parameters are valid, and numbers are truncated to zero decimal places.
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Code Syntax

ToText (param)
® param: Parameter to convert

Parent topic: Lumira functions reference [page 205]

Related Information

Aggregate functions [page 206]
Character functions [page 212]
Date and time functions [page 219]
Expression functions [page 233]
Numeric functions [page 248]
Operator functions [page 253]

11.6 Numeric functions

Functions that return numeric data.

The following functions can be used for custom calculations on aggregated values (all functions are case-
sensitive):

® Abs[page 248]

e Ceil [page 249]

e Floor [page 249]

® |og[page 250]

e [ o0glO [page 250]

e Mod [page 250]

e Power [page 251]

® Round [page 251]

e Sign [page 252]

e Truncate [page 252]

Abs

Returns the absolute value of a number
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Code Syntax
Abs (num)
® num: A number

Example
Abs (-11)

returns 11

Ceil

Returns the smallest integer that is greater than or equal to a specified number.
Code Syntax
Ceil (num)
® num: A number

Example
Ceil (14.2)

returns 15

Floor

Returns the largest integer that is not greater than a specified number.
Code Syntax

Floor (num)

® num: A number

Example
Floor (14.8)

returns 14

SAP Lumira, desktop edition User Guide
Lumira functions reference PUBLIC 249



Log

Returns the natural logarithm of a specified number.
Code Syntax
Log (num)
® num: A number

Example
Log (100)

returns 4.605

LoglO

Returns the base 10 logarithm of a specified number.
Code Syntax
LoglO0 (num)
® num: A number

Example
Log10 (100)

returns 2

Mod

Returns the remainder of the division of a number by another number.
Code Syntax

Mod (num, divisor)

e num: A number

® divisor: Thedivisor
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Example
Mod (15, 2)

returns 1

Power

Raises a number to a power.
Code Syntax

Power (num, exponent)

® num: A number

® cxponent: The exponent

The operator ~ (caret) can be used instead of this function.

Example
Power (2, 3)

returns 8

Round

Returns a numeric value, rounded to a specified number of decimal places.

Code Syntax

Round (num, digits)

e num: A number

® digits: The number of decimal places to round off to

Example
Round (14.81, 1)

returns 14.8
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Sign

Returns -1 if a specified number is negative, O if the specified number is zero, or +1if the specified number is

positive.
Code Syntax
Sign (num)
® num: A number

Example
Sign (-2)

returns -1

Truncate

Returns a numeric value, truncated at a specified number of decimal places.

Code Syntax

Truncate (num, digits)

® num: A number

® digits: Number of decimal places to truncate

Example
Truncate (12.281, 1)

returns 12.200

Parent topic: Lumira functions reference [page 205]

Related Information

Aggregate functions [page 206]
Character functions [page 212]
Date and time functions [page 219]
Expression functions [page 233]
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Miscellaneous functions [page 245]
Operator functions [page 253]

11.7 Operator functions

Operator functions include logical functions and other functions that return true or false.

The following functions can be used for custom calculations on aggregated values (all functions are case-
sensitive):

® And operator [page 253]
e Or operator [page 253]
e |ike pattern[page 254]
® |[nList[page 254]

e Not operator [page 255]

And operator

Returns the logical conjunction of its Boolean inputs. This function returns false: true and false.

Code Syntax

<left> and <right>

e left:Leftoperand
® right:Right operand

Or operator

Returns the logical disjunction of its Boolean inputs. This function returns true: true or false.

Code Syntax

<left> or <right>

® left:Leftoperand
® right:Right operand
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Like pattern

Determines whether a character string matches a specified pattern. The search is not case-sensitive.

Code Syntax

<matchExpr> like <pattern>

® matchExpr: The string expression to search

® pattern: The pattern string constant to search for

The pattern can include regular characters and the following special characters:

e " "matches asingle character
e "3" matches zero to many characters

Before you can use a special character as a regular character, you must escape it, using a backslash ("\").

1 Note
v, man o and "] " are reserved for future use.
Example
"Hiking is fun" like "H% is un"

returns true

In List

Use to determine whether a first input matches a value in a second input list.

Code Syntax

<testExpr> in <candidateList>

® testExpr: Expressionto be tested

® candidatelList: List of match candidates

Example
3 in [2, 4, 6]

returns false
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Not operator

Use to negate a Boolean input.

Code Syntax

not<bool>

® bool:ABoolean

Example
not false

returns true

Parent topic: Lumira functions reference [page 205]

Related Information

Aggregate functions [page 206]
Character functions [page 212]
Date and time functions [page 219]
Expression functions [page 233]
Miscellaneous functions [page 245]

Numeric functions [page 248]
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12 Documentation resources for SAP Lumira

These resources can help you get the most out of the data acquisition, enrichment, visualization, and
document sharing features in the application.

Table 49:

For this information

Immediate help with SAP Lumira and in-
formation about a feature or workflow

See

SAP Lumira Help is available in the software. To open it, select the help ?icon

in any SAP Lumira dialog, or select | 3 Help > Help 3

Complete documentation about using
SAP Lumira, in English, on the Internet

SAP Lumira Help Portal page

Complete documentation for using SAP
Lumira in languages other than English,
on the Internet

All Products Help Portal page

Select a language, select Lumira, and select the version required.

Latest database and software support for
SAP Lumira

SAP Product Availability Matrix
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13 Glossary

This glossary defines terms used in SAP Lumira.

chart

Chart Builder (Visualize
room)

Chart Canvas (Visualize
room)

comparison

Comparison mode

Compose room

Data Access Extension

data source

dataset

dimension

document

Edge Server

enrichment

Extension Manager

facet

Facets view (Visualize
room)

SAP Lumira, desktop edition User Guide
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A display of information in a graphical or visual manner.

The panel used to change the chart type and customize the chart.

The area used to create, modify, or explore a visualization.

A means to compare the differences between values or the categorical divisions of
measures using a variety of chart types.

The view that displays each data point in isolation used to compare individual
values. Each data point starts from zero on an absolute scale. For example, a story
containing sports team data can compare individual players by their points and
assists.

The page used to create and explore stories.

A plugin module created by SAP or other developers that allows users to access an
additional data source. For example, data can be imported from XML files, social
data sources like Twitter or Facebook, or other big data sources such as Google

Big Query.
The source from where data is imported to create a dataset. The data in a data

source is not altered in any way; only the imported dataset is manipulated.

The data used to create charts. A dataset can also contain semantic
enhancements or enrichments. For example, a dataset can contain time and
geography hierarchies, measures, formulas, and calculations.

A data object that represents categorical data in a dataset. For example, Products
or Sales.

A file created in SAP Lumira that contains datasets, data source connection
information, visualizations, and stories.

For Lumira 1.26 and later versions, see SAP Lumira, server for teams.

The process of organizing a dataset into measures and hierarchies during data
acquisition. For example, if the source data contains years and months, the
enrichment process might create a Date hierarchy.

A dialog box that displays installed and available Visualization and Data Access
Extensions.

An attribute or characteristic of a dataset. For example, measures, dimensions,
calculations, and hierarchies are facets of a dataset.

The view that displays a summary of a dataset by listing the unique values for each
dimension. For example, a dataset may contain a dimension called Country that
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Geo Map

influence analysis

Launchpad

measure

Measures and
Dimensions panel
(Visualize room)

Prepare room

SAP BusinessObjects
Business Intelligence
platform

SAP Lumira, Edge
edition

SAP Lumira, server for
teams

Stack mode

story

trellis

visualization

Visualization Tools
panel

Visualize room
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contains multiple instances of the values U.S.A., Canada, and Mexico. If you select
the Country dimension in the Facet view, the values U.S.A., Canada, and Mexico are
displayed along with the number of times they appear in the dataset.

A visualization where charts overlay a geographical image of the earth.

A feature that lets you look at a specific measure in your data to determine which
dimensions impact that measure the most. Related visualizations can be viewed
based on the analysis.

A page that lists all available stories and datasets.

A data object that represents quantitative data in a dataset. For example, sales
revenue, salary, or number of employees.

An interactive component in the Visualize room that allows searching for all
available measures and dimensions. When you drag and drop Values from this
panel to the Visualization Tools panel, the results are displayed on the Chart
Canvas.

The page used to view, organize, and manipulate tabular data.

The full name of the Business Intelligence (BI) platform or Bl platform.

For Lumira 1.26, see SAP Lumira Server for Teams.

In SAP Lumira 1.26 and later, the solution for deployments without Bl platform or
SAP HANA that allows sharing SAP Lumira content with a small number of
collaborators.

The view that displays data points as related stacks, building on previous data
points. In a stacked bar chart, each data point starts from the previous data point.
For example, a story containing sports team data can visualize each team's total
salary budget as a stacked bar chart with individual player salaries. The total height
of the stacked individual player salaries equals the team salary.

A collection of visualizations, text, and images that describes your data.

A grid layout of charts that use the same scale and format to allow side-by-side
comparison. For example, if you create a bar chart that compares revenue by
region, and then add the Country dimension to the trellis, multiple small charts will
be displayed, with each chart showing the revenue by region for one country.

A visual representation of your data. For example, data displayed in a pie chart.

The panel that contains tabs used for creating visualizations, for example the Chart
Builder tab or the Related Visualizations tab.

The page used to work with data contained in a dataset.
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Important Disclaimers and Legal Information

Coding Samples

Any software coding and/or code lines / strings ("Code") included in this documentation are only examples and are not intended to be used in a productive system
environment. The Code is only intended to better explain and visualize the syntax and phrasing rules of certain coding. SAP does not warrant the correctness and
completeness of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless damages were caused by SAP
intentionally or by SAP's gross negligence.

Accessibility

The information contained in the SAP documentation represents SAP's current view of accessibility criteria as of the date of publication; it is in no way intended to be
a binding guideline on how to ensure accessibility of software products. SAP in particular disclaims any liability in relation to this document. This disclaimer, however,
does not apply in cases of wilful misconduct or gross negligence of SAP. Furthermore, this document does not result in any direct or indirect contractual obligations of
SAP.

Gender-Neutral Language

As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed directly with "you", or a gender-neutral noun (such as
"sales person" or "working days") is used. If when referring to members of both sexes, however, the third-person singular cannot be avoided or a gender-neutral noun
does not exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the documentation remains comprehensible.

Internet Hyperlinks

The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint about where to find related information. SAP does
not warrant the availability and correctness of this related information or the ability of this information to serve a particular purpose. SAP shall not be liable for any
damages caused by the use of related information unless damages have been caused by SAP's gross negligence or willful misconduct. All links are categorized for
transparency (see: http://help.sap.com/disclaimer).
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© 2016 SAP SE or an SAP affiliate company. All rights reserved.

No part of this publication may be reproduced or transmitted in any
form or for any purpose without the express permission of SAP SE
or an SAP affiliate company. The information contained herein may
be changed without prior notice.

Some software products marketed by SAP SE and its distributors
contain proprietary software components of other software
vendors. National product specifications may vary.

These materials are provided by SAP SE or an SAP affiliate company
for informational purposes only, without representation or warranty
of any kind, and SAP or its affiliated companies shall not be liable for
errors or omissions with respect to the materials. The only
warranties for SAP or SAP affiliate company products and services
are those that are set forth in the express warranty statements
accompanying such products and services, if any. Nothing herein
should be construed as constituting an additional warranty.

SAP and other SAP products and services mentioned herein as well
as their respective logos are trademarks or registered trademarks
of SAP SE (or an SAP affiliate company) in Germany and other
countries. All other product and service names mentioned are the
trademarks of their respective companies.

Please see http://www.sap.com/corporate-en/legal/copyright/
index.epx for additional trademark information and notices.
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